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Thank you for purchasing the Dagstation DX1000 (hereafter referred to as “DX”).

This User’s Manual explains how to use the useful functions of the DX. To ensure correct
use, please read this manual thoroughly before operation.

The following five manuals are provided as DX manuals.

First edition:

Paper Manual

Manual Title Manual No.

Description

DX2000 Operation Guide  IM 04L41B01-02E

Explains the basic operations of the DX. It is
also provided in the CD-ROM.

Control of Pollution Caused IM 04L41B01-91C
by the Product

Gives a description of pollution control.

Electronic Manuals Provided on the Accompanying CD-ROM

Manual Title Manual No.

Description

DX2000 Operation Guide  IM 04L.41B01-02E

This is the electronic version of the paper
manual.

DX2000 User’s Manual IM 04L41B01-01E

Describes how to use the application
functions. Communication and network
functions are not covered.

DX1000/DX1000N/DX2000 IM 04L41B01-17E
Communication Interface
User’s Manual

Describes how to use the communication
functions using the Ethernet and serial
interfaces.

DAQSTANDARD User’s IM 04L41B01-61E

Manual

Describes how to use the accompanying
software program, DAQSTANDARD.

The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.

Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA's permission is strictly prohibited.

The TCP/IP software of this product and the document concerning the TCP/IP software
have been developed/created by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the University of California.

All the brands or names of Yokogawa Electric’s products used in this manual are
either trademarks or registered trademarks of Yokogawa Electric Corporation.
Microsoft, MS-DOS, Windows, Windows XP, and Windows NT are either registered
trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
Adobe, Acrobat, and PostScript are trademarks of Adobe Systems Incorporated (Adobe Systems).
CompactFlash and CF are trademarks of SanDisk Corporation.

For purposes of this manual, the ™ and ® symbols do not accompany their respective
trademark names or registered trademark names.

Company and product names that appear in this manual are trademarks or registered
trademarks of their respective holders.

December 2005 Third edition: April 2007

Second edition: October 2006

All Right Reserved, Copyright © 2005, Yokogawa Electric Corporation
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DX’s Version and Functions Described in This
Manual

The contents of this manual corresponds to the DX with release number 2 and style
number 2.

DX’s Version and Functions
For the procedure to check the version, see section 2.5.

Edition| DX |Suffix code Addition and change to functions Refer to
2 Version - (Added) German, French, and Chinese as display language Section 2.6
1.11 - (Added) Modbus client connection retry interval: 10 s, 20 s, and 30 s | Communication manual
/P1 (Added) 24 VDC/AC power supply (/P1 option) Operation Guide
Version| /USB1 [(Added) Tab key on the USB keyboard corresponds to arrow keys. |Section 2.11
1.21 - (Added) Operations to request and release network information Section 2.11
- (Changed)Modbus client: Function to connect a server with a unit Communication manual
number is changed.
- (Added) Modbus client: Connection timeout value Communication manual
- (Added) Modbus registers (floating point type for communication Communication manual
input data)
- (Added) A data output format (Skip or OFF channel data not output)| Communication manual
- (Changed)Error messages 105, 221, and 222 are added. Section 10.1
Error messages 215, 218, 536 and 536 are changed.
3 Release - (Added) Improvement to the operability on the historical trend Section 4.3
number display.
2 - (Changed)Displaying the date in the grid time of the trend display Sections 1.3 and 2.4
(Version when the trend interval is greater than or equal to 1 h/div.
2.0x) - (Added) Improvement to the display group setup operation. Section 5.1
- (Added) Addition of the Upper and Lower settings to the bar graph |Section 5.11
base position.
- (Added) Addition of the relay action when alarm ACK is executed to | Sections 1.2, 3.5, and 3.8
the alarm output relay settings.
/M1, /PM1 |(Added) Ability to reset the computed value during computation. Section 9.4
- (Changed)Changes to how the data files are named. Section 1.4
- (Added) Sorting the files by the update date/time. Sections 6.7, 6.8, and 6.9
- (Added) Storage method for constantly retaining the most recent | Sections 1.4 and 6.2
data files in the CF card (Media FIFO).
- (Added) Progress display when saving all data of the internal Sections 4.8
memory.
/USB1 |(Changed)Changing the initial display selection menu. Sections 4.8 and 5.17
/USB1 |(Changed)lmprovement to the data save operation to the USB flash |Sections 2.12 and 5.17
memory.
- (Changed)Retaining the state of the CapsLock and NumLock keys  |Section 2.11
on the USB keyboard
- (Changed)Changing the default setting of the web server function. Operation Guide
- (Added) Error messages, 513, 514, 515, and 516 have been added.|Section 10.1
Style - (Added) The waterproof construction of the DX front panel Section 12.6
number complies with the NEMA4 standard
2
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How to Use This Manual

Structure of the Manual
Read the Operation Guide first to familiarize yourself with the basic operation,

and then read this manual. For a description of the communication function and the
accompanying software program, DAQSTANDARD, read the respective manual.
This user’s manual consists of the following sections.

Chapter Title and Contents

1 Overview of Functions
Describes the functions of the DX.
2 Common Operations

Describes the procedure to set the time and the operating procedure using the
remote control terminal (/KB1 or /KB2 option) and keyboard (/USB1 option).

3 Measurement Channels and Alarms

Describes how to set the measurement conditions and alarms.
4 Switching Operation Screens

Describes the operations on the operation screen.
5 Operations for Changing the Displayed Contents

Describes how to change the displayed contents on the operation screen and how
to write messages.

6 Saving and Loading Data
Describes how to acquire and store the data. Also describes the procedure to
load measured data/setup data on the CF card or the USB flash memory (/USB1
option).

7 Customizing the Action (Event Action)
Describes how to carry out specific actions when a given event occurs, when a
remote control signal is applied, and when the USER key is pressed.

8 Using the Security Function
Describes how to use the key lock function and the function that allows only
registered users to operate the DX.

9 Computation and Report Functions (/M1 and /PM1 Options)
Describes how to use computation channels and how to create reports such as
hourly, daily, weekly, and monthly reports.

10 Troubleshooting

Describes error messages and troubleshooting.
1" Maintenance

Describes periodic inspection and calibration.
12 Specifications

Lists the specifications of the DX.
Appendix Describes how to estimate the file size, the types of data that the DX can
generated and how to use them, the data format of ASCI| files, etc.

Index

Nofte
» This user’s manual covers information regarding DX1000s that have a suffix code for
language “-2” (English).
» For details on setting the display language, see section 2.6, “Changing the Displayed
Language.”
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How to Use This Manual

Conventions Used in This Manual

Unit

= X

Markings

>

CAUTION

Note

Subheadings
Bold characters

[Ala]#]1]

Procedure

Explanation

Setup Screen

Denotes 1024. Example: 768 KB (file size)
Denotes 1000.

Improper handling or use can lead to injury to the user or
damage to the instrument. This symbol appears on the
instrument to indicate that the user must refer to the user's
manual for special instructions. The same symbol appears in
the corresponding place in the user's manual to identify those
instructions. In the manual, the symbol is used in conjunction
with the word “WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious
or fatal injury to the user, and precautions that can be taken to
prevent such occurrences.

Calls attentions to actions or conditions that could cause light
injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Calls attention to information that is important for proper
operation of the instrument.

Denotes key or character strings that appear on the screen.
Example: Volt

Indicates character types that can be used.
[Al Uppercase alphabet, [allowercase alphabet, | symbols,
[1] numbers.

Carry out the procedure according to the step numbers.

All procedures are written with inexperienced users in mind;
depending on the operation, not all steps need to be taken.

Explanation gives information such as limitations related the
procedure.

Indicates the setup screen and explains the settings. A
detailed description of the function is not provided in this
section. For details on the function, see chapter 1.

IM 04L41B01-01E



Contents
[0 ] =1V ] (o IR PO i
DX’s Version and Functions Described in This Manual .................oouvuuiiieiiiiiiiiiceeeeee e ii
HOW t0 USE ThiS IMANUAL.........eueeiiee ettt e e e e e e e e e e e e e e e e eeenaannns iii
Chapter 1 Overview of Functions

Chapter 2

Chapter 3

Tl INPUE SECHON ...ttt 1-1
L2 N =T o o1 SRR 1-4
L I o] = PRSP 1-7
1.4  Data Storage FUNCHON..........uviiiie et e e a e e e e e e e e e nanees 1-21
1.5 BatCh FUNCHON ....ciiie et e 1-31
1.6 Event ACtion FUNCHON ... et e e 1-32
1.7 SECUNLY FUNCHON ...eiiiiii ittt e e 1-35
1.8 Computation and Report Function (/M1 and /PM1 Options)..........cocoeeiiiiiiiieicniiieenieeee 1-37
1.9 FAIL/Status Output Function (/F1 OPtion) .......ceviiiiiiiiiiie e 1-43
T.10 Other FUNCHONS ..ottt et e e st e et e e eanteeeenn 1-45

Common Operations

2.1 Setting the Date/TIME .......eiiieiee ettt e e et e e e e anaee s 2-1
2.2 Setting the Time Difference from GMT ........cooiiiiiiireiee e 2-2
2.3 Setting the Time Correction Operation during Memory Sampling ..........ccccooocieeieiiiiiineennn. 2-3
2.4 Setting the Date FOrmat...........ooiiiiiii s 2-4
2.5 Viewing the DX INfOrmMation .........c.oooiiiiiiiiie e 2-5
2.6 Changing the Displayed LangUage..........c.ceeiuuiiiiiiieiiiee et 2-6
2.7 Setting the LCD Brightness and Backlight Saver ..........c.ccccoooviiiiie i 2-7
2.8 Initializing Settings and Clearing the Internal Memory............ccccveviieiiie i 2-8
2.9 Outputting the DX Status via the Relay Contact (/F1 Option).........ccoooieiiiiiiiiieiiiieeee 2-9
2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)............... 2-10
2.11 Controlling the DX with a Keyboard (/USB1 Option) ........ccccoiiiiiiiiiiiiiiiieee e 2-15
2.12 Using the USB Flash Memory (/USB1 OPtioN) .......ccoiuiiiaiiiiiiieee e 2-17

Measurement Channels and Alarms

3.1 Setting the Scan Interval and the Integration Time of the A/D Converter ............cccccceeeene. 3-1
3.2 Setting the Burnout Detection and the Reference Junction Compensation of the

ThermoCoUPIE INPUL.........u e e e e e e e e e e e e e e e e e e e s e s eennnreenes 3-2
3.3 Setting the INPUE RANGE ........eiiiii e 3-3
3.4 Setting the Moving Average of the INPUL ... 3-6
3.5 Setting the Auxiliary Alarm FUNCHON .......c.ooiiiiiiii e 3-7
3.6 Hiding the Alarm INAiCatioN ..........cooiiiiiii e 3-10
3.7  Setting Alarms 0N ChanNEIS ........ooiiiiiiiiiie ettt e e s 3-11
3.8 Releasing the Alarm Output (Alarm ACK Operation) ...........ccceeeriieeeiieeeiieeaiiee e 3-14
3.9 Performing Calibration Correction (/CC1 OPLioN) ......c.eeeiiiiiiiiiieiiiieee e 3-15
3.10 Counting PulsSes (/PM1 OPtION) ....ooiuiiiiiiiiiiie ettt 3-16
3.11 Setting the Method of Detecting Over-Range Values of Linearly Scaled Measurement

(3 =0T 0= LSS 3-19

IM 04L41B01-01E




Contents

Chapter 4 Switching Operation Screens

Chapter 5

Chapter 6

Chapter 7

Chapter 8

4.1
4.2
4.3
4.4
4.5
4.6
4.7
4.8
4.9

Operations in Operation MOGE............uuiii i e e e e eanaes 4-1
Displaying the Measured Data as Waveforms, Values, or Bar Graphs .........cccccoccceeiiinene 4-3
Displaying Past Measured Data (Historical Trend Display) .........cccoeieeeeenieeenieeeiiee e 4-5
Display the Statuses of All Channels on One Screen (Overview Display).............cccccee.... 4-10
Displaying Various INformation ............c.ccuioiiiiiiiii e 4-11
Using the Alarm SUMMEIY .......oouiiiiii e 4-13
Using the MeSSage SUMMAIY.......coiuiiiiiiii ittt 4-14
Using the MemOry SUMMANY .......oooiiiiiiiie et e et e e e e 4-15
Displaying a List of Operation LOGS .......cuueiiueieiiiieeiiie e eeee e 4-18

Operations for Changing the Displayed Contents

5.1
5.2
5.3
5.4
5.5
5.6
5.7
5.8
5.9
5.10

5.11
5.12
5.13
5.14
5.15
5.16
5.17

Setting DiSPIay GrOUDPS ....ccciiueieiie ettt et e e et e e e e et e e e e e e e e e e e e aanneeeeaeeeanneeas 5-1
Displaying Tags or Channel NUMDErS. ..ot 5-3
Setting the Trend Interval and Switching to the Secondary Trend Interval.............cccccoee. 5-4
WIIING MESSAUES ...ttt e ettt e e e e et e e s s 5-6
Changing the Channel Display ColOrS............uuiiiiiiiiiiee e e 5-9
Displaying Channels in DiSplay ZONES ........c.cuiiuiieiiiieeeiie et 5-10
Displaying a Scale on the Trend DiSPlay .........ccccueieioiieiiieee e 5-11
Displaying Alarm Point Marks and Color Scale Band on the Scale.............cc.ccccoiieinnen. 5-14
Partially Expanding the Waveform.............coiiiiii e 5-16
Changing the Display Layout, Clearing of the Waveform at Start, Message Display Direction,
Waveform Line Width, and Grid............oeiiiiiiiie e eeeaaes 5-18
Changing the Bar Graph Display Method ............cccooiiiiiiiiiiie e 5-19
Changing the Background Color of the Display............coooiiiiiiiiiie e 5-22
Automatically Switching Display GroUPS ........coceeiiiiiiiiiiieiie e 5-23
Automatically Reverting to the Specified Display ..........cccccooiiiiiiiiniiec e 5-24
Registering the Favorite DiSPlay .........ccoouiiiiiiiiiiecie e 5-25
Writing a Message When the DX Recovers from a Power Failure .............cccccceeeiiiinnnen.. 5-26
Changing the FUNC Key Menu and Display Selection Menu...........cccccceviiieiiieeiienenee 5-27

Saving and Loading Data

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8
6.9

Setting the Recording Conditions of the Measured Data...........cc.ccccoevieeiiie e, 6-1
Setting the Method for Saving the Data...........coooiiii e 6-4
Using the BatCh FUNCHON.........ocoiii e 6-6
Starting/Stopping the Recording and Saving the Measured data............c.ccccoviiiiiieinnenn. 6-8
Manually Saving the Measured Data (Manual Sample) ..........cccocviiiiiiiiiiieeii e 6-11
Saving the Screen Image Data (SnapShot) .........ccceiiiiiiiiie e 6-12
Managing the Files on the Storage Medium ...........cocuiiiiiieiiie e 6-13
Loading and Displaying the Measured Data in the Storage Medium...............ccccooeieee. 6-15
Saving/Loading the Setup Data............cooiiiiiiii e 6-16

Customizing the Action (Event Action)

71

7.2

Setting the Event Action Function (Including Remote Control (/R1 Option)
AN USER KEY) .ttt ettt e ae e et sne e et snb e ne e et nnes 7-1
Setup Examples of EVENE ACHON...........ooiiiiiiiie e 7-5

Using the Security Function

8.1
8.2
8.3

Disabling the Key Operation (Key Lock FUNCHON) .........ociiiiiiiieiie e 8-1
Enabling Only Registered Users to Operate the DX (Login Function)...........ccccceveeeiinens 8-3
Logging in and LOgging OUL......... ittt e e e e e e e eneeeeeas 8-6

vi

IM 04L41B01-01E



Contents

Chapter 9

Chapter 10

Chapter 11

Chapter 12

Appendix

Index

Computation and Report Functions (/M1 and /PM1 Options)

9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation

(O = g 0 =Y OSSR 9-1
9.2 WIItiNG EXPrESSIONS ...t ettt et e e ettt e e e ettt e e e e et ee e e e e e e nnneeeeanees 9-5
9.3 Displaying the Computation Channels.............ccuiiiiiiiiii e 9-11
9.4 Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data

DrOPOUL DISPIAY ...ttt ettt 9-13
9.5 Creating REPOIS . ....uviiiiiiiiiiie et et e e e et e e e e e e e e e et e e e e e e raeaae s 9-15
Troubleshooting
T0.1 A LISt Of MESSAGES. ... uuiiiiieiiiiiiie ettt et e e e et e e e e et e e e e s e enaraaeaeenrseeas 10-1
10.2 TroubIESNOOING .....oiieieee ettt e et e e e e e e 10-15
Maintenance
11,1 Periodic INSPECHION .. ...t e e e e e e e e e e aaaaeaeaeeeaaannae 11-1
11.2 Calibrating the DX..... ..t e e e e e e et e e e e e nnee e e e e nnees 11-2
11.3 Pulling Out the Inner Instrument (DX1000N) .......cooiiiiiiiiiii e 11-4
Specifications
12,1 Signal INPUt @Nd ALGIM .......eeii e 12-1
12.2 DisPlay FUNCHON .....ooiiiiiii et et e e beeeeae 12-3
12.3 Data Saving FUNCHON .......ooiiiiiie et e e e e e e e e e e 12-5
12.4 Other Standard FUNCHONS.........ooiiiiiieeiiie et eeenaee s 12-7
T2.5 OPLIONS ettt e et e e e et e e e e e e e e e e et e e e e e e eaae e e e e eabaeeeaeaaaraneas 12-9
12.6 General SPECIfiCatiONS ........coiiiiiiiiei et 12-14
12.7 EXErnal DIMENSIONS ......eiiiiiiiiiiiie ettt e ettt e e e ettt e e e e e et e e e e e enbaeeeaeeaannreeaaaanns 12-17
Appendix 1 File Size of Display Data and Event Data.............cccoeviiiiiiieiiniiccc e, App-1
Appendix 2 Types of Data That the DX Can Create and Their Application..............cccccc.... App-4
Appendix 3  Data Format of ASCII Fil€S ........oocuiiiiiiiieee e App-5

IM 04L41B01-01E

vii




Chapter 1 Overview of Functions

1.1  Input Section

Measurement Channel
¢ Number of Measurement Channels and Scan Interval
The DX samples the input signals on the measurement channels at the scan interval
to obtain the measured values. The table below shows the relationship between the
number of measurement channels and the scan interval.

Number of Scan Interval
Model Measurement

Channels Normal Mode Fast Sampling Mode
DX1002, DX1002N 2 125 250 25
DX1004, DX1004N 4 ms, £29M$ ms
DX1006, DX1006N 6 e
DX1012, DX1012N 12 1s 2s,5s ms
Integration time of .
the A/D converter 60 Hz/50 Hz |60 Hz/50 Hz/100 ms 600 Hz (fixed)

For the setting procedure, see section 3.1.

* Integration Time of the A/D Converter

The DX uses an A/D converter to convert the sampled analog signal to a digital

signal. By setting the integration time of the A/D converter to match the time period

corresponding to one cycle of the power supply or an integer multiple of one cycle, the

power supply frequency noise can be effectively eliminated.

» Because 100 ms is an integer multiple of 16.7 ms and 20 ms, this setting can be used to
eliminate the power frequency noise for both frequency, 50 Hz and 60 Hz.

» In fast sampling mode, the performance of eliminating power frequency noise is worse than in
normal mode. We recommend that you use normal mode when making measurements in an
environment affected by power frequency noise.

For the setting procedure, see section 3.1.

Input Type and Computation

You can make measurements using the following input types.

SuO0I32UN4 JO MBIAIBAQ

Input Type Description
DC voltage Measures a DC voltage in the range of +20 mV to +50 V.
DC current A shunt resistor*' is attached to the input terminal. The current signal is

converted to a voltage signal and measured. The measurable range is the
range equivalent to the “DC voltage” range indicated above after converting
the current to the voltage signal.

Thermocouple

Measures temperature corresponding to each type: R, S, B, K, E, J, T, N, W,
L, U, and WRe3-25. Measurement is possible on other thermocouples
such as PR40-20 and PLATINEL*2.

RTD

Measures temperature corresponding to each type: Pt100 and JPt100.
Measurement is possible on other RTDs such as Cu10 or Cu25*2 and Pt50 or
Ni100*2.

ON/OFF input

Displays the contact input or voltage input signals by correlating them to 0% or
100% of the display range.

Contact input: Closed contact is ON (1). Open contact is OFF (0).

Voltage input: Less than 2.4 V is OFF (0). Greater than or equal to 2.4 V is
ON (1).

Pulse input**

Counts the pulses.

*1 ltem sold separately. For example, a 250-Q shunt resistor is used to convert the signal
to 1to 5V for 4-20 mA input.

*2 /N3 option.
*3 /N1 option.
*4 |PM1 option.

IM 04L41B01-01E 1-1



1.1 Input Section

The following input processing and computation are available.

Moving average

Linear Calibration Low cut Difference Measured

scaling correction computation value
(/CC1 option)
DC Voltage | Y TN N
T o ) Lo
Shunt resistor b -/ b
DC current 1 E ! —~ . JEEN
i1 O O
! E Square root computation ! E .
1-5V ¥ ] : O | : \/\ _,\'
Burnout detection ) b P
RIC_ | ! L
Thermocouple —L—i i—i : ;o \”:,
Burnout detection <) ---4 | ! | ) b
P — o
RTD Lo Lo .
| M Do
o/ [
! P -
ON/OFF input \er_ Do ..
| VD Lo
-/ L/
Convert to number of pulses over 1 second
Pulse 7y
UL g

(/PM1 option)

Dotted lines indicate that the function can be selected.

Reference Junction Compensation

Burnout Detection

Performs reference junction compensation on
the thermocouple. DX

Thermocouple
Internal
L] reference
Thermocouple junction

External reference junction
For the setting procedure, see section 3.2.

Detects and indicates a burnout in the sensor.

Burnout
C ® 1-5V Indicated as
Detected on the Burnout.
1-5V value.

Thermoelectromotive

Burnout
force

<

For the setting procedure, see section 3.2.

Indicated as
Burnout.

Moving Average

Eliminates noise.
Operation example when the number

New sampled

New sampled

of moving average data points is 3 data i data '
1| 10.0 mv 15.0 mV 10.0 mV Number of moving
_Samplllon%rdata 2| 50mv s 10.0 mv s 15.0 mv average data points: 2 to 400
in the butter 3 oomv [~ 50mvV_ [ 10.0 mv
) Clear Clear
(Moving average) [ 5.0mv | [10.0omv ]| [117mv ]
Sampling nth time n + 1th time n + 2th time

For the setting procedure, see section 3.4.
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1.1 Input Section

Square Root Computation Linear Scaling

Takes the square root of the input value and converts Converts the unit to obtain the measured value.
the unit to obtain the measured value.

b B
o) L, | o0V 1 300"

* /\ value Measured

a A B > value value

X—a /] 0V —> - 100 °c
X=(B-A) —— +A /
b-a A

a b
For the setting procedure, see section 3.3. For the setting procedure, see section 3.3.

Calibration Correction (/CC1 Option) Low-cut

For square root computation, measured values below
the specified value are cut.
For 1-5 V input, values below 0 % are cut.

Corrects the input value with the characteristics
specified by segments to obtain the measured value.

Measured
Number of break value

oints: Up to 16
Output P P Result of square root
value

computation
Measured
(Voae™*")) i
7
value

For the setting procedure, see section 3.9. For the setting procedure, see section 3.3.
Difference computation Pulse Input (/PM1 Option)
The measured value of the channel is set to the Pulse that can be counted Input to the DX
difference with respect to the measured value of the
reference channel. Pulse
100 Hz or less Contact {

Input Measured 7
O——CleD) ] | or => bx
T - ﬁ Open {
Measured value on the reference channel 5 ms or more collector

Count on the DX
|The contact changes from open to close.|

The signal level at the input terminal changes from high
to low.

For the setting procedure, see section 3.3. For the setting procedure, see section 3.10.

Nofte

Difference computation is executed even if the input type or range is not the same between
the difference computation channel and the reference channel. The difference is computed
discarding the decimal place and unit, and the decimal place and unit of the difference
computation channel are applied.
Example 1: If the input value of the difference computation channel is 10.00 and the measured
value of the reference channel is 100.0, the computed result is
10.00 — 100.0 = —90.00.
Example 2: If the input value of the difference computation channel is 10.00 V and the
measured value of the reference channel is 5.00 mV, the computed result is
10.00 V-5.00 mV =5.00 V.

IM 04L41B01-01E 1-3
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1.2

Alarms

This function generates an alarm when the measured data meets a certain condition. Up
to four alarms can be set for each channel.

Alarm Type

You can use the alarms shown below. The character inside the parentheses is the

symbol denoting each alarm.

For the alarm setting procedure, see section 3.7.

High Limit Alarm (H)

Low Limit Alarm (L)

Measured value Hysteresis

Alarm value |> v
| N\
Alarm output ON E———"—"+

Measured value Hysteresis

Alarm value I> ) /

Alarm output ON ——

Delay High Limit Alarm (T)

Delay Low Limit Alarm (t)

7 Measured value
|
N\

Alarm value |>
/|

Delay time —=r——~

Alarm output ON

\ Meaéured value /

Alarm value [>

Delay time

Alarm output ON ———

High Limit on Rate-of-Change Alarm (R)

Low Limit on Rate-of-Change Alarm (r)

Mef-:sured value Change in the
A

/./' measured value
T2 -
- Amount of change in
P the setting
T
T2-T1|
/| t1 t2 ]
> Time

e
Interval (t2-t1)

Measured value
4

T2 Amount of change in
< the setting
T BN [T2-T1
> ~. > Change in the measured value
t1 t2| < N~
> Time

Interval (t2-t1)

Difference High Limit Alarm (h)

Difference Low Limit Alarm (I)

Difference in the measured values of two channels
Hysteresis

Alarm value [> ~
! N\

Alarm output ON =

Difference in the measured values of two channels
Hysteresis
\ /

Alarm value |> \_//

Alarm output ON _—

e Alarm Hysteresis

You can set a width (hysteresis) to the value used to activate and release alarms.

e Delay High Limit Alarm and Delay Low Limit Alarm
An alarm occurs when the measured value remains above or below the alarm value
for a specified time period (delay period).

* High Limit on Rate-of-Change Alarm and Low Limit on Rate-of-Change

Alarm

The rate-of-change of the measured values is checked over a certain time (interval).

An alarm occurs if the rate-of-change of the measured value in the rising/falling

direction is greater than or equal to the specified value.

The alarm value of the rate-of-change alarm is set using an absolute value. The

interval is derived using the following equation and set using the number of samples.
Interval = the scan interval x the number of samples

For the setting procedure, see section 3.5.

» Difference Upper Limit Alarm and Difference Lower Limit Alarm
An alarm occurs when the difference in the values of two channels is greater/less
than or equal to the specified value. These alarms can be specified on measurement
channels set to difference computation.
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1.2 Alarms

Alarm Indication

The alarm conditions are displayed as alarm icons in the status display section and on
the operation screen such as the trend, digital, bar graph, overview displays. Detailed
information about the alarms is displayed in the alarm summary.

* Hold/Non-hold of Indications
The alarm indication can be set to operate in the following fashion when the condition

is no longer met.

+ Clear the alarm indication (non-hold).
* Hold the alarm indication until the alarm ACK operation is executed (hold).

The default setting is non-hold.

For the setting procedure, see section 3.5.

¢ Alarm Hide Function

No indication is made when an alarm occurs. The alarm is also not recorded in the
alarm summary. The alarm is output to the relay (/A[ ] option) or internal switch. This
function can be set for each channel and each alarm.

For the setting procedure, see section 3.6.

Alarm Output Relay Operation

Contact signals can be generated from alarm output relays (/A_ option) when alarms
occur. The alarm output relay operation can be changed.
For the setting procedure, see section 3.5.

Reflash

AND/OR

r Channel 1 —l‘
Channel 2+’—
L Channel 3—%—%—!_
| | !
| | !

— U u—
A=l

S66Ts 566

L (when arelay is set to “OR” logic)

Alarm

Alarm output relay
(reflash ON)

Alarm output relay
(reflash OFF)

Channel 1_| L

|

|
Channel Zﬂ

|

Alarm

| |

| |

| I_I |
Alarm output relay AND ; }
or | |
Internal switch — I 1=

(You can set the alarm output relay and internal
switch. For details on the internal switch, see the
next page.)

Energize or De-energize

When power is shut down

| /]

Normal operation

| /]

When alarm is occurring

N

NO: Normally Opened

Energize C: Common
NOC NC NOC NC NOC NC NC: Normally Closed
oo | /] N | |
NOC NC NOC NC NOC NC
Non-Hold Hold
Alarm occurrence Alarm IACK Alarm ACK
1
Alarm | I Alarm release | | ! _,_E_L:_
1 1 | | 1
Alarm iActivated Activated or Activated | Normal| @
output Relay is activated %
relay Deactivated Deactivated Deactivated in the next scan <
interval t_Z(,>
=
Alarm occurrence Alarm ACK Alarm ACK Alarfn ACK 3
! o
Alarm release_| 1 I | I T Reset | 5
Alarm _!_.I_ ! 0 ! (Release| >
Alarm Activated or Activated Activated or Activated number | Q
. . P
output — L |Relayis activated 2
relay Deactivated Deactivated Deactivated Deactivated on the next alarm || or later)
occurrence
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1.2 Alarms

Internal Switch

¢ Reflash
When multiple alarms are assigned to one alarm output relay, this function notifies the
occurrence of subsequent alarms after the relay is activated by the first alarm. When
subsequent alarms occur, the output relay is released temporarily (approximately 500 ms).
The reflash function is set on the first three output relays.*
* 101 to 103 or 111 to 113. 101 and 102 for the /A1 option.

Note

When reflash is enabled, the first three output relays are used exclusively as reflash relays.

The first three output relays are set to OR logic and de-energize operation regardless of the
AND/OR and energize/de-energize settings explained below.

¢ AND/OR
When multiple alarms are assigned to one alarm output relay, the condition for
activating the output relay can be selected from the following: You can select AND
operation also for the internal switch.
* AND: Activated when all assigned alarms are occurring simultaneously.
*+ OR: Activated when any of the specified alarms is occurring.

¢ Energize or De-energize Operation
You can select whether the alarm output relay is energized or de-energized when an

alarm occurs. If de-energized is selected, the status of the alarm output relay when an
alarm occurs is the same as the status that results when the DX power is shut down.
The setting applies to all alarm output relays.

* Non-Hold/Hold
The alarm output relay can be set to operate in the following fashion when the alarm
condition is no longer met.
* Turn OFF the relay output (non-hold).
» Hold the relay at ON until the alarm ACK operation is executed (hold).
The setting applies to all alarm output relays.

¢ Alarm ACK Operation
The alarm acknowledge (alarm ACK) operation releases all alarm indications and

relay outputs. For the action of alarm indication and alarm output relay when you
carried out the alarm ACK operation, see the previous page.

Nofte

When you enter the basic setting mode, the hold/non-hold condition of the alarm output relay
immediately before is retained. In the basic setting mode, alarms are not detected, and you
cannot acknowledge alarms.

The alarm status can be output to software switches (30 internal switches). The values of
the internal switch are shown below. Like the alarm output relay, you can specify AND/
OR operation (see the previous page).

Alarm occurrence

Alarm
Alarm release

1
Internal switch F,_L

The internal switches can be used events of the event action function (see section 1.6).
In addition, the internal switches can be written in calculation expressions of computation
channels (/M1 or /PM1 option).

1-6
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1.3

Display

Common Items Related to the Display

¢ 5.5-inch TFT Color LCD and the Screen Configuration

The DX has a 5.5-inch TFT color LCD (240 x 320 dot resolution). The screen consists
of the status display section and the data display section.

AR = 1] ] «— status display section
0.5014 1.6631
m ” ” -
3 1  Data display section
-0.4410 +0ver
mm 'l

» Status Display Section
The status display section shows the display name, date/time, batch name (when
using the batch function), user name (when using the login function), usage of the
internal memory or CF card, alarm occurrence, computation status (/M1 or /PM1
option), and usage of key lock or e-mail transmission.

* Data Display Section
The data display section shows the measured data using numeric values,
waveforms, and bar graphs. It also shows the setup screen when setting functions.

Group Display

On the trend, digital, and bar graph displays, the data of channels is displayed by
groups that are set in advance. Up to 10 groups can be registered, and up to six
channels can be assigned to each group. Groups are common to the trend, digital,
and bar graph displays.

The displayed group can be switched automatically at a specified time interval (5 s to
1 min).

For the setting procedure, see section 5.1.

Channel Number Display and Tag Name Display

Channels can be displayed as tags or channel numbers. The setting applies to all
channels.

For the setting procedure, see section 5.2.

Update Interval of Measured Values
The values are updated every second. However, if the scan interval is greater than 1 s,
the values are updated at the scan interval.
For the setting procedure, see section 5.3.

Alarm Indication
Alarms that are set for each channel are checked at all times and are indicated with
the symbol representing the alarm type on each display.

Alarm Type Symbol Alarm Type Symbol
High limit alarm H High limit on rate-of-change alarm R
Low limit alarm L Low limit on rate-of-change alarm r
Difference high limit alarm h Delay high limit alarm T
Difference low limit alarm | Delay low limit alarm t
IM 04L41B01-01E 1-7
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1.3 Display

Status Display Section

The following information is displayed in the status display section during operation mode
or setting mode.

Memory sampling status

. Faa=] Data type
LU s::::”":g 5[] DISP: Display data
PP EVENT: Event data

. ﬁ Memory sampling progress
: ey S | e Displays the progress using a green bar graph. The frame indicates the file :

in progress [ save interval (display data) or the data length (event data).
Error in internal memory.
Contact your nearest YOKOGAWA dealer for repairs.

Memory sampling icon Displays the remaining memory sampling time for the left bar graph.

OUP 1 ALL ,
5/12/81 14:71:30 Madr " LUt LS

Homm e | Alarm icon

Displayed when any alarm is activated.
“}} Blinks when there are alarms that are
(Red) occurring but have not been acknowledged.

Display name or group name
For all channel display on the trend display, “All” is
displayed.

All alarms have been released after they
have occurred, but there are alarms that
(Green) have not been acknowledged.

Displayed in yellow while the time is being corrected.

Date and time 1

Batch name and the display
name are shown alternately.
Date and time

— Status icon These icons are shown alternately
on models with /M1 option:

E Keys are locked.
E E-mail transmission is enabled.

The status assigned to the status output
relay (/F1 option) is occurring.

f If the “batch number-lot number” exceeds 20 characters,
' the “date and time” position is used to display the “batch
i number-lot number.”

When using the login function 1
Adminl Name of the user logged in |

T R AR LR 5)E - Date and time and the
display name are shown
alternately.

— Computation icon (/M1 option)

i; White icon: Computation started

When using the login and batch functions =
="| Yellow icon: Computation data dropout occurred

Name of the user logged in —_
Batch name, the display
name, and date and time are; “— CF card icon
SR ElLEIES ; nl CF card is being accessed.

The green level display indicates the amount of —— E Waiting.

CF card d. If Media FIFO* i t bled and

card use edia '8 no enable oan '+ Light blue icon: CF card in the slot is not
the free space on the CF card falls below 10%, ) .
o recognized. Remove and reset it.
the level indicator changes to red.
* See section 1.4, in the DX1000/DX1000N User's CF card error.
Manual. Media FIFO is a function available on Carry out the procedure below to reset the CF

release number 2 or later. card icon to normal.
» Replace the CF card with a normal one.
» Format the CF card on the DX (the data on
the CF card will be erased).

Bar Graph
When a pretrigger is configured in the event data recording and you press the START

key causing the DX to enter the trigger wait condition, the data in the pretrigger section
is recorded. During this time, the bar is displayed in orange. After the pretrigger time
elapses, the length of the bar fixed at that point. However, the relevant data is updated
until the trigger condition is met. When the trigger condition is met, the bar turns green,
and data is recorded after the data in the pretrigger section.
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1.3 Display

Trend Display (T-Y)

Measured data is displayed in a waveform. For the operating procedure, see section 4.2.

5: 1 o= I (O) 6
3

Current value mark

2.8 -1.8 ve.a

l—IZIBHl””l—IIIB”l””UlBIBI”lI Scale
"Trend space” function [ T EaI—. S0, A See section 5.7.
Inserts a division-wide /v @—— Trend interval

1618 E
space here. |

See section 4.2.

See section 5.3.
Grid
See section 5.10.

@— Trip line (up to four lines)
} See section 5.1.

1 division
(30 dots)
Time at the grid position
Displays the time or
the date and time.

See sections 2.4 and 5.3.

Numeric display section
See section 4.2.

Tag name or channel number, measured value,

and specified alarm

Waveform (displayed using the channel display color)
Change the channel display color (see section 5.5.)
Change the waveform line width (see section 5.10.)
Display the waveforms of all channels (see section 4.2.)

.- Maximum value
- Minimum value

1 dot

Displays the maximum and minimum
values of the data sampled within the
time corresponding to 1 dot.

Alarm point mark
See section 5.8.

Color scale band

Display layout See section 5.10. See section 5.8.

Current value display using
a bar graph
See section 5.7.

]
| @=t8#73— Alarm mark
il DU— Alarm type

Horizontal wide display Horizontal split display (displays two groups)

18 18:18:18 ? = (O &

WSy
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1.3 Display

¢ Updating of the Waveform

On the screen, 30 dots along the time axis is represented by a unit called division (see
the figure on the previous page). The displayed waveform is updated at an interval
corresponding to one dot. This interval is determined by the time corresponding to one
division (referred to as the trend interval). The relationship between the trend interval
and the speed of movement of waveforms on the screen is as follows:

Trend interval [/DIV] 15s” 30s 1 min 2 min 5 min
Time (s) corresponding to 1 dot 0.5 1 2 4 10
Speed of movement of waveforms

(approximate value, mm/h) 2500 1250 625 312 156
Trend interval [/DIV] 10 min 15 min | 20 min 30 min 1h
Time (s) corresponding to 1 dot 20 30 40 60 120
Speed of movement of waveforms

(approximate value, mm/h) 8 42 31 21 10
Trend interval [/DIV] 2h 4 h 10 h

Time (s) corresponding to 1 dot 240 480 1200

Speed of movement of waveforms 5.9 26 10

(approximate value, mm/h) ) ) :

* Selectable on the DX1002, DX1004, DX1002N, and DX1004N.

Switching the Trend Interval
You can switch from the normal trend interval to the secondary trend interval during
memory sampling and vice versa. For the operating procedure, see section 5.3.

Writing Messages

Preset messages Trend display

Start B 18 10:18:
| Material1 ] .

' 15:83 START
/ Eat
g q

\awls]=

Free message
Set the message when writing the message

Preset Messages

Preset messages are recalled and written.

The number of messages that you can use are 100 (message 1 to 10 are shared with
free messages). For the operating procedure, see section 5.4

Free Messages
Messages are entered when you need to enter them. The number of messages that
you can use are 10. For the operating procedure, see section 5.4.

Automatic Message Writing

* A message is written when the trend interval is switched during memory sampling.
For the setting procedure, see section 5.3.

* A message is written when the power recovers from a power failure during memory
sampling. For the operating procedure, see section 5.16.

Message display method

» Except for the vertical display, you can set the direction in which messages are
displayed to horizontal or vertical. For the setting procedure, see section 5.10.

* Messages can be displayed consolidated at the upper left of the screen (list

display). For the operating procedure, see section 4.2.

| 1 " =

18 18:18 Gl i twinsdiy ¢ List display
tmjinddjw LB BE-HOLD—)
- 1.6529 Y18:55 Press :
i > A Tene
> b
Nh. 5
1.654
o v Vertical display
2 | 44 4
1.654 L
W =
T
1 LA > o F
1-UJe » % g
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1.3 Display

e Zone Display
You can display channels in specified zones. This function can be used to keep the
waveforms from overlapping for easier view.
In the example below, channel 1 is displayed in the 0 to 30% zone, channel 2 in the
30 to 60% zone, and channel 3 in the 60 to 100% zone.

Normal display Zone display
Zone1 Zone2 Zone3
OI% SOI% GOI% 1|00%
0% 100% | | | |
\\
)) ) ) )
1|
> /d 4 /4
N \ \ \
e~
> i R
— |

Channel1 Channel2 Channel3
For the setting procedure, see section 5.6.

* Partial Expanded Display
By compressing a section of the waveform display range, the rest of the section is
expanded.
In the example below, 0 V (boundary value) is moved to the 30% position of
the display range (new boundary position). The 30% area below the boundary
corresponds to “- 6 V to 0 V” and 70% area above the boundary corresponds to “0 V

to6 V.”
Normal Display Partial Expanded Dispaly
Compressed|portion | Expanded portion |
% of full display span |
0 50 100 0 30 100
1
N
N I~
L~ L
1
NS
-6V 0 6V -6V 0 6V
Measured value Measured value

For the setting procedure, see section 5.9.

e Alarm Indication
Alarm mark, alarm type, and measured value are displayed as follows according to
the alarm status.

When indication is When indication is
set to non-hold set to hold
Alaam ACK Alarm ACK

Mam e L | ] .

Alarm mark Green| Red | Green | Green | Blinking |Blinking: Green Green | Blinking ;| Red | Green
red green red

Alarm type None| Red | None | None| Red None :None None| Red :Red|None

Measured Blue| Red | Blue | Blue | Red Blue : Blue Blue| Red (Red| Blue
value
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1.3 Display

Digital Display

Displays the measured data numerically using large numbers. For the operating
procedure, see section 4.2.

1 .6631u 0. 5014: nit

Y Measured value
IIIC Alarm mark
2 ie Tag name or channel numbers
tOver | -0.4410
v v
H B
Nofte

¢ Numeric display of measurement channels
If a measured value of a measurement channel is over range (see below), the measured

value is indicated as “+QOver” or “~Over.” If a burnout is detected on a channel whose

burnout detection function is enabled, the word “Burnout” is indicated. Otherwise, a numeric
value is displayed.
Over range of measurement channels

For DC voltage input, over range occurs when the measured value of the measurement
channel exceeds +5% of the measurable range. For example, the measurable range
when the measurement range is 2 V is —2.000 to 2.000 V. If the measured value exceeds
2.200 V, + over range occurs; if the measured value falls below —2.200 V, — over range
occurs.

For thermocouple or RTD input, over range occurs when the measured value exceeds
approximately +10°C of the measurable range. For example, the measurable range
when the measurement range is R is 0.0 to 1760.0°C. If the measured value exceeds
approximately 1770.0°C, + over range occurs; if the measured value falls below
approximately —10.0°C, — over range occurs.

For channels that are linearly scaled, + over range occurs when the value exceeds
30000 excluding the decimal point; — over range occurs when the value falls below
—30000. However, + over range can be changed to greater than or equal to 105% of the
scale width and — over range to less than or equal to —5% of the scale width within +
30000. For the setting procedure, see section 3.11.

¢ Numeric display of computation channels
See section 1.8, “Computation and Report Function (/M1 and /PM1 Options)

e Alarm Indication
Alarm mark and measured value are displayed as follows according to the alarm

status.

Alarm

Sqsigiod I IR IO I
Release

When indication is When indication
set to non-hold is set to hold

Alaam ACK Alarm ACK

Alarm mark Green| Red |Green| Green Eznking BIinkingEGreen Green Eglklng Red | Green

Measured
value

green

Blue | Red | Blue | Blue| Red Blue {Blue Blue| Red | Red| Blue
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1.3 Display

Bar Graph Display

Waveform data is displayed in a bar graph. For the operating procedure, see section 4.2.

4 @&—— Tag name or channel number

—2. A6

C Ul
B.3699

—2.588

C Ul
8.37a

——
Bar graph base position is set to Center
See section 5.11.

Horizontal

—3. 888

C Ul
8.37a

Alarm mark

L Upper limit of span

Scale
See section 5.7.

Alarm point mark
Bar graph (displayed using the
channel display color)
[_4_%3].1_ See section 5.11.
8.37 Lower limit of span and unit
Measured value

4. BEE

See section 5.10.

—-2.588

2. 8888

2.588

—3.888

—4. 888

3. 888

11| 1 1768 Bar graph base position is set

¥ to Normal
(The starting point of the bar
1.177 graph is the left edge or right
- " edge, which ever the value is
B smaller.)
1'173 See section 5.11.

RO

4 Bar graph base position is set
1-173 to Center

See section 5.11.

* Updating of the Bar Graph
The bar graph is updated at the same interval as numeric values.

e Alarm Indication
Alarm mark, alarm point mark, and measured value are displayed as follows according
to the alarm status.

When indication is When indication is
set to non-hold setto hold
Alarm ACK Alarm ACK
Occurrence
Alar jadl I N I [
Release
Alarm mark Green| Red |Green | Green| Blinking |Blinking: Green Green | BlNKing : Red | Green
red green red
Point mark Green| Red |Green | Green| Red Green :Green Green| Red :Red |Green
Melasured Blue| Red |Blue | Blue| Red Blue | Blue Blue| Red :Red| Blue
value
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1.3 Display

Historical Trend Display
The waveform of the past measured data (display or event data) in the internal memory

or external storage medium can be displayed. This function is called Historical trend.

* Methods of Displaying the Historical Trend
There are four methods to display the historical trend of the measured data in the
internal memory.
» Display from the alarm summary. For the operating procedure, see section 4.6.
» Display from the message summary. For the operating procedure, see section 4.7.
» Display from the memory summary. For the operating procedure, see section 4.8.
» Recall from the display selection menu. For the operating procedure, see section 4.3.
Measured data on an external storage medium can also be displayed as historical
trend. For the operating procedure, see section 6.8.

* Displayed Contents
Waveform (channel display color)

Background

color

Message (Can be changed)

The most recent data position
among the displayed data

Date and time of the data at the top on

the time axis or the time at the cursor position
The time at the cursor position is displayed
enclosed in a yellow frame.

ol))

[

Trip line

Cursor

Date and time of the data at the bottom on the
time axis

Tag name or channel number (channel display
color)

L Measured value (maximum or minimum value
over the entire display range)
Unit

Measured value (maximum or minimum value
at the cursor position)

Historical trend

Item Description

Alarm summary Displays an alarm summary of the displayed data.

Message summary Displays a message summary of the displayed data.

Data information Shows information about the displayed data (file name, sample start

time, end time, etc.).

* Added Messages
Added messages can be written. For the operating procedure, see section 5.4.
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1.3 Display

Overview Display

Displays a list of the statuses of all channels.
You can move the cursor to select a channel and display the trend, digital, or bar graph
of the group containing the selected channel.
For the operating procedure, see section 4.4.

/1 10:10: 10 ader= NEET (S

IN-va1
A
)

e Alarm Indication
Channel display area, tag name/channel number, alarm type, and measured value are
displayed as follows according to the alarm status.

When indication is

ol))

Alarm type

Cursor

Measured value and unit

Channels on which an alarm is
occurring are indicated in red

Tag name or channel number

When indication is

set to non-hold setto hold
Alarm ACK Alarm ACK
oibgsos I I I [
Alarm
Release _l—
Tag/Channel Black| White |Black | Black | Blinking |Blinking: Black Black | Blinking : White | Black
white black white
Channel Green| Red |Green|Green| Red | Green :Green Green| Red : Red |Green
area
Alarm type None| White | None | None | White | None :None None| White :White|None
Melasured Black| White |Black | Black | White | Black | Black Black| White :White|Black
value
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1.3 Display

Alarm Summary

Displays a list of the most recent alarms.
* Up to 1000 alarms can be displayed.
* You can select arbitrary alarm information and recall the historical trend of the display
data or event data that contains the alarm information.
For the setting procedure, see section 4.6.
[ -]

9 am12/E311)

1A:1

Channel Tupe wAlarm Time

> To the historical trend display

1; OFF 1 1H 2885718718 18:87:51
a0H 1 1H 2865/18/18 18:87:dd
OFF 2 1L 2865718718 18:85:38 =
a0N 2 1L 2865718718 18:83:45
@ Ak 2865/18/18 18:81:38
a0H 1 1H 2865/18/18 83:49:82
OFF 2 1L 2865/18/18 83:46:57
a0N 2 1L 2865/18/18 89:45:85
OFF 1 1H 2885/18/18 83:42:59
a0H 1 1H 2865/18/18 89:48:23
OFF 2 1L 2865718718 83:38:19
0N 2 1L 2865718718 B9:36:26
?? ? ?

FS

0N

oFf : Alarm release

Date/Time of alarm occurrence/release
Alarm No. (1, 2, 3, 4)/itype (H, L, h, |, R, 1, T, t)
Channels on which alarms are occurring

: Alarm occurrence
( « blinks until the alarm ACK operation is carried out if “Indicator” is set to

“Hold.”)

O K : Alarm acknowledge
(when blinking is cleared through the alarm ACK operation)

Cursor (selects the alarm)

Number of the alarm information displayed on the bottom line/number of alarm
information in the internal memory

IM 04L41B01-01E



1.3 Display

Message Summary
Displays a list of written messages and the time the messages were written.

» Up to 450 messages can be displayed.
» Up to 50 messages that are added to the past data section (added messages) can be

displayed.

* You can select arbitrary message information and recall the historical trend of the
display data or event data that contains the message.
For the setting procedure, see section 4.7.

r—®BET.aET

b FOYER OFF
P sTOP

DANGER,
BATTERY
POWER ON
HIGH YOLTAGE

#5/18/18 18:
#5/18/18 18:
#5/18/18 18:
#5/18/18 18:
#5/18/18 18:
#5/18/18 IB':’

83
83
a5 # —> To the historical trend display
83
82
al

E o R

Message
Added message
(displayed in blue)

Destination group to write the message
All groups or a group humber

Date/Time when the message was written

Cursor (selects the message)

Number of the message displayed on the bottom line/number
of messages in the internal memory

* Switching of the Display Items
You can switch between two sets of display contents.
» Message, time when the message was written, and group to which the message

was written

* Message, user name that wrote the message

IM 04L41B01-01E
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1.3 Display

Memory Summary
Displays the information pertaining to the display data and event data in the internal

memory.

* By selecting the display data or event data, the historical trend display can be recalled.

* The number of manual sampled data and report data (/M1 and /PM1 options) in the
internal memory is displayed.

For the setting procedure, see section 4.8.

Y 0. 1o = I (O]

A1
M. SAMPLE DATA
FEFTRT

E%zf% ! 1010 1areast } Date/Time of the most recent data
SHFLE TR ¢ © DISFLEN DA Number of data points in the internal
> Start Time Erd Tine Data Factor memory/maximum number of data
18-16 18:67:56 1818 16263 12 5 Sarli . .
@ 1010 teaee 1010 leayds 2 ik points that can be recorded in the
110 ieaca lala imerid 10 2% —1| internal
1610 G:56:20 1016 @950: 32 13 Ers Internal memory
pEmbs kel B ael|lD
1050 (560105 105 E) Ao Save at_a type
e 99522548| o 69=<3=q‘| 617 Een * Event data
T To the historical trend display
|
Status
Sampling count
Date/Time of memory stop
Date/Time of memory start

Cursor (selects the file)

¢ Switching of the Display Items
You can switch between two display methods.

» Display the start and end times
» Display the file name

¢ Saving the Data
The data in the internal memory can be saved to a CF card or USB flash memory

(/USB1 option).
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1.3 Display

Report Data (/M1 and /PM1 Options)

Report data residing in the internal memory can be displayed.

Status Display

Log Display

For the operating proce

dure, see section 4.5.

5.10:10 e EETEIO)ER  +1)

—telndex : 18/18 Kind : Hourlw

Start : 2805/11/11 18:48:35 .
Timeup: 2085/11/11 11:83:05 I—— Start:  Start date/time

— Report type

Hax  Hin Sum Timeup: Report date/time

Ch Unit Sts fve

eal u 1.78Z -1ed27 B.EP42 2 ZR4400EHE

ez | 1,764

=55 1,764 -1.E4Z B.EFS  2.2050120H
1.784

Slieas  Guers 2.mperEeR Report data status
SlLEAS RS 2.ZEEIZEMR Indicates that the following occurred

between the report interval.

E: Error data
O: Over data
P: Power failure
C: Time change

Unit

Channel number

B: Burnout
Average, maximum, minimum, sum,
or instantaneous value

Number of the displayed report data/number of report data in the internal memory

The following displays

available.

For the operating procedure, see section 4.5.

¢ Relay Status Display
Displays the status of the alarm output relay and internal switch.

* Modbus Client Status Display and Modbus Master Status Display
Displays the command status.

Displays various logs (operation log).
For the operating procedure, see section 4.9.

Log Type Description
Login Log of login/logout, log of time setting, and log of power failure
Error Log of error messages

Communications

Log of communication commands

FTP transfer Log of FTP transfers

WEB Log of Web operations

E-mail transmission  Log of e-mail transmissions

SNTP Log of accesses to the SNTP server

DHCP Log of accesses to the DHCP server

MODBUS Log of communications using Modbus client or Modbus master
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1.3 Display

Other Useful Functions
¢ Automatically Reverting to the Specified Display
Show a preset display when there is no operation for a specific time.
For the setting procedure, see section 5.14.

* Favorite Key

Register a frequently used display to the Favorite key and enable the display to be
shown through simple operation.
For the setting procedure, see section 5.15.

e Customizing the Menus
Change the FUNC key menu that appears when the FUNC key is pressed and the
screen menu that appears when the DISP/ENTER key is pressed.
For the setting procedure, see section 5.17.

Setting the Display Conditions of the LCD
The display conditions of the LCD can be configured.

Display Attribute

Setting

Background color of the
operation display

The background color of the display can be set to white or black. The
default value is White. For the setting procedure, see section 5.12.

Background color of the
historical trend screen

You can select white, cream, black, or light gray for the background
color of the screen. The default value is Black. For the setting
procedure, see section 5.12.

LCD brightness

The brightness of the LCD can be set among eight levels. The default
brightness is 2. For the setting procedure, see section 2.7.

Backlight saver

The lifetime of the LCD backlight can be extended by automatically
turning OFF or dimming the light when there is no key operation for a
specified amount of time. The display returns to the original
brightness with a key operation or an alarm occurrence. By default,
the backlight saver is disabled. For the setting procedure, see
section 2.7.
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1.4

Data Types

Data Storage Function

This section explains the types of data that the DX can record and how to store them.

The types of data that the DX can record are as follows:

Data Type Description

Display data » Waveform data displayed on the trend display. The measured data is
recorded as a specified sampling interval. The sampling interval is specified
using the trend interval.

*  The minimum and maximum values among the measured data within the
sampling interval are saved.

* Aheader string (common to other files) can be written in the file.

» The display data contains alarm and message information.

» Data format: Binary (Undisclosed)

Event data * Measured data that is recorded at a specified sampling interval. There are
two modes. One mode starts recording when a trigger event occurs. The
other mode records at all times.

* Aheader string (common to other files) can be written in the file.
» The event data contains alarm and message information.
» Data format: Binary (Undisclosed)

Manual sampled data

» Instantaneous value of the measured data when a manual sample
operation is executed.

» Aheader string (common to other files) can be written in the file.

» Data format: ASCII

Report data (/M1 and /PM1 options)

* Hourly, daily, weekly, and monthly report data. Report data is created at an
interval that is determined by the report type (one hour for hourly reports,
one day for daily reports, and so on).

* Aheader string (common to other files) can be written in the file.

» Data format: ASCII

Snapshot data (screen image data)

» The image data of the DX screen when the snapshot operation is executed.
* The data can be saved to a CF card.
» Data format: PNG

Setup data * The setup data of the DX.
» Data format: Binary (Undisclosed)

Display data and event data

Display data can be likened to the conventional recording on the chart sheet and
are useful for long-term recording. Event data is useful when you wish to record the
measured data in detail.

o [ J

. - 1

Maximum value per sampling interval - o ® ‘ 1
Minimum value per sampling interval —>| b H i 1

H H H 1
" ° ® . o o, Event data
; : ; i I

1
, Measured data per
1 scan interval

Scan interval
Sampling interval of event data

Sampling interval of display data
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1.4 Data Storage Function

Flow of Data Recording and Storage
Measured data is recorded once to the internal memory and then saved to the external

storage medium.

Measurement Computation
channel channel

~——Data of another device
(via communication)

N

. Display Setup data
Sampling
Internal memory D

=
1
Screen image Save
Save the data data
FTP server on
the network < Display/Event EE
dalta

<> ]

CF card USB memory (/USB1 option)

External storage medium

Internal Memory
Display data and event data are held in files in the internal memory. The data area also
stored on the external storage medium in files.

Internal memory

Manual

Display data and event data sampled data

Report data

FTP server on <—¢
the network

Directory on the external storage medium
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1.4 Data Storage Function

Recording Method of Display Data and Event Data

For the setting procedure, see section 6.1.

* Types of Data to Be Acquired

Select display data only, display data and event data, or event data only.

Deciding the Data to Be Recorded

Record the data that suits your application. Refer to the following examples.

Example 1: Continuously record the waveform data as with the conventional chart
recorder.
Record the display data.

Example 2: Record waveform data under normal conditions but record details around
the point of alarm occurrence when alarms occur.
Continuously record display data and record event data when alarms
occur.

Example 3: Only record the most-detailed data at all times.
Record event data by specifying the sampling interval.

Example 4: No need to continuously record data. Record data only when alarms
occur.
Record event data only when alarms occur.

* Internal Memory
The recorded measured data is divided at a specific time interval and saved to files.

The size of the internal memory that holds the files is 80 MB or 200 MB (expansion
memory). If this size is exceeded or if the number of display data files and event data
files exceeds 400, files are overwritten from the oldest file.

¢ Recording Conditions of Display Data

Item Description

Source channels Select from measurement channels and computation channels.

Sampling interval Specify the sampling interval with the trend interval (see the table
below). You cannot specify a sampling interval that is faster than the
scan interval.

File creation Files are created at the specified file save interval.

//\‘/\’—’ Time
1 1 1 >
File File File Adding data

Files are also created in the following cases.

* When a file is created manually.

* When the memory sampling is stopped.

» When file creation is executed with the event action function.

Memory start/stop Press the START key to start recording (memory start) and the
STOP key to stop the recording (memory stop).

Trend interval and the sampling interval of display data

Trend interval [/DIV] 15 s* 30s 1 min 2 min 5 min
Sampling interval of displayed data (s)| 0.5 1 2 4 10
Trend interval [/DIV] 10 min| 15 min | 20 min 30min | 1h
Sampling interval of displayed data (s)| 20 30 40 60 120
Trend interval [/DIV] 2h 4h 10 h

Sampling interval of displayed data (s)| 240 480 1200

* DX1002, DX1002N, DX1004, and DX1004N only.
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1.4 Data Storage Function

¢ Recording Conditions of Event Data

Item Description

Source channels Same as the display data.

Sampling interval Select from the available settings between 25 ms to 600 s. However,
you cannot specify an interval that is faster than the scan interval.

File creation Afile is created when the specified data length is reached.

Files are also created in the following cases.

* When a file is created manually.

* When the memory sampling is stopped.

* When file creation is executed with the event action function.

Mode The available modes are Free (continuously record), Single, and
Repeat. The recording operation varies depending on the mode as
follows:

Free
Press the START key to start recording (memory start) and the STOP
key to stop the recording (memory stop) .

/ /\t/\’— Jime

I I I v

File File File Adding data
Single
Pressing the START key places the DX in the trigger-wait state. When
the trigger condition is met, the DX records data for a specified time (data
length) and stops. From this point, the DX does not record even if the
trigger condition is met.

Trigger co?dition met

M Time

File

Repeat

Pressing the START key places the DX in the trigger-wait state. When
the trigger condition is met, the DX records data for a specified time
(data length) and stops. The DX enters the trigger-wait sate again and
keeps recording the data for a specified time (data length) each time the
trigger condition is met. To stop the recording of the event data, press
the STOP key.

Trigger condi:ion met Trigger*condition met

W Time

Pretrigger of Event Data
The pretrigger can be specified in trigger mode.
This function is used to save the data before the point where the trigger condition
is met as event data. This function is convenient when you wish to record the data
before the occurrence of a certain event such as when an alarm occurs.
Specify the pretrigger as a percentage (0, 5, 25, 50, 75, 95, or 100%) of the recording
time (data length) of the event data. If set to 0%, the data after the trigger condition is
met is recorded.

Trigger co?dition met

/ ‘ Time
] <
Data before ——I |<— Data after —>|
the trigger the trigger

Trigger for Starting the Event Data Recording
When set to trigger mode, you can set various conditions for starting the recording.
Example: Key operation, alarm occurrence, specific time, or remote control
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1.4 Data Storage Function

¢ Creating Files through Key Operation
Files can be created using keys.
Key operation

/ /\t/\ﬁ Jime

I I I I i

File File File
Previous files [ Current file ]

Manual Sampled Data

Manual sampled data is recorded to the internal memory. When the number of manual
sampled data exceeds 400, the data is overwritten from the oldest data.

/_/M Jime

! ! L ]

= Manual sampled data

Report Data

Report data is recorded to the internal memory. When the number of report data
exceeds 100, the data is overwritten from the oldest data.

/ /\T/\T’ Jime

: il '

= Report data
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1.4 Data Storage Function

Saving Data to the External Storage Medium
For the setting and operating procedure, see sections 6.2 and 6.4 respectively.

Type of External Storage Medium
* CF card (32 MB or more)
» USB flash memory (/USB1 option)

Auto Save
Have the CF card inserted in the slot at all times. The data in the internal memory is
automatically saved to the CF card.
Auto Save Timing
Data Type Description
Display data The file is saved when the file is created.
/ /\/—\’—’ Time
I T »
File | File | File |

[ Save to the CF card ]
Event data Same as the display data.

Manual sampled data  The first time manual sample is executed, a manual sampled data file
is created on the CF card. The data is appended to this file for each
subsequent manual sample operation.

Report data The first time report data is generated, a report data file is created on
the CF card and report data is stored. The report data is appended to
this file every time of report.

Dividing of the report files

The appending of the report data to the file is stopped at a specified
time, and subsequent reports are saved to a new file. The file is divided
in the unit shown in the table below.

Report Type Report File

One File File for Each Type

Hourly report |[—_Jhourly reports of a day

Daily report |[__]daily reports for a month

Hourly and  (_Jhourly reports for a day and  |[_] a file for each daily report

daily reports a daily report [ hourly reports of a day

Daily and [Jdaily reports for a week and  |[—_] a file for each weekly report
weekly reports a weekly report [ daily reports for a month
Daily and [_Jdaily reports for a month and |[__] a file for each monthly report
monthly reports| a monthly report [ daily reports for a month

Save Destination
CF card.

Data Save Destination Directory
You can set the data save destination directory name (DATAO by default). The
specified directory is created on the CF card, and the data is saved in the directory.

Save Operation (If Media FIFO Is Disabled)

The data in the internal memory can be saved only if there is sufficient free space on
the CF card. Replace the CF card and save the data before the data in the internal
memory is overwritten.

Save Operation (Constantly Retaining the Most Recent Data Files Using Media
FIFO) (Release Number 2 or Later)

When saving the data files automatically, you can save the data so that the most
recent data files are constantly retained in the CF card. This method allow you to use
the DX continuously without having to replace the CF card.
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1.4 Data Storage Function

e Operation

4 N
oid Update date New N\
<« >
| Il
@ted File 1 File 2 File 3 <Saved File 4
- e
\_ Medium )
AN N

If not enough free space is available when saving a new data file to the CF card,
files are deleted in order from the oldest data update date/time to save the new file.
This operation is referred to as FIFO (First In First Out).

» The FIFO operation is carried out only when saving the following files
automatically. It is not carried out when saving files to the save destination
directory using another method. Display data files, event data files, report data
files, manual sample data files, and snapshot files

» Files that are deleted
All the files in the save destination directory are applicable to be deleted.
However, the following files are excluded. Hidden files, read-only files, files in
the subdirectory within the save destination directory

» The most recent 1000 files are retained. If the number of files in the save
destination directory exceeds 1000, the number of files is held at 1000 by
deleting old files even if there is enough free space.

» fthere are more than 1000 files already in the save destination directory, one or
more files are always deleted before saving the new file. The number of files is
not kept within 1000 in this case.

¢ Manual Save (Collectively Storing Unsaved Data)

Unsaved data in the internal memory is stored in unit of files to the external storage
medium when an external storage medium is inserted and a given operation is carried
out.

Save operation

/ /\t/\ﬁ Jime

I I I I v

File File File
AN
Saved the A
previous time [ Saved this time ]

When using manual save, it is important that you save the data in the internal memory
to the external storage medium before the data is overwritten. Determine the usage
condition of the internal memory and save the data to the external storage medium at
appropriate times.

Save Destination
You can select a CF card or USB flash memory (/USB1 option).

Data Save Destination Directory
You can set the data save destination directory name (DATAO by default).

IM 04L41B01-01E
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1.4 Data Storage Function

* File Name
You can select the file name configuration from three types.

Structure Description
Date Display data
Event data 7-digit | _Specified string [0 Date . [Extension
Manual sampled data | Ex: 000123 AAAAAAAAAAA050928 174633.DAD
Snapshot data
Report data 7-digit | _Specified string | Date [ETyped . [Extension
Ex.: 000123_AAAAAAAAAAA050928_174633HD.DAR
Sequence Display data
Event data [ 7-digit W Specified string I . [Extension |
Manual sampled data | £y : 000123_AAAAAAAAAAA.DAD
Snapshot data -
Report data 7-digit_ I _Specified sting _IETypes .
Ex.: 000123_AAAAAAAAAAAOHD.DAR
Batch name  |Display data :
Event data Ex.: 000123_BBBBBBBBBBBBBBBBBBBBB.DAD
Report data [ 7-digit_| Date [ETypes . [ Extension
Ex.: 000123_050928_174633HD.DAR
Manual sampled data | [ 7.digit | Date | . [Extension
Snapshot data Ex.: 000123_050928_174633.DAM
Item Description
7-digit Consists of a 6-digit number and 1-character delimiter.
6-digit A sequence number in the order of occurrence. The number ranges from
number 000001 to 999999. If the number reaches 999999, it returns to 000001.
1-character | Starts with ‘_’ and takes on the following values: Ato Z and 0 to 9.
delimiter If a file with the same name exists in the specified directory, the file is
saved by changing the delimiter to prevent overwriting.
Example:If a file named “000123_AAAAAAAAAAA.DAD” already exists,
the file is saved to the name “000123AAAAAAAAAAAA.DAD.”
Date YYMMDD_hhmmss YY: Year (lower two digits), MM: Month, DD: Day
hh: Hour, mm: Minute, ss: Second
Specified string |AAAAAAAAA«s-A Up to 16 alphanumeric characters can be used
Batch name BBBBBBBBBBB+*B |Up to 40 alphanumeric characters can be used
Type H_,D_,W_M_ Report data type
HD, DW, DM H_: Hourly, D_: Daily, W_: Weekly, M_: Monthly,
HD: Hourly and daily, DW: Daily and weekly,
DM: Daily and monthly
Extension Display data :DAD Report data :DAR
Event data :DAE Snapshot data :PNG
Manual sampled data :DAM Setup data :PDL

Note

Differences from the File Names up to Now

* The “ID” item at the end of the file name is deleted and its functionality is included in the

“Separator” of the 7-digit sequence.

» The sequence section of the display data and event data file names is changed to 7 digits,
and the “ID” function is included in the “Separator” when using the “Batch name.”
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1.4 Data Storage Function

File Names on DXs before Release Number 2
The table below shows the file name that is assigned when the measured data is saved
to the CF card.

Structure Description
Date Display data
Event data 7-digit |0 Specified string 1| Date [0 1. [Extension
Manual sampled data | gy . 000123_AAAAAAAAAAA050928_1746330.DAD
Snapshot data
Report data 7-digit I _Specified string 1) Date ETyped 1D | . [Extension]
Ex.: 000123_AAAAAAAAAAA050928_174633DH0.DAR
Sequence Display data
Event data . [Extension]
Manual sampled data | Ex.: 000123_AAAAAAAAAAA0.DAD
Snapshot data
Report data 7-digit | B0 Specified string IETYPed ID | . [Extension]
Ex.: 000123_AAAAAAAAAAAHDO.DAR
Batch Display data :
name Event data Ex.: 123BBBBBBBBBBBBBBBBBBBBB0.DAD
Report data 7-digit_| Date ETyped 1D | . [Extension
Ex.: 000123_050928_174633HD0.DAR
Manual sampled data 7-digit | Date [ 10 ].[Extension
Snapshot data Ex.: 000123_050928_1746330.DAM
Item Description
Date YYMMDD_hhmmss Same as release number 2 and later.

7-digit sequence

000001 to 999999

Consists of a 6-digit number and an underscore as a separator.
A sequence number in the order of occurrence.

3-digit sequence |001 to 999 A sequence number in the order of occurrence.
Type H,D_,W_M, Report data type
HD, DW, DM Same as release number 2 and later.

ID 0to9,AtoZ When a file with the same name exists in the specified directory,
the file is saved by changing the ID character to prevent
overwriting.

Example:If a file named

“000123_AAAAA050907_1036480.DAD”

already exists, the file is saved to the name

“000123_AAAAA050907_1036481.DAD.”
Extension Same as release number 2 and later.

IM 04L41B01-01E
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1.4 Data Storage Function

¢ Saving Data through Key Operation

You can carry out the following data save operations regardless of whether auto save
or manual save is used.

Data Storage Description

All save Collectively saves all the data in the internal memory.

Selective save Saves the specified display data or event data file.

Manual sampled data save  Collectively saves all the manual sampled data in the internal
memory.

Report data save Collectively saves all the report data in the internal memory.

Save Destination
You can select a CF card or USB flash memory (/USB1 option).

Data Save Destination Directory

Creates a directory with the name of the data save destination directory name with the

date/time added and saves the data.

Directory name: “Specified string”_YYMMDD_HHMMSS

Example: If the data is saved at 17 hours 6 minutes 42 seconds on September 30,
2005, the data is saved to a directory named “DATA0_050930_170642.”
“DATAQ” is the specified string.

Nofte

The number of directories that you can create on the external storage medium varies
depending on the length of the directory names. If the length of the “specified string” is 5
characters, approximately 170 directories can be created. If it is 20 characters, approximately
120 directories can be created. An error occurs, if you try to create directories exceeding this
limit.

Other Types of Data That Can Be Stored

e Setup Data

The setup data of the DX is saved to a CF card or USB flash memory (/USB1 option).
The setup data is saved to the root directory.

Name of the setup data file [ Specified |. PDL
Example: ABCD10005.PDL

¢ Snapshot Data

The screen that the DX displays is saved to a CF card in PNG format. The data is
saved to the same directory as the display data and event data. For the file name, see
the previous page.

e
i Iime

»

Snapshot

[m] [u] [u] [u]
Data file

CF card

Saving Data via the Ethernet Network

Display data, event data, report data (/M1 or /PM1 option), and screen image data can
be automatically transferred and saved to an FTP server via the Ethernet network by
using the FTP client function. Conversely, the DX can function as an FTP server. The
DX can be accessed from a PC and the data files in the internal memory or the external
storage medium can be retrieved to be stored on the PC.

See the Communication Interface User’s Manual IM 04L41B01-17E.
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1.5 Batch Function

Batch Information

You can add batch information to the display data and event data files. The files can be
managed using the batch information.
For the setting and operating procedure, see section 6.3.

Batch Number and Lot Number
A file can be identified by its “batch number-lot number.” The lot number does not have

to be specified.
« Batch number (up to 32 characters).
* Lot number (up to 8 digits)

Automatic Increment of the Lot Number
The lot number can be automatically incremented when the memory sampling is

stopped.

Text Field
Eight sets of arbitrary text can be entered in a file. Each text field consists of the

following:
» Field title (up to 20 characters)
» Field string (up to 30 characters)

The text field can be shown on the DX screen through key operation.

Batch Comment
Three arbitrary comments can be entered in a file. A single comment can be entered

while memory sample is in progress.
* Comment 1, Comment 2, and Comment 3 (up to 50 characters each)

Using the Batch Function

See the figure below. For example, enter the operator and administrator in the text field.

Memory start Comment Memory stop

Batch number + lot number
Text field => Time

Comment I__I g

AN J
Vo

% Data file

IM 04L41B01-01E
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1.6

Events

Event Action Function

A specified action is carried out when an event occurs. This function is called event

action.

For the setting procedure, see section 7.1.

* Events
Select from the following events.
Event Level/Edge*  Description
Remote Level/Edge ON/OFF of the remote control input.
Output relay Level/Edge Activated/Deactivated condition of the alarm output relay.
Internal switch  Level/Edge The value 0 and 1 of the internal switch.
Timer Edge Timer timeout.
Match time timer Edge When the time matches.
Alarm Level/Edge The state in which any alarm is occurring and the state in
which no alarm is occurring.
USER key Edge The operation of pressing the USER key.

* For a description of level and edge, see “Miscellaneous” in this section.

e Timers

Four timers are available.

Timer Type

Absolute timer

Relative timer

Set the timer

Reset the timer

Set the timer

Time

»

?

»

Time

A A A A B B
* Timeout A: Interval

¢ Absolute Time Mode
The timer expires at the times determined by the reference time and the interval.

The reference time is set on the hour (00 to 23).

Example: Reference time: 00:00
Interval: 10 min
The timer expires at 0 hour, 0 hour 10 min, 0 hour 20 min, ... 23 hour 40
min, and 23 hour 50 min. For example, if the timer is set at 9 hour 36
min, the timer expires at 09 hour 40 min, 09 hour 50 min, 10 hour, and
SO on.

¢ Relative Time Mode

The timer is started when the timer is set, and the timer expires every specified

interval. In this mode, the timer stops when a power failure occurs.

Example: Interval: 00:15
The timer expires every 15 minutes.

B: Interval

Match Time

You can set the time matching conditions for the four match time timers. Specify
the date/time using the method described below. For each condition, you can select
whether to use the condition once or continuously.

Specified Date/Time

Y hour of the X day

Y hour of the X day of the week
Y hour

Description

The condition is met once a month.

The condition is met once a week.

The condition is met once a day.
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1.6 Event Action Function

Action

Actions

Select from the following actions.

Action LevellEdge* Description

Memory start/stop Level Starts/stops memory sampling.

Memory start Edge Starts the memory sampling.

Memory stop Edge Stops the memory sampling.

Event trigger Edge Applies a trigger for starting the event data

recording.
This is valid when recording event data in trigger
mode. See the next page.

Alarm acknowledge Edge Releases the alarm output.
This is valid when the use of the alarm ACK
operation is enabled.

Computation start/stop*™  Level It is used to start/stop the computation.

Computation start** Edge Starts the computation.

Computation stop** Edge Stops the computation.

Computation reset** Edge Resets the computed values on all computation
channels.

Save display data Edge The display data being recorded is saved to the

internal memory as a file. This is the same function
as the data save operation using the FUNC key.

Save event data Edge The event data being recorded is saved to the
internal memory as a file.
This is the same function as the data save operation
using the FUNC key.

Message Edge Writes a message.
This action can be executed while memory sampling
is in progress.

Snapshot Edge Saves the screen image data.

Switch the display rate Level Toggles between the trend interval and the
secondary trend interval.
This action is valid when the DX is configured to use
trend interval switching.

Manual sample Edge Executes manual sampling.

Reset the relative timer Edge Resets the relative timer. The timer restarts from
that point.

Switch the display group  Edge Switches the display group when the trend, digital,
or bar graph is displayed.

Flag** Level The flag is zero for normal conditions and 1 when an

event occurs. The flag can be written in a calculation
expression of a computation channel.

Load the setup Edge Loads the setup data file in the root directory of the
CF card into the DX and updates the DX settings.
See below.

Adjust the time Edge Synchronizes the time to the nearest hour. See the
next page.

* For a description of level and edge, see “Miscellaneous” in this section.

**An option.

Resetting the Relative Timer
If the event is set to output relay, internal switch, match time timer, or alarm, the

resetting of the timer is not considered a timeout. (The action is not executed even if
the timer is used as an event.)

Loading the Setup
Can be specified as an action only when the event is set to remote control input.

Loads the setup data file, LOAD1.PDL, LOAD2.PDL, or LOAD3.PDL, in the root
directory of the CF card into the DX and updates the DX settings.
You must create a setup file and save it to the CF card in advance.
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1.6 Event Action Function

Event Trigger Operation

When the event is set to output relay, internal switch, or alarm

If the output relay is activated, the internal switch is 1, or the alarm is occurring during
memory sampling, the event trigger is always activated. However, the number of times
the trigger is activated depends on the event data mode (single or repeat).

Time Adjustment

Time adjustment can be specified as an action only when the event is set to remote
control input. The internal clock of the DX is adjusted to the nearest hour through
remote control input.

* Operation When Memory Sampling Is Stopped

Difference from the Nearest Hour Operation

00 min 00 s to 01 minto 59 s Truncates the minutes and seconds.
Example: 10 hours 01 min 50 s becomes 10 hours 00 min
00 s.

02 min 00 s to 57 minto 59 s The time is not changed.

58 min 00 s to 59 min to 59 s Rounds up the minutes and seconds.
Example: 10 hours 59 min 50 s becomes 11 hours 00 min
00 s.

¢ Operation during Memory Sampling
If the time difference between the time the remote control signal is applied and the
nearest hour is within the preset time, the time is gradually corrected. Otherwise,
the time is corrected immediately. For details, see section 10.1.

Miscellaneous
Limitations on the Combinations of Events and Actions
The combinations that are checked in the table below can be used.
Event Remote | Output | Internal Timer Match Alarm | User Key
Action Relay Switch Timer
Alarm ACK v v v v
Reset the relative timer v v v v v v
Load the setup v
Adjust the time v
Other actions v v v v v v v
Level and Edge
The combinations of events and actions are summarized in the figure below.
Type Operation
Event
Edge Edge
Level
Action Status 1
Level Edge
Status 2 Operation Operation
executed executed
Level and Edge of the Remote Control Input Signal
Level Edge
ON |
t OFF L
—>H<—250 ms or more
For contact inputs, the remote signal rises when the contact switches from open to
closed and falls when the contact switches from closed to open. For open collector
signals, the remote signal rises when the collector signal (voltage level of the remote
terminal) goes from high to low and falls when the collector signal goes low to high.
1-34
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1.7  Security Function

Key Lock Function
Key lock is a function that prohibits key operations. You enter a password to release the

key lock.
For the setting procedure, see section 8.1.

Key Lock Items Description

Keys The following keys can be locked independently.
START key, STOP key, MENU key, USER key, DISP/ENTER
key (prohibits switching the operation screen), and Favorite key.

Access to the storage medium Prohibits all operations listed below.
* Manually save the data
» Load the display data and event data files
» Save/Load setup data files
« List the files on the storage medium
* Delete the files on the storage medium
* Format the storage medium

Function operation The following FUNC key operations can be locked
independently.
» [Alarm ACK]
* [Message], [Free message], [Batch],
[Add Message], [Add Free Message]
[Text field]
* [Math start], [Math stop], [Math reset],
[Math ACK]
* [Save display], [Save event],
[Manual sample], [Trigger],
[Snap shot], [Timer reset], [Save stop]
* [E-Mail start], [E-Mail stop], [FTP test],
Operations to [Request] or [Release] network information
* [SNTP], time setting (operation in the setting mode)
 [Favorite regist], [Standard display],
[Second speed], [Normal speed]
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1.7 Security Function

Login Function

Only registered users can operate the DX. Access from communication functions can
also be limited to users registered here.
For the setting and operating procedure, see sections 8.2 and 8.3 respectively.

* Login and Logout
You enter your user name and password to log into the DX in the following cases.

Method of Accessing the DX  Login Required

Keys * When the power is turned ON
* When logging in after exiting the basic setting mode
* When logging in after logging out

Communication When accessing the setting/measurement server, FTP server,
maintenance/test server, or Web server.

Auto Logout (When Logged in Using Keys)

When logged in using keys, you are automatically logged out when there is no key
operation for a specified time. If you are automatically logged out from the setting
mode, the setting changes are cancelled. You are not automatically logged out during
basic setting mode.

Operations That Can Be Carried Out When Logged Out
When logged out, you can switch the operation screen using the DISP/ENTER key,
arrow keys and Favorite key.

e User Levels
A user can be an “administrator” or a “user.”
Administrator
Administrators can perform all operations on the DX. At least one administrator must
be registered to use the login function.

Item Description

Number of users that 5
can be registered

Range of operations  All operations.

Login method Select key operation, via communication, or Web server login.
ID information User name and password

User

Item Description

Number of users that 30
can be registered

Range of operations Key operations

Operation Limitation
Basic setting mode Not allowed
Setting mode Customize menus Not allowed
Other Specified by user privileges
Operation mode  |Key operation Specified by user privileges|

¢ User privileges
You can set operation privileges for each user. The privileges are the
same as with the key lock function.

Operations via communication

See the Communications Interface User’s Manual.

Login method Select key operation, via communication, or Web server login.

ID information User name and password
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1.8

Computation and Report Function (/M1 and
/PM1 Options)

Computation Function

Equations can be defined in computation channels by using the measured data or
computed data as variables. The result of the computation can be displayed or stored.
For the setting procedure, see section 9.1.

¢ Channels Dedicated to Computations

Model Number of Channels Channel Numbers
DX1002, DX1004, DX1002N, DX1004N 12 101 to 112
DX1006, DX1012, DX1006N, DX1012N 24 101 to 124

¢ Computation Types
In the table below, [001] represents the measured value of channel 001.

Type Example Description of the Example
Four arithmetic 001+002 Determines the sum of [001] and [002].
operation 001-002 Determines the difference between [001] and [002].
001*002 Determines the product of [001] and [002].
001/002 Divides [001] by [002].
Power 001**002 Determines [001] to the power of [002]. y = X"
Square root SQR(001) Determines the square root of [001].
Absolute value ABS(001) Determines the absolute value of [001].
Common logarithm LOG(001) Determines the common logarithm of [001]. y = log1ox
Natural logarithm ~ LN(001) Determines the natural logarithm of [001]. y = Inx
Exponent EXP(001) Determines e to the power of [001]. y = &*
Relational 001.LT.002 The result is 1 when [001] is less than [002] or O
computation otherwise.
001.LE.002 The result is 1 when [001] is less than equal to [002] or
0 otherwise.
001.GT.002 The result is 1 when [001] is greater than [002] or O
otherwise.
001.GE.002 The result is 1 when [001] is greater than equal to [002]
or 0 otherwise.
001.EQ.002 The result is 1 when [001] is equal to [002] or O
otherwise.
001.NE.002 The result is 1 when [001] is not equal to [002] or O
otherwise.
Logical computation 001ANDO002 The result is 1 when [001] and [002] are nonzero or 0
otherwise.
0010R002 The result is 1 when [001] or [002] or both are nonzero
or 0 otherwise.
001XOR002 The result is 0 when [001] and [002] are nonzero or 1
otherwise.
NOTO001 The result is 1 when [001] is zero or O otherwise.

TLOG computation®* TLOG.SUM(001) Determines the sum of [001].

TLOG.MAX(001) Determines the maximum value of [001].

TLOG.MIN(001)  Determines the minimum value of [001].

TLOG.AVE(001)  Determines the average value of [001].

TLOG.P-P(001) Determines the difference between the maximum value
and minimum value of [001].

* Usage is explained “Usage of TLOG Computations” in this section.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

Type Example Description of the Example
CLOG computation CLOG.SUM(001.002.003)
Determines the sum of [001], [002], and [003].
CLOG.MAX(001.002.003)
Determines the maximum value among [001], [002],
and [003].
CLOG.MIN(001.002.003)
Determines the minimum value among [001], [002], and
[003].
CLOG.AVE(001.002.003)
Determines the average value of [001], [002], and [003].
CLOG.P-P(001.002.003)

Determines the difference between the maximum value
and the minimum value among [001], [002], and [003].

Special computation PRE(001) Determines the previous value of [001].
101=HOLD(001.GT.K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried
out to derive the computed value. When [001] exceeds
K01, the previous computed value is held.

K01

Description
HOLD(a):b When a is zero, b is carried out to derive the computed
value. Otherwise, the previous computed value is held.

RESET(101.GT.K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried
out to derive the computed value. When [101] exceeds
K01, the previous computed value is reset, and
TLOG.SUM(001) is carried out.

- \Reset
10 '\n
Description

RESET(a):b When a is zero, b is carried out to derive the computed
value. Otherwise, the previous computed value is
reset, and b is carried out to derive the computed value.

CARRY(K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried
out to derive the computed value. When the computed
value is greater than or equal to K01, the computed
result is the excess (computed value — K01).

K01

Ko1 4

Description
CARRY(a):b Only TLOG.SUM can be specified for b. If the
computed value X of b is less than a, the computed
result is X. If X is greater than or equal to a, the
computed result is the excess (X — a).
Conditional equation[001.GT.K01?001:001+002]
When [001] is greater than K01, the computed value is

set to the value of [001]. Otherwise, the computed
value is set to the value of [001] + [002].

Description
[a?b:c] If the computed result of a is nonzero, b is carried out.
Otherwise, c is carried out.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

Data That Can Be Used in Equations
The data listed below can be used.

Data Notation Description

Measurement channel data 001, etc. Specify the computed data using a channel number.
Computation Channel data* 101, etc. Specify the computed data using a channel number.
Constant K01 to K60  Avalue.

Communication inputdata  C01to C24 Data set through communications.

Status of the remote control* D01 to D08** The value is 1 when the remote control input is ON

input or 0 when it is OFF.
Pulse input* P01 to P08** Counts the number of pulses per scan interval.
Q01 to Q08** Counts the number of pulses per second.
Internal switch status S01t0S30 1or0.
Alarm output relay* status 101 to 106 The value is 1 when activated or 0 when
deactivated.
Flag FO1to FO8 1 or 0. Set the flag using the event action function

(see section 1.6).

* An option. ** Values such as 01 are terminal numbers.

Only the data that are checked in the table below can be used in TLOG, CLOG, and
PRE.

Data | Meas. | Comp. | Constant | Comm.|Remote| Pulse |Internal| Relay | Flag
Comp. Type CH CH Input Switch
TLOG v v v v v v
CLOG v v
PRE v v v v v v
Other computations v v v v v v v v v

Example: TLOG.SUM(S01), CLOG.AVE(001.002.K01), and PRE(S01) are not allowed.

Processing Order of Computation

Computation is processed in order from the smallest event action number for each
scan interval.

Example: If you specify 102 = 101 + 103, the value of the previous scan interval is
used for the 103 value.

Handing of the Unit in Computations

In computations, measured values are handled as values without units. For example,
if the measured data from channel 001 is 20 mV and the measured data from channel
002 is 20 V, the computed result of 001 + 002 is 40.

Displaying the Computed Data

The computed data is displayed by setting a measurement span for each computation
channel. Computation channels can be displayed on various operation screens in the
same fashion as the measurement channels.

For the setting procedure, see section 9.3.

Alarm

Up to 4 alarms can be assigned to each computation channel. The alarm types are
high limit alarm (H), low limit alarm (L), delay high limit alarm (T), and delay low limit
alarm (t).

Saving Computed Data
As with the measured data, the computed data can be saved to display data, event

data, manual sampled data, and report data.

Computation Data Dropout

A computation data dropout occurs if the computation is not completed within the scan

interval. For the operating procedure, see section 9.4.

» The computation icon in the status display section turns yellow.

*  When a computation data dropout occurs, the computed data of the scan interval in
which the dropout occurred is set to the data immediately before the dropout.

» If computation data dropout occurs frequently, lessen the load on the CPU by
reducing the number of computation channels or setting a longer scan interval.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

* Numeric Display and Recording

The range of displayed values of computed data is from —9999999 to 99999999
excluding the decimal point. The decimal place corresponds to the decimal place of
the lower limit span of the computation channel. On the numeric display, values are
displayed if the computed result is within the above range regardless of the upper and
lower limits of span. The following table indicates special displays.

Display/Recording Computed Data Status

+Over » +Display over: When the computed result exceeds 99999999
» +Computation over: When the value exceeds approximately
3.4x10%® in the middle of the computation
» When a computation error* occurs (select +Over or —Over.)

—Over » —Display over: When the computed result is less than —9999999
« —Computation over: When the value is less than approximately —
3.4x10%% in the middle of the computation
* When a computation error* occurs (select +Over or —Over.)

*

Computation error occurs when the following computation is carried out.
+  X/0, SQR(=X), or LOG(—X)
» If a channel number set to skip or Off is used in the equation

Rolling Average

The rolling average of the computed result of the equation specified for the
computation channel is determined, and the result is the computed data for that
channel. The number of samples and the sampling interval can be specified for each
computation channel. The rolling average is applied over the time corresponding to “the
number of data samples x the sampling interval.” The maximum sampling interval is 1
hour, and the maximum number of samples is 1500.

Starting the Computation
You can configure the DX to start the computation when you press the START key.

Usage of TLOG Computations

TLOG computation determines the sum, maximum, minimum, average, or the
difference between the maximum and minimum of a specific channel for each interval
determined by a timer.

Timers That Are Used

The timer that is used is assigned to each channel.

Unit of Sum Computation
Set the sum scale when using sum computation (TLOG.SUM).
Select Off, /s, /min, or /h. For details, see the next page.

Resetting the TLOG Computed Value

You can select whether to reset the TLOG computed value at each interval. The figure
below illustrates the reset operation for sum computation (TLOG.SUM).

Example: Result of the TLOG.SUM computation

Timer timeout 1 2 3

Reset Reset Reset
Reset: On W
Reset: Off

When reset is On, the sum value is calculated over each interval. When set to Off, the
sum value from computation start is calculated.

Power Failure Operation, Handling of Error Data, and Handling of
Overflow Data
See “Special Data Handling” in this section.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

Report Function

This function is used to create hourly, daily, weekly, and monthly reports.

Report Data Types 9
You can select from four types among maximum value, minimum value, average S
value, sum value, and instantaneous value. g'
Report Type ?n“
Type Description S
Hourly report Creates report data every hour on the hour for the previous one hour. %‘
Daily report Creates report data every day at a specified time for the previous one day. a
Weekly report Creates report data every week at a specified time at a specified day of the
week for the previous one week.
Monthly report Creates report data every month at a specified time at a specified day for

the previous one month.

Combinations of Reports That Can Be Created
You can select from hourly reports only, daily reports only, hourly and daily reports,
daily and weekly reports, and daily and monthly reports.

Source Channels
You can select from measurement channels and computation channels. The report

data are not created for channels that are set to Skip or Off. The number of channels
is 24.

Unit of Sum Computation
In the sum computation, data are summed over the scan interval. However, for flow

values that have units /s, /min, /h, or /day a simple summation results in the actual
value not matching the computed result, because the scan interval and the unit of the
input values are different. In such cases, set the sum scale to match the unit of the
input value. In effect, the sum value with the same unit as that of the input value is
calculated.

For example, if the scan interval is 2 s, and the input value is 100 m*/min, a simple
summation would add 100 every 2 s resulting in 3000 after one minute. However, if
the sum scale is set to /min, then 2 s/60 s is multiplied every scan interval before the
value is added giving a result that has an m®/min unit.

The following converting equations are used to compute the sum. The unit of the scan
interval is seconds.

Off: >(measured data every scan interval)

Is: >(measured data every scan interval) x scan interval
/min:  ¥(measured data every scan interval) x scan interval/60
/h: >(measured data every scan interval) x scan interval/3600

/day: X(measured data every scan interval) x scan interval/86400

Displaying the Report Data
You can display the report data using keys.
For the operating procedure, see section 4.5.

Saving the Report Data
See section 1.4, “Data Storage Function.”

Numeric Display and Recording
The numeric range of the report data is from —9999999 to 99999999 excluding the

decimal point.
For the data handling of special cases, see “Special Data Handling” in this section.
For details on the report file format, see appendix 3.
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1.8 Computation and Report Function (/M1 and /PM1 Options)

Special Data Handling
This section explains the handling of special data in TLOG computation, CLOG

computation, and reports.

* Power Failure Operation (TLOG and Reports)
If a power failure occurs when the report function is enabled or in the middle of the
TLOG computation, the report operation and TLOG computation resume when the
DX recovers from the power failure. The operation varies depending on whether the
DX recovers from the power failure before or after the time to create a report or TLOG
data.

Time of Recovery Operation

After the time to create the data The report or TLOG data is created immediately after the DX
recovers. The measured data up to the time of the power
failure is used. At the time the next report or TLOG data is
created, the data after the recovery is used.

Before the time to create the data After the DX recovers, report or TLOG data is created at the
normal time to create the data. The measured data excluding
the power failure period is used.

e Error Data Handling (TLOG, CLOG, and Reports)
If an error occurs in the channel data, the error data is discarded, and the computation

continues. If all the data are in error, an error results.

The following types of data are considered error data.

» Channels set to skip or Off.

» The measured result on a measurement channels is error (A/D converter failure,
etc.).

* The input of the measurement channel is in a burnout condition.

» The computed result on a computation channel is error.

* Handling of Overflow Data*

* Refers to over range on a measurement channel and computation overflow on a computation
channel.

For TLOG, CLOG, and Reports
When the channel data is overflow data, the DX handles the data as follows:

Computation Type Description
Average value or sum  Set the handling to ERROR, SKIP, or LIMIT.

value ERROR: Considers the data to be a computation error.
SKIP: Discards the overflow data and continues the computation.
LIMIT: Replaces the data with the limit value and continues the
computation.

The limit value is the span upper or lower limit or the scale
upper or lower limit of the channel.

Maximum, minimum, Set the handling to OVER or SKIP.
Maximum — minimum  OVER: Computes by using the overflow data.
SKIP: Discards the overflow data and continues the computation.

For Multiplication and Relation Computation EQ and NE

Computation Type Computation Computed Result

Multiplication 0*(+Over)
0*(—Over)
(+Over)*0
(—Over)*0

.EQ. (+Over).EQ.(+Over)
(—Over).EQ.(-Over)

.NE. (+Over).NE.(+Over)
(—Over).NE.(—Over)

~|a|lO|O|O|O|O|O
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1.9 FAIL/Status Output Function (/F1 Option)

FAIL Output

When a failure occurs in the CPU of the DX, a relay contact signal (1 signal) is output.
The relay is energized when the CPU is normal and de-energizes when a CPU failure
occurs. Therefore, relay output is carried out also when the power is turned OFF (including
a power failure). You cannot change this behavior.

Relay Operation

A A g

NO C NC NO C NC NO (o NC
During normal operation When a failure occurs When power is turned OFF

*

NO: Normally Opened, C: Common, NC: Normally Closed

If a failure occurs, contact your nearest YOKOGAWA dealer for repairs.
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1.9 FAIL/Status Output Function (/F1 Option)

Status Output

Outputs the status below with a relay contact signal (1 relay). You can select whether
each status is output to the relay. The relay is energized when the status occurs. You
cannot change this behavior.

For the setting procedure, see section 2.9.

Status

Status of the internal
memory or CF card

Description Corrective Action

Error in the internal memory. Contact your nearest
YOKOGAWA dealer for
repairs.

When the auto save function to the CF card is On.

» The free space on the CF card dropped  Replace the CF card.
to 10% of the total size (only when the
media FIFO (see section 1.4) is disabled).

* Errorin the CF card. * Replace the CF card with a

normal one.

» Format the CF card on the
DX (the data on the CF

card will be erased).

However, the status of the internal memory Insert a CF card.

is output when the CF card is not inserted.

* 10 MB or less of available space*
remaining in internal memory.

* The number of files in internal memory for
which Auto Save to the CF card has not
been completed has exceeded 390.

When the auto save function to the CF card is Off.

* 10 MB or less of available space* Save the data in the internal
remaining in internal memory. memory to the CF card.

* The number of files in internal memory
for which Manual Save has not been
completed has exceeded 390.

Measurement error

Error in the A/D converter.
Burnout is detected.

Contact your nearest
YOKOGAWA dealer for
repairs.

Replace the thermocouple
that has burned out.

Communication error

Check the error in the Modbus
master or Modbus client
screen and carry out the
corrective action.

A Modbus master or Modbus client
communication error occurred.

Failed the FTP file transmission. Check the FTP log and carry

out the corrective action.

Memory stop

When the memory sampling is stopped.

Start the data acquisition.

*

The internal memory’s “available space” refers to the following quantities.

* Unused regions
» Regions of data for which Auto Save or Manual Save (see page 1-26) has been

completed.

Relay Operation

NO Cc NC NO C NC

During normal operation

NO Cc NC
When specified status occurs When power is turned OFF
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1.10 Other Functions

Time Related Functions

Time Correction
The DX internal clock can be changed in the following manner.

Method Description

Key operation Sets the DX internal clock to the specified time.

Event action function Synchronizes the DX internal clock to the nearest hour.

SNTP client function Sets the DX internal clock to the time retrieved from an SNTP
server.

Time Correction Operation
The time correction operation varies depending on whether the memory sampling is in

progress or not.

Status Operation

Memory sampling stopped The DX internal clock is changed immediately.

Memory sampling The DX internal clock is gradually corrected. While the time is
being gradually adjusted, the date/time in the status display section
is displayed in yellow.

Operation of Gradually Correcting the Internal Clock
If the time deviation between the time of the DX internal clock and the correct time (the

specified time) is within a specified value, the DX clock is adjusted gradually at 40 ms
for each second. Otherwise, the clock is corrected immediately. The maximum value
of time deviation (tm in the figure below) can be selected in the range of 10 s to 5 min.

Time when the remote control

Time specified using keys or signal is applied

Time on retrieved from an SNTP server Nearest (Time on the DX)

the DX J7 hour l
| v I . | v | S
| |[——— v I e — 1 i

Time deviation Time deviation

e J 1 | IS | E—

tm tm tm tm
Range in which the time is gradually Range in which the time is gradually
adjusted adjusted

Example:  When changing the time to 12 hours 55 minutes 35 seconds when the
internal clock is 12 hours 55 minutes 32 seconds
The time deviation of 3 seconds is adjusted 40 ms per second. The
internal clock will be synchronized to the specified time 75 seconds later.

Date Format

You can select the display format of the data from “2005/09/28,” “09/28/2005,”
“28/09/2005,” and “28.09.2005.”

For the setting procedure, see section 2.4.

Time Zone
Set the time difference between the location where the DX is used and GMT.
For the setting procedure, see section 2.2.

DST

If the DX is used in a region that has DST, the time is switched automatically between
DST and standard time by setting the date/time when switching from the standard
time to DST and the date/time when switching back from DST to standard time.

For the setting procedure, see section 2.1.
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1.10 Other Functions

System Display

Displays the total number of inputs on the DX, the size of the internal memory, the
communication functions, the external storage drive, the options, the remote controller
ID, the MAC address, and the firmware version number.

For the operating procedure, see section 2.5.

Language
The displayed language can be set to English, Japanese, German, French, or, Chinese.

For the setting procedure, see section 2.6.

24 VDC Power Supply for Transmitter (/TPS2 or /TPS4 Option)
Provides 24-VDC power supply to up to two (/TPS2) or four (/TPS4) two-wire system

transmitters. The measured values of the transmitter correspond to a current signal of
4 to 20 mA on the same cable. Therefore, the signal can be connected to the DX input

terminal and displayed.
DX

Current
e

Transmitter power

supply output terminal Transmitter

Input terminal
Shunt resistor: 250 Q

Easy Text Entry Option (/KB1 and /KB2 Options)

You can control the DX using the keys on the remote control terminal.

» Set the remote controller ID on the DX and the ID number on the remote control
terminal to the same value.

* You can set a value between 0 and 31 for the remote controller ID and ID number.

» By changing the ID number on the remote control terminal, you can control DXs with
different remote controller IDs from a single remote control terminal.

For the operating procedure, see section 2.10.

Infrared signal
output section

Light-receiving
section
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1.10 Other Functions

USB Interface (/USB1)

Temperature Unit

You can connect a keyboard or USB flash memory to the USB port on the front and rear

panels of the DX.

* You can use a keyboard to control the DX.

* You can save measured data and setup data to the USB flash memory and also load
from it.

Connectable devices: 109/104 keyboard and USB flash memory

For the operating procedure, see sections 2.11 and 2.12.

You can set unit when measuring temperature with the thermocouple or RTD to °C or °F.
For the setting procedure, see section 3.3.
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Chapter2 Common Operations

21 Setting the Date/Time

Set the date/time. If you are using the DX in a region that uses DST, specify the date/time
for switching between DST and standard time.

Setup Screen

e Date/Time
Press MENU (switch to the setting mode) and select Date/Time > Date & Time

1 =T
o1 o0:00:0; g M (O] )

i,
I E
[E/10/10 10:10:10 eMlling
m

ENT
Save/Load }‘
Hehu customize »
<« [ |
e DST

Press MENU (switch to the setting mode) and select Date/Time > Daylight Saving

U -} - T
h10 101010 0 IEETE(D) 0}

Davlight savinas time

Uses/Hot

Start time : Honth APR
Week 1st
Day of the week SUN
Hour of the daw 2

End time i Honth OcT
Week Last
Day of the week SUN
Hour of the daw 1

* Time set
Enter the date and time, select ENT, and press DISP/ENTER.

* Daylight savings time > Use/Not
To switch between DST and standard time, select Use.

¢ Daylight savings time > Start time
Specify the date/time to switch from standard time to DST. Set the month, the nth
week, the day of the week, and the time.

* Daylight savings time > End time
Specify the date/time to switch from DST to standard time. Set the month, the nth
week, the day of the week, and the time.
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2.2 Setting the Time Difference from GMT

Setup Screen

Set the time zone of the region in which the DX will be used. Make sure to set this value
if you are using the Internet network functions or the DST function.

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Time settings

Basic Setting Hode

Time settings

Time zane (HHHH?
Time deviation limit 38z
Date format ¥ AHAD

* Time settings > Time zone(HHMM)

Set the time zone of the region in which the DX will be used in terms of the time
difference from GMT. Specify a value in the range of —1300 to 1300 (where the first
two digits denote the hour and the last two digits denote the minute). A negative value
indicates that the local time is behind the GMT.

Example: The standard time in Japan is ahead of the GMT by 9 hours. In this case,
enter “900.”
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2.3 Setting the Time Correction Operation during
Memory Sampling
This function gradually corrects the time when the time is changed while Memory
Sampling is in progress.
For a description of the time correction operation, see section 1.10.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Time settings

Basic Setting Hode

Time settings

Time zone (HHHH L]
Tine deviation linit [DECCEEN
Date format ¥ AHAD

| off | i@ | 2@s | 36s |

* Time settings > Time deviation limit

Current time ﬁSpecified time
| YV |

| |
| N

| Time deviation limit |

When the time deviation between the time on the DX and the specified time is within
*(the value specified here), the time on the DX is gradually corrected. Otherwise, the
clock is corrected immediately.

Settings Description

10 s to 5 min The time deviation limit.

Off Disables the function that gradually corrects the time.

Example: If Time deviation limit is set to 10s and the time on the DX is 10 hours 21
minutes 15 seconds, the time on the DX is gradually corrected if the specified time is
between 10 hours 21 minutes 5 seconds and 10 hours 21 minutes 25 seconds.
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2.4 Setting the Date Format

Select the display format of the date.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Time settings

Basic Setting Hode

Time settings

Time zone (HHHH L]
Time deviation limit 38z

Date format

* Time settings > Date format

Settings Display Example
Dates other than the grid time of Time at the grid position in the
the trend display trend display (example: 8 O’clock
on Nov. 30)*
Y/M/D 2005/11/30 11/30 08
M/D/Y 11/30/2005 11/30 08
D/M/Y 30/11/2005 30/11 08
D.M.Y 30.11.2005 30.11 08

*

Only if the trend interval is set greater than or equal to 1 h/div. A function available on DXs
with release number 2 or later.

Applied Range

The format is applied to the date displayed on the screen. It does not change the

date format on the setup screen of the date/time, the date in the output data via
communications, the date saved along with the data, and the date used in the data file
names.
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2.5

Procedure

Explanation

Viewing the DX Information

Show the DX information on the system information screen and the network information

screen.

* Displaying System Information Screen

1. In the operation mode, press FUNC.

The FUNC key menu appears.
2. Press the System info soft key.

The system information screen is displayed.

Displaying Network Information Screen

1. In the operation mode, press FUNC.

The FUNC key menu appears.
2. Press the Network info soft key.

The network information screen is displayed.

System Information Screen

o0}

IANALOG
Number of measurement channels

ANALOG:

USE

(C) denotes the clamped input
terminals (/H2 option)
MATH

RS-232 cli1e .
ALARH 4 SPECIAL INPUT] Number of computation channels
FAIL/STATUS CAL CORRECT ;
EEHOTE (/M1 and /PM1 options)
oF
REMOTE CONTROLLER ID ¢ ] =y — MEMORY )
FRODUCT: Internal memory size
MAG address BA:@B:E4:88:24:E1 OPTIONSs
Wersion 1.81
Remote controller ID

Network Information Screen
The following values set on the DX are displayed.

|P address, MAC address, DNS server,

G 1100:01 o= BEET (D)6
IF address ¢o18, @8.233. ™

Subnet mask 255,255,254, @
Default gateway : 18, 8,232, 1

T oBE:Be:Ed: B8 2d:B1

HAG address
DNS zerver
Primary @, @8, @ @
Secondary A, @, 8. @
Host name

HHHHHHHK

Domain name

o et

(/KB1 and /KB2 options)
MAC address
Version

Firmware version

host name, and domain name

IM 04L41B01-01E
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2.6 Changing the Displayed Language

Set the displayed language.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

Basic Setting Hode Cink

Operating environment

Tag/Channel Tag
Lanauage

Remote Controller ID 0ff
Temperature G

izh Japanese

* Operating environment > Language

basic setting mode), and select Environment > Operating Environment

Set the displayed language to English, Japanese, German, French, or Chinese.
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2.7 Setting the LCD Brightness and Backlight
Saver

Change the LCD brightness. In addition, set the backlight saver function to prolong the
service life of the LCD backlight.

Setup Screen

Press MENU (switch to the setting mode) and select Display > LCD
1510 10:10:10 R IEZT(O) 0}

LCD

Brightness “

Backlight saver

Hode Dimmer

Saver time 1h

Restore KewtAlm
4l 2 [ 3 | 4 |

e LCD > Brightness
Select a value from 1 to 8 (2 by default). Larger the value, brighter the display
becomes.

¢ LCD > Backlight saver > Mode

Settings Description

Off Disables the backlight saver.

Dimmer Dims the display if there is no operation for a given time.
Timeoff Turns the backlight OFF if there is no operation for a given time.

* LCD > Backlight saver > Saver time
Select a value from 1 min to 1 h. If the specified time elapses without any key
operation or alarm occurrence, the LCD backlight switches to the specified mode.

e LCD > Backlight saver > Restore

Settings Description
Key The backlight returns to the original brightness when a key is pressed.
Key+Alm The backlight returns to the original brightness when a key is pressed or when an

alarm occurs.

Nofte
« If the backlight is dimmed or turned OFF by the backlight saver function, pressing any key

on the DX causes the backlight to return to the original brightness. In this operation, the key

does not perform its intended function.

* The degradation of the brightness and the discoloration of the screen (become yellowish)
tend to progress faster as the brightness is set higher. Extended use at an unnecessary high
setting should be avoided. It is also recommended that you use the backlight saver function.
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2.8 Initializing Settings and Clearing the Internal
Memory

Initialize the settings to default values. In addition, clear the data in the internal memory.
For the default settings, see the DX7000/DX1000N Operation Guide (IM04L41B01-02E).

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Load setting, Initialize > Initialize

Basic Setting Hode
Initialize
Kind

Initialize contents
Glearl : Basic settinas + Settinas
+ MeasurekMath data
Clear2 : Settings + HeasurekHath data
GCleard ¢ Heasurekbath data

¢ |nitialize > Kind

Settings Description

Clear 1 Initializes the settings of the basic setting mode and setting mode and clears the
data in the internal memory.

Clear 2 Initializes the settings of the setting mode and clears the data in the internal
memory.

Clear 3 Clears the data in the internal memory.

e Data in the Internal Memory That Is Cleared
Display data, event data, manual sampled data, report data (/M1 and /PM1
options), and log information.

Procedure

1. Press the Clear 1, Clear 2, or Clear 3 soft key.

Press DISP/ENTER.
A confirmation window opens.

3. Select Yes and press DISP/ENTER.
The specified operation is executed, and the DX returns to the operation mode.
If you do not want to initialize, select No and press DISP/ENTER.
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2.9 Outputting the DX Status via the Relay Contact
(/F1 Option)

A signal is output to a dedicated relay when an error occurs in the DX CPU. In addition, a
signal is output to a different relay when the a specified status occurs.
For a description of the FAIL/status output function, see section 1.7.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Status relay

Basic Setting Hode

Status relav

Hemorw/Hedia status “

Heasurement error 0ff
Communication error 0ff
Hemory stop Ooff

[ on | 0ff |

¢ Memory/Media status
On: Outputs the internal memory and CF card statuses to the relay.

* Measurement error
On: Outputs a relay signal when a measurement error occurs.

e Communication error
On: Outputs a relay signal when a communication error occurs.

* Memory stop
On: Outputs to the relay when the memory sampling is stopped.

Procedure

¢ FAIL Output
There are no settings or operations that are required. A signal is output to the relay

contact when a CPU error is detected. A signal is also output to the relay contact when
the DX is turned OFF.

¢ Status Relay
A signal is output to the relay contact when a specified status occurs.
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2.10 Contro

lling the DX with the Remote Control

Terminal (/KB1 and /KB2 Options)

Handling Precaution

Preparing the DX
Se

S
If the infrared signal output section of the remote control terminal or the light-receiving

section on the DX becomes dirty or receives scratches, it can hinder the transmission/

reception of the infrared signal. Clean the infrared signal output section of the remote

control terminal or the light-receiving section on the DX.

When cleaning, wipe using a dry soft cloth. Do not use chemicals such as benzene or

thinner, since these may cause discoloring and deformation.

Do not apply shock to the remote control terminal.

Do not operate the remote control terminal with wet hands.

The transmission/reception sensitivity of the infrared signal may deteriorate if used in

the following types of locations.

» Location where the receiver of the DX is exposed to direct sunlight or fluorescent
lamp.

* Near magnetic field sources such as a transceiver.

If you carry the remote control unit in your pocket, for example, keys may be pressed

unintentionally and cause the DX to be controlled. Handle the remote control terminal

properly so that keys are not pressed inadvertently.

When you are near the DX, press the keys on the remote control terminal only when

controlling the DX. If you are going to press the keys on the remote control terminal

but do not wish to control the DX, take measures so that the signal does not reach

the DX such as by covering the infrared signal output section of the remote control

terminal.

The distance at which the DX can be controlled using the remote control terminal

varies depending on the operating environment such as the battery voltage and the

presence or absence of external light.

There is a possibility that DXs with the same remote controller ID be controlled

simultaneously. It is recommended that different remote controller IDs be set on each

DX.

t the remote controller ID.

Setup Screen
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > Operating Environment

Basic Setting Hode

Operating environment

Taa/Channel Tag
Lanauage f_EEETTE?T_
Remote Contraller ID 0ff
Temperature [
T O O

Operating environment > Remote Controller ID
Select the remote controller ID from 0 to 31. When not using the remote control

terminal, select Off.

Checking the Remote Controller ID
You can check the DX remote controller ID on the system information screen.

See section 2.5.

210
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2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Preparing the Remote Control Terminal
Names of Parts

Battery cover

Infrared signal
output section

Loading Batteries

1. While pressing the projection
on the battery cover, open
the cover.

2. Load the batteries.
3. Close the battery cover.

Setting the ID Number
Set the ID number of the remote control terminal to match the remote controller ID of

the DX that you are to operate.

The ID number of the remote control terminal is not displayed anywhere. If you are
not sure which ID number the remote control terminal is set to, set the appropriate 1D
number according to the following procedure.

1. Press ID.

2. Enter the ID number (0 to 31) by pressing the keys
from 1 (A1) to 0 (NO).
Example For ID number “16”
Operation: Press 1 (A1) and 6 (G6).
3. Press ID.

Nofte

« If you enter an ID number other than 0 through 31, the ID number retains the original setting.

* Pressing the ID key once causes the remote control terminal to enter the ID number setup
mode. If none of the keys on the remote control terminal is pressed for 8 s, the remote
control terminal automatically exits from the ID number setup mode. In this case, the ID
number of the remote control terminal retains the original setting.

« If you remove the batteries, the ID number is reset to 0. After loading the batteries, set the
appropriate ID number again.

Affixing the ID Number Label

If you are using the remote control terminal with a fixed ID number (such as when
there is a one-to-one correspondence between the DX to be controlled and the remote
control terminal), you can enter the ID number on the label and affix the label on the
remote control terminal.

Affix the ID number label on the battery cover
of the remote control terminal.

IM 04L41B01-01E
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2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Controlling the DX

Control the DX by pointing the infrared output section of the remote control terminal to
the light-receiving section on the DX. Control the DX while checking the results on the
DX screen.

Nofte

« The remote control terminal cannot be used to control the Favorite key.

*  When a specific key operation is possible on the DX, the corresponding key on the remote
control terminal is activated. For example, the operation for entering a character string is
activated when a window for entering a character string is displayed on the DX screen.

* You cannot control the DX using the remote control terminal, if the remote control terminal is
in the ID number setup mode.

»  On models with the /M1 math option or /PM1 pulse input option, use the keys on the DX
to enter the computing equation of the computation channel. Computing elements are not
assigned to the keys on the remote control terminal.

¢ Correspondence with the DX Keys

— Character input
keys

| Up arrow key

LI |- User key
| DISPIENTER key | F1/F5 F2/F6 F3/F7 F4 Hold down SHIFT
and press F3/F7.

ESC key —

— Right arrow key

— Down arrow key
I~ MENU key

Left arrow key —

FUNC key —

Character input

keys
T

@I- — Soft keys

Character type switch key for character input keys (see the next page)
START key — STOP key

YOKOGAWA 4

REMOTE COJTROL TERMINAL 438227

Delete key
& Deletes the character at the cursor position when inputting characters.

Space key
Enters a space at the cursor position when inputting characters.
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2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

¢ Entering Strings
When a character input window is displayed on the DX screen, pressing the A/a/1
key switches the character type assigned to the character input keys as shown in the
following figure.

g 3

¢ Uppercase Alphabet Characters and Symbols/Lowercase Alphabet
Characters and Symbols

Uppercase alphabet
characters and symbols

characters and symbol

Lowercase alphabet J_" Numbers ’_I

Alphabet (Ato Z or a to z)

Each time the MARK key is pressed, the displayed symbol switches
in the following order.
The display switches in a cyclic pattern.

i ) ' Number of ti
222¢ p umperottimes Lot o 13 45 6 7 8 9 10
the key is pressed

Symbol % | # o @ _| (/) + *|1I

¢ Numbers

Number (1 to 9 and 0)

Decimal point

However, when setting a constant to be used in the computation
on the DX with the /M1 or /PM1 option, the display switches

in the order “.”, “+”, and “E” each time the key is pressed.

The display switches in a cyclic pattern.

Minus sign

IM 04L41B01-01E
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2.10 Controlling the DX with the Remote Control Terminal (/KB1 and /KB2 Options)

Troubleshooting

The DX does not react when you try to control it using the remote control terminal.

Are the correct batteries loaded in the remote control terminal?

Check the voltage and polarity of the batteries.

Are the batteries flat?

Replace the batteries with new ones.

Does the ID number of the remote control terminal match the remote controller
ID of the DX that you are trying to control?

Check the remote controller ID on the DX, and set the ID number of the remote control
terminal to the same value.

Is the remote control terminal in ID number setup mode (condition in which the
ID key is pressed once)?

Wait 8 seconds without pressing any keys to exit from ID number setup mode.

Is the remote control terminal too far away from the DX?

Get closer to the DX. Control from as close to the front of the DX as possible.

Is a strong light hitting the light-receiving section of the DX?

Take measures to prevent strong light from hitting the light-receiving section of the DX.
Is there a magnetic field source such as a transceiver nearby?

Move the magnetic field source away from the DX.

Is the infrared output section of the remote control terminal or the light-
receiving section on the DX dirty?

Clean them.

Is the DX in a condition that allows the relevant key operation?

Check the condition of the DX, and start from an operation that is possible.

214
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2.11 Controlling the DX with a Keyboard (/USB1
Option)

Connecting/Removing a Keyboard
¢ Connecting a Keyboard
Connect the keyboard connector to the USB port on the DX.

The message “USB device has been connected” appears on the screen, and the
keyboard is ready for use.

usB port

+®
&
suonesadp uowwon ﬂ

-\

* Removing the Keyboard
Remove the keyboard connector from the USB port on the DX.

Nofte
* You can connect or remove the keyboard regardless of the DX status (power ON/OFF or
displayed screen).
¢ One keyboard can be connected.
« Use a keyboard appropriate for the language setting on the DX.
« The state of the CapsLock and NumLock keys is retained even if you disconnect the USB
keyboard. A function available on DXs with release number 2 or later.
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2.11 Controlling the DX with a Keyboard (/USB1 Option)

Operating from the Keyboard

Use the keyboard while watching the DX screen. An operation that can be carried out on

the DX can be carried out from the keyboard.
Example: Switch to setting mode

When the DX is in the operation mode, press Ctrl+M.
The DX switches to setting mode, and the setting menu appears.

¢ Mapping of the Keys on the DX to the Keys on the Keyboard

Keys on the Keyboard

104 Keyboard (US)for the PC Keys on the DX
Enter DISP/ENTER
— Left arrow key
1 Up arrow key
l Down arrow key
— Right arrow key
Num Enter DISP/ENTER
Esc ESC
F1to 5 Soft key 1 to soft key 5
F9 FUNC
F12 Hold down FUNC for 3 seconds
Left-Windows MENU
Right-Windows MENU
Application Favorite key
Ctri+S START
Ctri+P STOP
Ctrli+U USER
Ctrl+M MENU
Ctri+F Favorite key
Tab, Shift+Tab Arrow keys*

* Press Tab to move the cursor to the next item, or Shift+Tab to move to the previous item.
However, this does not work in the following screens:
Operation screens, Menu screens for Setting mode and Basic setting mode, screens for
entering values and characters, “Menu customize” and “Save/Load” screens in Setting mode,
and “Load setting, Initialize” screen in Basic setting mode

¢ Entering Alphabets, Numbers, and Symbols
When alphabets, numbers, and symbols can be entered on the DX, you can enter

them from the keyboard. The operation is the same as with normal keys. However,
symbols that cannot be used on the DX are invalid.

Symbols That Can Be Entered Using the Keyboard
The symbols below can be entered. However, symbols that cannot be used on the
DX are invalid. For example, the characters &, *, /, :, and ? cannot be used in the data

save destination directory name.

*

[+ s| (D

3
S

Aol e fe o]y

*  Press “N” on the keyboard to enter the temperature degree symbol.

* Invalid Keys
Keys enclosed in frames are invalid.
The 104 Keyboard for a PC (US)

216
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2.12 Using the USB Flash Memory (/USB1 Option)

Connecting/Removing a USB Flash Memory
e Connecting a USB Flash Memory

1. Connect a USB flash memory to the USB port on the DX.

2. In operation mode, possible operations are shown. Select the desired operation
using the arrow keys and press DISP/ENTER.

When set to auto save When set to manual save
/B 16:31:42 E'I'}' @ /B 16:31:42 E'I'}' @
| " U [ " U |

et | Lninddiv et | Lninddiv

Save data Load Settings Sa Save data
Cancel [ Load Settings [ Cancel
3 {/H 3 {H/H 3 {H/H HH HH HH
BTHH BTHH BTHH BTHH BTHH BTHH

Setting Description
Save Manual Saves unsaved data in the internal memory to the USB flash memory.
Save data Moves to the memory summary display. For the procedure to save the

internal memory data, see section 4.8.

Save data is displayed only when a flash memory is connected to the USB

port and is usable* in the operation mode (Release Number 2 or Later).

* If DX is configured so that any of the items below is shown in the display
selection menu, Save data can be executed. You can change the items
shown in the display selection menu using the MENU CUSTOMIZE
function.

SELECT SAVE, M.SAMPLE SAVE, REPORT SAVE, or ALL SAVE
Load Settings Moves to the setup load display of the setting mode. For the procedure to
load the setup data, see section 6.9.
Cancel Closes the operation selection window.

¢ Removing the USB Flash Memory

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Media eject soft key and then the USB soft key.
A message “Media can be removed safely.” appears.

3. Remove the USB flash memory.

Note

* One USB flash memory can be connected.
» Be sure to carry out the procedure above when removing the USB flash memory.

Saving and Loading Data
The following data save/load and file operations can be carried out.
Save/Load setup data files (see section 6.9).
Save display data and event data files (see sections 4.8 and 6.4).
Load display data and event data files (see section 6.8).
List files and delete files (see section 6.7).
Format (see section 6.7).
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Chapter 3 Measurement Channels and Alarms

3.1 Setting the Scan Interval and the Integration
Time of the A/D Converter

Select the scan interval and the integration time of the A/D converter.
For a description of the scan interval and the integration time of the A/D converter, see
section 1.1.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select A/D, Memory

Basic Setting Hode

Scan interval

Sean mode | tornal |
Scan interval 125ms
A/D intearate Auto
Hemory
Data kind Dizsplay

[ Normal | FAST |

¢ Scan interval > Scan mode
Normal: Measures at the normal mode scan interval.

FAST: Measures at a scan interval of 25 ms (DX1002, DX1004, DX1002N, and
DX1004N) or 125 ms (DX1006, DX1012, DX1006N, and DX1012N).

e Scan interval > Scan interval
The selectable settings appear.

¢ Scan interval > A/D integrate
When the scan mode is set to Normal, select the A/D integration time as necessary.

Only the selectable settings are displayed.

Settings Description

Auto The DX automatically detects the power supply frequency and sets the integration
time to 16.7 ms and 20 ms for 60 Hz and 50 Hz, respectively. Fixed to 20 ms on
/P1 models that use the 24 VDC power supply.

50Hz Sets the integration time to 20 ms.

60Hz Sets the integration time to 16.7 ms.

100ms Sets the integration time to 100 ms (when the scan interval is 2 s or 5 s).
600Hz The A/D integration time for fast sampling mode. You cannot change this value.

IM 04L41B01-01E 31
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3.2 Setting the Burnout Detection and the
Reference Junction Compensation of the
Thermocouple Input

Set the function that detects burnouts in the sensor for thermocouple input and 1-5V
input and the reference junction compensation method of the thermocouple.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

First-CcH:

Burnout szet

RIC

Basic Setting Hode C
Last-CH: [1

basic setting mode), and select Burnout, RJC

0Ff

Hode External
Volt A ul
4l 2 [ 3 | 4 |

¢ First-CH, Last-CH
Select the target channels.

¢ Burnout set

Thermocouple Input

Settings Description

Off Does not detect burnouts in the sensor.

Up When the sensor burns out, the measured result is set to +over range. The
measured value displays “Burnout.”
For 1-5V input, the DX assumes that the sensor has burned out when the
measured value exceeds the scale upper limit by 10% of the scale width.
(Example: When the measured value is greater than 110 when the scale is from
0 to 100)

Down When the sensor burns out, the measured result is set to —over range. The
measured value displays “Burnout.”
For 1-5V input, the DX assumes that the sensor has burned out when the
measured value falls below the scale upper limit by 5% of the scale width.
(Example: When the measured value is less than —5 when the scale is from 0 to
100)

* RJC > Mode

Sets the reference junction compensation method of the thermocouple input. Select
Internal or External.

Settings Description
Internal Uses the reference junction compensation function of the DX.
External Uses an external reference junction compensation function. When set to
External, Volt is displayed.
* RJC > Volt

The compensation voltage to be added to the input. Set the value in the range of —
20000 pV to 20000 pV.

3-2
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3.3 Setting the Input Range

Set the input range for each channel.

Setup Screen

* Temperature Unit
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > Operating Environment

Basic Setting Hode

Operating environment

Tag/Channel Tag
Lanauage Enalish
Remote Controller ID 0ff
Temperature

¢ | F |

¢ Input Range for Each Channel

Press MENU (switch to the setting mode) and select Meas channel > Range, Alarm
1610 10:10:10 R0 IEEEN(O) 0}

First-CH: Last-CH: [1

Range

Hode Range Span_L Span_ll
[Wo1t [ 2y [-2.eeee [ 2.eee8
Alarm

1 [off

2 [off

3 [off

4 [off

1 1 2 [ 3 | 4 |

* Temperature
Select the temperature unit. The setting is applied to all temperature measurement

swue|y pue sjauuey) juswainsesyy

channels.

Settings Description

C Use Celsius

F Use Fahrenheit
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3.3 Setting the Input Range

¢ First-CH, Last-CH
Select the target channels.

* Range > Mode

Settings Description

Skip Not measured.

Volt, TC, RTD, DI, 1-5V  Input type. Represents DC voltage, thermocouple, RTD, ON/OFF
input, and 1-5V inputs, respectively.

Delta, Scale, Sqrt Difference computation, linear scaling, and square root computation.

Set the items with check marks in the table below according to the mode value.

Mode
Setup ltem Volt | TC | RTD | DI |Delta | Scale | Sqrt | 1-5V | _ Skip
Type v v
Range v v v v v
Span Lower v v v v v v v v
Span Upper v v v v v v v v
Scale Lower v v v
Scale Upper v v v
Unit v v v
Ref. CH v
Low-cut v v
Low-cut value v

* Range > Type
Input type when Mode is Delta or Scale. See the description on Mode above.

* Range > Range
Input type details.

Setting Input Type Notes Setting Input Type Notes
20mV —20.000 mV to 20.000 mVDC |Standard R Type R Standard
60mV —60.00 mV to 60.00 mVDC S Type S

200mV —200.00 mV to 200.00 mVDC B Type B

2V —2.000 V to 2.000 VDC K Type K

6V —6.000 V to 6.000 VDC E Type E

20V —20.000 V to 20.000 VDC J Type J

20V —50.00 V to 60.00 VDC T Type T

Pt Pt100 N Type N

JPt JPt100 w Type W

Level ON/OFF(Voltage) L Type L

Contact | ON/OFF(Contact | U Type U

1-5V 0.800V to 5.200V WRe type WRe

Setting Input Type Notes Setting Input Type Notes
Kp Kp vs Au7Fe /N3 Cut Cu10 (GE) /N1
PLATI PLATINEL option Cu2 Cu10 (L&N) option
PR PR40-20 Cu3 Cu10 (WEED)

NiMo NiNiMo Cu4 Cu10 (BAILEY)

W/WRe | W/WRe26 Cu5 Cu10: a = 0.00392 at 20°C

N2 Type N (AWG14) Cub Cu10: a = 0.00393 at 20°C

Pt50 Pt50 Cu25 Cu25: a = 0.00425 at 0°C

Ni1 Ni100 (SAMA)

Ni2 Ni100 (DIN)

Ni3 Ni120

J263 J263*B

Cu53 Cu53

Cu100 Cu100: a = 0.00425 at 0°C

Pt25 P25

* Range > Span_L, Span_U
Input range. The selectable range is displayed on the screen.

Nofte

* You cannot set the same value to Span Lower and Span Upper.
*  When the Mode is 1-5V or Sqrt, Span Lower must be less than Span Upper.
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3.3 Setting the Input Range

Range > Scale_L, Scale_U

Input range after converting the unit.

The selectable range is from —30000 to 30000. The decimal place is determined by
the Scale Lower setting. It can be set to the following positions: “X. XXXX,” “XX.XXX,”
XXXXX,” XXXXX,” or “XXXXX.”

Nofte

* The DX converts the measured value to a value obtained by removing the decimal point

from the value span specified by Scale Lower and Scale Upper. For example, if the scale
setting is “—5 to 5,” the value is converted to a value within the span of “10”; if the scale
setting is “~5.0 to 5.0,” the value is converted to a value within a span of “100.” In this case,
the resolution of the value converted to a span of “10” is lower than the value converted to a
span of “100.” To prevent the display from becoming rough, it is recommended that the scale
be set so that this value is greater than 100.

* You cannot set the same value to Scale Lower and Scale Upper.

*  When the Mode is 1-5V or Sqrt, Scale Lower must be less than Scale Upper.

Range > Unit
Sets the unit (up to 6 characters, [Alaf#[1)).

Range > Ref. CH
The reference channel for difference computation.

Range > Low-cut
Select On to use the low-cut function.
* The low-cut value for 1 to 5 V input is fixed to 0% value of the input span.

Range > Value
On a square root computation channel, set the low-cut value in the range of 0.0% to
5.0% of the input span.

Measured value

Result of square root computation

Low-cut value

7] Input value

IM 04L41B01-01E
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3.4 Setting the Moving Average of the Input

Set the moving average function of the measurement channel. This function suppresses
the effects of noise.
For a description of the function, see section 1.1.

Setup Screen

Press MENU (switch to the setting mode) and select Meas channel > Moving
average

P 1 [==T
b0 1.10:10 0= IEEEYE (O] 0}
First-CH: Last-CH: 1

Howing average

On/fOff (n
Count 2
4l 2 [ 3 | 4 |

—>-|—|<—Scan Interval

A\V4 AV AV A\V4 AV AV AV
— Average value
Average value
\______v______J

Count

¢ First-CH, Last-CH
Select the target channels.

* Moving average > On/Off
To use moving average, select On.

¢ Moving average > Count
Set the number of data points of the moving average in the range of 2 to 400.
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3.5 Setting the Auxiliary Alarm Function

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the basic
setting mode), and select Alarm > Basic settings; Switch, Relay; or Hysteresis.

* Basic settings » Switch, Relay
Basic Setting Mode Basic Setting Hode
Basic setting Internal Switch
Reflash o
Rate of chanae Relaw
Decrease 1 AND Hone
Increase 1 Action Eneraize
Indicator Honhold Hold Honhold
Relaw Action on ACK Hormal
L 00 | off | 58

» Hystersis

Husteresis

Heas CH
High/Low 8.5 ¥
Delta High/Low 8.4 ¥
Hath CH
High/Low 8.4 ¥

Basic settings > Reflash
To set the reflash operation on the alarm output relay, select On. The reflash function

is set on the first three output relays.

Basic settings > Rate of change

e Decrease
Set the interval for the rate-of-change calculation of the low limit on rate-of-change
alarm in terms of the number of sampled data points (1 to 32). The actual interval is
obtained by multiplying the value specified here by the scan interval.

* Increase
Set the interval for the rate-of-change calculation of the high limit on rate-of-change
alarm in the same manner as the interval for the low limit on rate-of-change alarm.

Basic settings > Indicator
Select the alarm indication behavior from the following:

Settings Description

Nonhold Clears the alarm indication when the alarm condition is released (returns to
normal condition).

Hold Holds the alarm indication until an alarm acknowledge operation is performed.

IM 04L41B01-01E
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3.5 Setting the Auxiliary Alarm Function

¢ Switch, Relay

Nofte
When reflash is turned ON, the operation of the first three output relays is fixed to OR logic.
Specifying AND produces no effect.

Internal Switch > AND

Select the internal switches that are to operate using AND logic. Set the range

of internal switches (from the first internal switch) to take the AND logic. All
subsequent switches will be set to OR logic.

Relay > AND

Select the relays that are to operate using AND logic. Set the range of relays (from
the first alarm relay) to take the AND logic. All subsequent relays will be set to OR
logic. Available settings are None, 101 (101 only), 101-102 (I01 and 102), 101-103 (101
to 103), etc. Only alarm output relays that are installed are valid.

Relay > Action
Select whether the alarm output relay is energized or de-energized when an alarm
occurs. The setting applies to all alarm output relays.

* Relay > Hold
Select the alarm output relay behavior from below: The setting applies to all relays.
Settings Description
Nonhold Turns the output relay OFF when the alarm condition is released (returns to
normal condition).
Hold Holds the output relay at ON until an alarm acknowledge operation is performed.
Nofte

When reflash is turned ON, the operation of the first three output relays is set to nonhold.
Specifying Hold produces no effect.

Relay > Relay Action on Ack
You can select the relay output status that is enabled after the alarm ACK operation
from the following two settings.

Settings Description

Normal The relay output is deactivated when the alarm ACK operation is executed. If the

condition for activating the alarm output relay is met in the next scan interval, the
relay output is activated.
This operation is valid only when the alarm output relay is set to Hold.

Reset The relay output is deactivated when the alarm ACK operation is executed. If a

new condition for activating the alarm output relay is met, the relay is activated.

An example of the relay action when alarm ACK is executed is shown below. This
example is for the case when the output relay AND item is set to OR.

Normal
Alarm Alarm ACK
occurrence ¥
Alarm 1 Alarm
occurrence
Alarm 2

Activated
Alarm output relay
Deactivated

(Relay is activated in the next scan intewal)

3-8
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3.5 Setting the Auxiliary Alarm Function

Reset
Alarm Alarm ACK
occurrence ¥
Alarm 1 Alarm
occurrence
Alarm 2

Activated

Alarm output relay
Deactivated

(Relay is activated on the next alarm occurrence )

* Hysteresis > Meas CH

e High/Low
Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm
specified on measurement channels.
Selectable range: 0.0% to 5.0% of the span or scaling width

¢ Delta High/Low
Sets the hysteresis width of the alarm occurrence/release of the difference high/low
limit alarm specified on measurement channels.
Selectable range: 0.0% to 5.0% of the span

¢ Hysteresis > Math CH (/M1 and /PM1 options)
Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm

specified on computation channels.
Selectable range: 0.0% to 5.0% of the measurement span

IM 04L41B01-01E
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3.6 Hiding the Alarm Indication

Select whether to enable the alarm hide function.

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > Input, Alarm
Basic Setting Mode CLink

Input
VYalue on owver-range Over

Alarm

No logaing [__on |

[ on | 0ff |

e Alarm > No logging
To enable the function that turns off the alarm indicator and logging, select On. The
Detect setup item is displayed in the alarm setting screen (see section 3.7).

This function disables the alarm indicator and the logging of the alarm event to the
alarm summary even when an alarm occurs.

¢ Settings for Each Channel and Each Alarm
See section 3.7.
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3.7 Setting Alarms on Channels

Set the alarms after setting the range. All alarm settings of a channel are cancelled in the

following cases.

* When the input type (Volt, TC, etc.) is changed.

* When the input range is changed.

»  When the upper or lower limit of the span or scale is changed on channels that are set
to linear scale, square root computation, or 1-5 V (including changes in the decimal
point position).

Setup Screen

e Alarms for Each Channel
Press MENU (switch to the setting mode) and select Meas channel > Range, Alarm

[ =
b0 1.10:10 0= IEEEYE (O] 0}
Firzt-CH: 1 Last-CH: 1

Range
Hode Range Span_L Span_ll
[Wo1t [ 2y [-2.eeee [ 2.eee8

Alarm Twpe Walue Relay Mo,

1 [ [ o.oe08 | on |18l

2 [of
3 [of
4 [of
[ on | 0ff |

oo
—+ |+

=
-

e Alarm Delay Time
Press MENU (switch to the setting mode) and select Meas channel > Tag, Memory,

Delay
0P 1 r="—
b0 1.10:10 0= IEEEYE (O] 0}

First-CH: [T Last-CH: [1

Tag

Characters

Hemory sample

On/fOff On
Alarm delay

Time II!ES

¢ First-CH, Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

e Alarm>1, 2, 3,and 4
For each alarm, 1 to 4, select On to enable it.
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3.7 Setting Alarms on Channels

e Alarm > Type
Select the alarm type.

Settings Name Description

H  High limit alarm -

L Low limit alarm -

h  Difference high limit alarm Can be specified on channels set to difference computation.
| Difference low limit alarm Can be specified on channels set to difference computation.
R High limit on rate-of-change alarm —

r Low limit on rate-of-change alarm  —

T  Delay high limit alarm -

t Delay low limit alarm -

Alarms on channels set to difference computation are inserted at the following
positions.
I-II!L!T!t Rl,r,h,l

Input value O Measured value ’

T
Measured value on the reference channel

e Alarm > Value
Set the alarm value for the selected alarm type.

When the Mode of the Channel Is Set to Volt, TC, RTD, or DI
Type Value Example of a Range of Alarm Values
H,L Value in the measurable range —2.0000 to 2.0000 V for 2 V range

R, r 1 digit to the upper limit of the width 0.0001 to 3.0000 V for 2 V range
of the measurable range
However, less than or equal to 30000 0.1 to 1760.0°C for thermocouple type R
excluding the decimal point.

T,t SameasHandL. Same as H and L.

When the Mode of the Channel Is Set to Delta

Type Value Example of a Range of Alarm Values
H,L Value in the measurable range —2.0000 to 2.0000 V for 2 V range
h, 1 Value in the measurable range —1760.0 to 1760.0°C for thermocouple type R
R, r 1 digit to the width of the measurable  0.0001 to 3.0000 V for 2 V range
range

However, less than or equal to 30000 0.1 to 1760.0°C for thermocouple type R
excluding the decimal point.

Tt Same as Hand L. Same as Hand L.

When the Mode of the Channel Is Set to Scale, Sqrt, or 1-5V

Type Value Example of a Range of Alarm Values

H,L —5% to 105% of the scale width. —5.0 to 105.0 when the scale is 0.0 to 100.0
However, within —30000 to 30000 —120.00 to 300.00 when the scale is —100.00
excluding the decimal point. to 300.00

R, r  Within 1 to 30000 excluding the 0.1 to 3000.0 when the scale is 0.0 to 100.0
decimal point. 0.01 to 300.00 when the scale is —100.00 to

300.00
Tt Same as Hand L. Same as H and L.

¢ Alarm > Relay
Select whether to turn On or Off the relay output.

e Alarm > No.
Set the output relay number or internal switch number when performing relay output.
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3.7 Setting Alarms on Channels

Alarm > Detect

This item appears when the alarm hide function (see section 3.6) is turned On. Select
whether to show or hide the alarm indication when an alarm occurs. If set to Off, a
signal is output to the alarm output relay or internal switch when an alarm occurs, but
it is not indicated on the screen. The alarm is also not recorded in the alarm summary.

Alarm delay > Time (for delay high/low limit alarms)
Set the alarm delay time using an integer in the range of 1 to 3600 s.

Nofte
» The alarm delay time takes on a value that is an integer multiple of the scan interval. For
example, if the alarm delay time is set to 5 s when the scan interval is 2 s, the actual delay
timeis 6 s.
» The delay alarm has the following special operations.
+ If the computation is stopped in a condition in which the computed value is exceeding the
alarm setting when a delay alarm is set on a computation channel, the alarm is turned
On after the specified period (delay period) elapses.
* The alarm detection operation is reset if a power failure occurs. The operation restarts
after the power recovers.
+ If the alarm setting of the delay high limit alarm is changed when an alarm is already
activated and the input is greater than or equal to the new setting, the alarm continues.
For all other cases, the alarm detection operation starts at the new setting. This is also
true for the delay lower limit alarm.

IM 04L41B01-01E
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3.8 Releasing the Alarm Output (Alarm ACK
Operation)

This operation is valid when the DX is set as follows:

DX with release number 2 or later

* When Indicator is set to Hold in the basic setting mode.

* When Relay Hold is set to Hold and Relay action on ACK is set to Normal in the
basic setting mode.

* When Relay action on ACK is set to Reset in the basic setting mode.

DX before release number 2

* When Indicator is set to Hold in the basic setting mode.

* When Relay Hold is set to Hold in the basic setting mode.

For the procedure to set the relay action, see section 3.5.

This operation is carried out after an alarm occurs.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the AlarmACK soft key.
The alarm output is released.

Procedure

Explanation

¢ Alarm Acknowledge (ACK) Operation
When an alarm acknowledge operation is carried out, the indications and outputs
(relays and switches) of all activated alarms are cleared.
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3.9 Performing Calibration Correction (/CC1
Option)

The input value is corrected using segments, and the result is used as a measured value.

Setup Screen

For a description of the function, see section 1.1.

Press MENU (switch to the setting mode) and select Meas channel > Calibration

correction
/10 101010 00 IEET(S)

ret-CH:

[T Last-CH:

Humber of set points

1

ol))

ES wval True wal
1 [, enen [0, 0e00
2 |[o.5een[6.5100
3 [1.oeen 1. 0200
4 [1.5mea|1.5508
5 |z.moen|1.9900
L off | 2 | 3 | 4 |
Y5 Condition
va X1<X2<X3<X4<X5
\
MES val
Y3 Calibration set points
Y2 ~1 -
| L —] | Number of set points
Y1
X1 X2 X3 X4 x5 [True val

¢ First-CH, Last-CH
Select the target channels. You can set consecutive channels whose range is set to

the same value as the first channel.

¢ Number of set points
Select the number of points that make up the segments (including the start and end

points) in the range of 2 to 16.

To disable calibration correction, select Off.

¢ Number of set points > MES val, True val
Press the Input soft key and enter the value.
For the MES value, set a value that is greater than the previous value.

Press the Measure soft key to set the measured value at that point to MES val. If

you press the Measure soft key when setting multiple channels simultaneously, the

measured value of the first channel are set to the MES val of all channels.

Selectable Range of MES and True Values
Channels on which linear scaling is specified

Nofte

The calibration correction setting is set to Off if you change the Mode or Range setting.

.

.

—30000 to 30000 (the decimal place is the same setting as the scale value)

Other

channels

Value in the measurable range of the selected range
Example: —2.0000 to 2.0000 for 2 V range

Calibration correction cannot be specified on channels set to Skip.

IM 04L41B01-01E
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3.10 Counting Pulses (/PM1 Option)

The pulses applied to the pulse input terminal are counted on a computation channel.
For a description of the function, see section 1.1.

Setup Screen

Press MENU (switch to the setting mode) and select Math channel > Expression,

Alarm
. ol))
First-CcH: 181  Last-CH: 181
Hath  [E5N
Calculation expression
fat
Span Lower Span Upper Unit
[ -2epees | 3eeees |
Alarm
1 [ofr
2 [oFr
3 [ofr
4 [off
L 00 | off |

* First-CH, Last-CH
Select the target computation channels.

¢ Math
Select On.

e Math > Calculation expression
Enter the equation using symbols.
Q01 to Q08: Displays the number of pulses per second.
P01 to P08: Displays the number of pulses per scan interval.
*  The numbers 01 to 08 correspond to the pulse input terminal numbers.
For the procedure to set the computation channels, see section 9.1.

The procedure is explained below using an example.

* Example 1: Pulse Sum Value
Display the sum value of the pulse signal applied to pulse input terminal number 6.

R R R R R R M
fe——

Scan interval

Pulse input Time

&
&
&
&

H e
Number of pulses \— \_

per scan interval

(Sum) H
ﬁ

Pulse sum value

Expression
Assign the computation channel and set the expression. Set the span lower/upper
limit and unit according to the application.

Channel Equation Description
101 TLOG.SUM(P6) Sum of the number of pulses per scan interval
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3.10 Counting Pulses (/PM1 Option)

¢ Example 2: Number of Pulses per Minute
Count the pulse signal applied to pulse input terminal number 6 on the DX1002 (scan

interval set to 250 ms), and calculate and display the number of pulses per minute.
(Moving average over a minute)

Pulse input t f Time
Sampling interval

(250 ms) [/
[] I

1
Number of pulses I (60x) l
s
Number of pulses
per minute

per second

Expression
Assign the computation channel as shown below and set the expressions. Set the

span lower/upper limit and unit according to the application.

Channel Equation Description
101 Q6 Number of pulses per second
102 101*K01 Number of pulses per minute
Constant Value Description
K01 60 Coefficient for converting the number of

pulses per second to the number of
pulses per minute

Channel Rolling average Description
101 Sampling interval: 1s Moving average over a minute
Number of samples: 60

Channels

The computation is performed in order from the channel with the smallest channel
number in one scan interval.

Use a channel of a channel number larger than that of the channel counting the
number of pulses per second for the computation channel that is to calculate the
number of pulses per minute.

e Example 3: Reset When the Pulse Sum Value Exceeds a Certain Value
Reset the sum value when the pulse sum value exceeds a specified value (reset
value) and carry over the value exceeding the reset value to the sum after the reset.
Count the number of resets and calculate the total sum value up to that point.

Expression

Assign expressions to the computation channels as shown below and set the
constants.

Channel Expression Application

101 ((102+P01).GE.K01)+101 Pulse sum value reset count

102 CARRY(KO01):TLOG.SUM(P01) Pulse sum value

103 K01*101+102 Total sum value

Symbol Description

PO1 Counts the number of pulses per scan interval.

K01 Constant. The reset value. The sum value is reset when this value is exceeded.

IM 04L41B01-01E 317
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3.10 Counting Pulses (/PM1 Option)

Pulse input Time

Scan interyal

sl INsINE NN INAINA]

Number of pulses
per scan interval

o o |1 | 1 1 | 2 | 2

Reset count

all

(Resets the value below the reset value)

reset value

1l

Sum value

Channel 101: Reset Count

Calculates the number of times the pulse sum value is reset.

The expression “((102+P01).GE.K01)” is set to 1 when “the previous pulse sum value
(102) + the current pulse count (P01)” is greater than the reset value (K01). Otherwise,
the expression is set to 0. The value of channel 101 is incremented when the pulse
sum value exceeds the reset value.

Channel 102: Pulse Sum Value

Calculates the pulse sum value.

Under normal conditions, the pulse sum value TLOG.SUM (P01) is calculated. When
the pulse sum value is greater than or equal to the reset value (K01), the pulse sum
value is set to the amount exceeding K01.

Channel 103: Total Sum Value
Multiplies the reset value (K01) by the reset count (101) and adds the pulse sum value

(102) to derive the total sum value.

Note

* The computation is performed in order from the channel with the smallest channel number

in one scan interval. If the channel number in the expression is greater than or equal to the
channel number in which the expression is assigned, the previous computed result (previous
value) is used for the channel in the expression.

» Because the accuracy of the computation function is single-precision floating point, we
recommend a reset value less than or equal to 107,

» If the pulse input value of the scan interval is greater than the reset value, correct
computation cannot be achieved.
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3.11 Setting the Method of Detecting Over-Range
Values of Linearly Scaled Measurement
Channels

Setup Screen

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > Input, Alarm

net

Basic Setting Hode

Input
VYalue on owver-range

Alarm
Ho Togsing Ooff

* Input > Value on over-range

Settings Description

Free The value is set to —over range if the value is less than —30000 and +over range
if the value is greater than 30000 excluding the decimal point. The value is
displayed as —Over and +Over, respectively.

Over The value is set to —over range if the value is less than —5% of the scale and
+over range if the value is greater than 105%. The value is displayed as —Over
and +Over, respectively.

Example: If the scale is 0.0 to 200.0, the value is set to —over range if the value is
less than —10.0 of the scale and +over range if the value is greater than 210.0.

Note

For computations such as TLOG, CLOG, and report, the handling of the scale over-range value
can be set in advance.
See section 9.1.
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Chapter 4  Switching Operation Screens

4.1 Operations in Operation Mode

Switching the Screen with the DISP/ENTER Key and Arrow Keys

Press DISP/ENTER and arrow keys to show the display selection menu and sub menu to
switch the display. The flow of operation is indicated below.

su@auog uonesado Buiyoymg =

(( DISP/ENTER key and arrow keys
~ TREND Sec. 4.2
| 1
i~ GROUP1  [---- GROUP n ;
E N E
O I S, }_ ____________________ J
DIGITAL Sec. 4.2
L 1 pr
1 1 =5 Y
E GRG P1  |---1 GROUP n E =
E E Sub menu
[ I I $ ____________________ 4 Display selection menu
BAR Sec. 4.2
E 1: Tag Display
i > (J—*'j— i Long tags may not fit in the display space. In such
! ! case, they are displayed as follows:
1 GROUP1  |---1 GROUP n H » Automatically scrolls the screen once immediately
i i after the screen is displayed.
! ! + Scrolls the screen once when you press ESC.
Lo e 4
OVERVIEW }-
Sec. 4.4
INFORMAT|ON
r-=——=-=-=--9 Suiid me hl
i ALARM MESSAGE MEMORY REPORT DATA RELAY i
! |SUMMARY SUMMARY SUMMARY Sec. 4.5 Sec. 4.5 !
| sec.4.6 Sec. 4.7 Sec. 4.8 !
R T B -E MODBUS i
! MASTER i
PREND | |MODBUS ;
HISTORY | CLIENT Sec. 4.5 !
Sec. 4.3
LOG  Sec.4.9
E Login log, error log, communication log, FTP log, i
N Web log, e-mail log, SNTP log, DHCP log, and !
i Modbus status log i
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4.1 Operations in Operation Mode

Operations Using Other Keys

So keys (see below)

r

s s fan e e
@ @ CRITDNEAIED)
Favorlte key (see section 5.15)

FUNC key (see below)
USER key (see section 7.1)
START and STOP keys (see section 6.4)

Operation Using the FUNC Key
Press FUNC to display the FUNC key menu at the bottom of the screen. Press the

Next soft key to SW|tch the menu. Press the desired soft key.

|
162 168

1_Ra?

m— Next soft key

Y
FUNC key menu
(Select using the soft keys)

Sec. 3.8 Sec. 5.4 Sec. 5.4 Sec. 6.4 Sec. 6.6 Sec. 6.5 Sec. 6.4 Sec. 6.4 Sec. 6.4 Sec. 4.8
Sec. 2.12

Sec. 9.4 Sec. 9.4 Sec. 9.4 Sec. 7.1 Sec. 8.1 Sec. 8.3 Sec. 8.3 Sec. 5.3 Sec. 6.3 Sec. 6.3

Sec 5.15 Sec. 5.14 Sec. 2.5 Sec. 2.5 Comm* Comm* Comm* Comm*
* Communication Interface User’s Manual.

Customizing the Menus
The display selection menu that appears when the DISP/ENTER key is pressed and

the FUNC key menu that appears when the FUNC key is pressed can be changed.
See section 5.17.
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4.2

Displaying the Measured Data as Waveforms,
Values, or Bar Graphs

This section explains how to use the trend, digital, and bar graph displays.
For a description of the function, see section 1.3.

Procedure

¢ Showing the Display
1. Press DISP/ENTER to show the display selection menu.
2. Press the arrow keys to select TREND, DIGITAL, or BAR, and press DISP/

ENTER.
The selected display appears.

¢ Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

Sub menu of the trend display
;

£ ]— Group name: Displays the group

— ALL CHANNEL: Displays the waveforms of all
channels

— || GROUP CHANNEL: Displays the waveforms of the

— channels registered to groups

= ] SCALE ON: Displays the scale

SCALE OFF: Clears the scale

DIGITAL OFF: Clears the numeric display section
DIGITAL ON: Displays the numeric display section

— MESSAGE DISP1: Displays the messages using display
method 1

MESSAGE DISP2: Displays the messages using display
method 2

— TREND SPACE ON: Inserts a space at the right edge

E (horizontal display) or the top edge
' (vertical display) in the waveform

; display section

1 TREND SPACE OFF: Does not insert a space

(To show these items on the menu, see section 5.17.)

—— AUTO SCROLL ON: Automatically switches the displayed
groups

AUTO SCROLL OFF: Does not automatically switch the
displayed groups

Sub menu of the digital display
/16 10:10: 10 o IESEE (O

1.4264
v

il— Group name: Displays the group

— AUTO SCROLL ON: Automatically switches the displayed
v groups
AUTO SCROLL OFF: Does not automatically switch the
displayed groups

ol))
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4.2 Displaying the Measured Data as Waveforms, Values, or Bar Graphs

Explanation

il— Group name : Displays the group

AUTO SCROLL ON : Automatically switches the displayed
1.4346 | 1.t groups

AUTO SCROLL OFF: Does not automatically switch the
displayed groups
4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

Starting the Waveform Display of the Trend Display/Stopping the

Waveform Updating
Press START to start the waveform display of the trend display. Press STOP to stop
the waveform updating.

Writing Messages
See section 5.4.

Switching the Displayed Group Using Arrow Keys
Press the right arrow key to switch the displayed group in ascending order. Press the
left arrow key to switch the displayed group in reverse.

Switching the Trend, Digital, and Bar Graph Displays Using the Arrow
Keys

Press the down arrow key while showing the trend, digital, or bar graph display to
switch the display in the order trend, digital, bar graph, trend, and so on. Press the up
arrow key to switch the display in reverse order.

ALL CHANNEL/GROUP CHANNEL on the Trend Display

On the group display, the channels that are assigned to the group are displayed. In all
channel display, the waveforms of all channels that are configured to record data are
displayed on the current group display.

SCALE ON/OFF and DIGITAL ON/OFF on the Trend Display
Select whether to show or hide the scale and numeric display sections.

AUTO SCROLL ON/OFF

The displayed groups can be automatically switched at a specified interval by
selecting AUTO SCROLL ON. The display switches in ascending group order.
For the procedure to set the auto scroll interval of groups, see section 5.13.

MESSAGE DISP 1 and MESSAGE DISP 2 on the Trend Display
Switches the message display method.

IM 04L41B01-01E



4.3 Displaying Past Measured Data (Historical
Trend Display)

There are five methods to display the past measured data.
For a description of the function, see section 1.3.
Recall from the display selection menu (see this section).
Display from the alarm summary (see section 4.6).
Display from the message summary (see section 4.7).
Display from the memory summary (see section 4.8).
Show the measured data stored on an external storage medium (see section 6.8).

Procedure

* Showing the Display
Carry out the procedure below while memory sampling is in progress.
1. Press DISP/ENTER to show the display selection menu.

2. Press the arrow keys to select TREND HISTORY, and press DISP/ENTER.
The display appears.

¢ Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.
Sub menu of the historical trend display

p 1 o BT (O

B/18 18:16:18

¢ P |GROUP 1
—— Group name: Displays the group.

—  ALL CHANNEL: Display the waveforms of all
channels.

GROUP CHANNEL: Displays the waveforms of the
channels registered to groups.

SCALE ON: Displays the scale.
SCALE OFF: Clears the scale.

MESSAGE DISP2: Switches to message display 2.
MESSAGE DISP1: Switches to message display 1.

—— CURSOR TIME ON: Displays the time at the cursor
position at the upper right.
CURSOR TIME OFF: Displays the date/time of the data
at the right edge.

]7 Switches to the specified display.

Return to the display that was shown before the
historical trend.

__r— Displays the alarm summary in the loaded data file.
— Displays the message summary in the loaded data file.
~— Displays the information of the loaded data file.

]— Expands/Reduces the time axis.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.
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4.3 Displaying Past Measured Data (Historical Trend Display)

¢ Moving the Cursor and Scrolling the Waveform

Moves the cursor up by 1 dot.

ALY Hold down an arrow key to move
‘@» Moves the cursor down by 1 dot. the cursor by 2 divisions.
@ Use the left and right arrow keys on the horizontal trend display.
* Displaying the Continuing Data

Approximately one screen of data is shown on the historical trend display. The

continuing data can be shown as follows:
\ Move the cursor to the end of the waveform and press
the arrow key yet again to shift a half a page and

4 \/‘\/
Displayed> (@’ display the continuing data.
¥ V4 A\

2 Move the cursor to the end of the waveform and press
the arrow key yet again to shift a half a page and
W display the continuing data.
* Use the left and right arrow keys on the horizontal

trend display.
» Specifying the Display Range
Specify the display range. Items inside the parentheses are for the horizontal trend
display.

1. Press the right (up) arrow key.
The waveform of the entire data range is displayed at the right (top) section of the screen.

1 2 Fmin ;
i Displayed highlighted.
/28 1F 3 These icons are not displayed if the scale
is displayed.

Frame indicating the display range

All data display

(all of the data in the display memory)
Loads as much of the continuous data as
the display memory can hold and shows
the data when switching to the all data
display (Release number 2 or later).

2. Press the up and down (left and right) arrow keys to set the display position by
moving the frame that indicates the display range.

3. Press the left (down) arrow key.
The specified range is displayed.
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4.3 Displaying Past Measured Data (Historical Trend Display)

¢ If the Data Does Not Fit in the All Data Display (Release Number 2 or Later)
Specify the range to be displayed in the all data display.
Below is the procedure to display data that is older than the data displayed currently.
ltems inside the parentheses are for the horizontal trend display.

1. Press the right (up) arrow key.
The waveform of all the data in the display memory is displayed at the right (top) of the
screen. At the same time, the data area in the internal memory that can be loaded is
displayed. In addition, the data position of 8 MB that is displayed in the all data display is
indicated using a rectangular frame in the loadable data area.

All data display
(all the display data in the display memory
amounting to 8 MB)

— The green arrow indicates that loadable
data exists in the arrow direction.

— A frame indicating the 8 MB that is shown
in the all data display.

7

A frame indicating the range shown in the
screen.

Loadable data in the internal memory

2. Press the down (left) arrow key to move the frame indicating the display range
to the edge of the all data display. If you press the down (left) arrow key again,
the message “Overwrite old data?” appears.

3. Select Yes and press DISP/ENTER to replace 4 MB of data in the display
memory.

4. Press the up/down (left/right) arrow key to move the frame indicating the
display range to specify the range you want to display.

5. Press the left (down) arrow key.
The specified range is displayed.
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4.3 Displaying Past Measured Data (Historical Trend Display)

Explanation

¢ Dividing the Screen into Halves and Displaying the Current Trend and

Historical Trend Simultaneously

This operation is possible only when the historical trend of the display data is being
displayed. Items inside the parentheses are for the horizontal trend display.

* This operation is not possible when the scale is displayed.

Press the left (down) arrow key.
The current trend is displayed in the top half (right half), and the historical trend is

L A 666U5
Hl

To revert to the original screen, press the right (up) arrow key.

Writing Add Messages
For the operating procedure, see section 5.4.

ALL CHANNEL/GROUP CHANNEL
The waveforms of channels assigned to the group or waveforms of all channels that

are configured to record data are displayed on the current group display.

SCALE ON/OFF
Select whether to display the scale. The current value mark of the scale indicates the

value at the cursor position.

MESSAGE DISP 1 and MESSAGE DISP 2
Switches the message display method.

TIME AXIS > ZOOM+ and ZOOM-

The time axis can be expanded or reduced around the cursor position.

» Display data: 2 times the trend display to 1/60 minimum

« Event data: Reduction only, up to 1/60 minimum
The minimum magnification and the factor by which the display can be expanded
or reduced with one operation vary depending on the trend interval for the display
data and on the sampling interval for the event data. To expand or reduce further,
repeat the procedure.
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4.3 Displaying Past Measured Data (Historical Trend Display)

¢ INFORMATION (Information on the Displayed Measured Data)
The following information is displayed.

Filename
Hemory

File twpe Display
Serial number :SHESBEEEE

Batch number
Lot nunber : BEBEEd

Start time 120518718 B6:52:52

Page switch mark
Comment and text field are
displayed on the second and
third pages when using the
batch function.

Use the left and right arrow
keys to switch the page.

End tine |2885/18/18 18:85:dd

T

Display Description

File name Data in the internal memory is displayed as “Memory.” For a file on

the external storage medium, the file name is displayed.

File type

Display corresponds to display data, and Event corresponds to
event data.

Serial number

The serial number of the DX that was used.

Batch number, Lot number

Displayed when the file is created using the batch function.

Start time, End time

The start time and end time of recording.

User name

Name of the user who performed the operation. Displayed when the
login function was used.

Note

When measured data on the external storage medium is displayed, the serial number
corresponds to that of the DX that was used to save the data.

¢ Background Color of the Historical Trend
You can change the background color of the historical trend.

For the procedure to change the background color of the historical trend, see section

5.13.
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4.4 Display the Statuses of All Channels on One
Screen (Overview Display)

This section explains how to use the overview display.
For a description of the function, see section 1.3.

Procedure

* Showing the Display
1. Press DISP/ENTER to show the display selection menu.
2. Press the arrow keys to select OVERVIEW, and press DISP/ENTER.
The display appears.
¢ Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.
Sub menu of the overview display

10 10:10:10 W0 EEEEMI(O)ES )

CURSOR OFF: Clears the cursor.
| CURSOR ON: Displays the cursor.

—— JUMP TO ALM SUM: Switches to the alarm summary.

L JUMP TO TREND: Switches to the trend display of the
smallest group number that includes
the channel selected with the cursor.

JUMP TO DIGITAL: Switches to the digital display of the ;
! smallest group number that includes |
! the channel selected with the cursor.i
EJUMP TO BAR: Switches to the bar graph display of |
! the smallest group number that

' includes the channel selected with
| the cursor.

(To show these items on the menu, see section 5.17.)

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

¢ Showing the Trend, Digital, Bar Graph Display Containing the Specified
Channel
1. Press the arrow keys to move the cursor, and select a channel.

oo 16710 10:10:10 e IEE(S)ER )
IN-val
H B.7724 V

Cursor (white Frame)

2. Switch to the trend, digital, or bar graph display according to the procedure
described in “Changing the Displayed Contents.”
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4.5 Displaying Various Information

Procedure

This section explains how to display reports (/M1 and /PM1 options) and how to use the
status display.
For a description of the function, see section 1.3.

* Showing the Display

1.

2.
3.
4

5.

Press DISP/ENTER to show the display selection menu.
Press the up and down arrow keys to select INFORMATION.

Press the right arrow key to display the sub menu.

Press the up and down arrow keys to select the sub menu item.
To close the menu without changing the displayed contents, press the ESC key.
Sub menu of the information display

Iminddip
Hex ALARM SUMMARY: Displays alarm summary.
3 » See section 4.6.
il I ST MESSAGE SUMMARY:Displays message summary.
T ALARH SUMHAR > See section 4.7,

:Tﬂ. TNFOR: —— MEMORY SUMMARY: Displays memory summary.
R iation

> See section 4.8.
{MODBUS CLIENT: Displays Modbus client status.
EMODBUS MATER: Displays Modbus master status.
RELAY: Displays relay status.

(To show these items on the menu, see section 5.17.)

REPORT DATA: Displays report data.

Press DISP/ENTER.
The display appears.

* Displaying the Report

Switching the Displayed Report Data

The Index item on the report display shows “the number of the report data being

displayed/the number of report data saved in the internal memory.” The largest

report data number corresponds to the most recent report data.
Number of the report data being displayed

Number of report data saved to the internal memory

1010 0= IEETE(O)

Index @ 18/18 Kind : Hourlw
Start @ 28@5/18/18 19:18:18
Timeup: 2005/18/18 12:00:608

Ch Unit Sts fve Hax Hin Sum

eat | —_— B.54% B.9E2E B.6TED  1LSPIPREEHER
eaz L —_— B.6586  B.7B56 B.SIES 1. IMISIEHER
Bas L —_— 85577 B8.554 B.4353  9.954267EHAL
aa4 1) —_— B.4883 B.4335 B339 T.4Z2IEEH1
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4.5 Displaying Various Information

Carry out the procedure below to switch the displayed report data.
Up arrow key: Report data being displayed + 1.

Down arrow key: Report data being displayed — 1.

Left arrow key: Report data being displayed + 10.

Right arrow key: Report data being displayed — 10.

Note

The display is not updated even if a new report is created while displaying the report data.

Perform either of the operations below to display the most recent report data.
» Hold down the left arrow key until the latest report data is displayed.
* Press DISP/ENTER and display the report data again from the display selection menu.

* Switching the Report Channels
Up to 12 report channels can be shown on one screen. If there are more than 12
report channels, you can switch the displayed report channels.

Press DISP/ENTER to show the display selection menu.
Press the right arrow key to display the sub menu.
Press the up and down arrow keys to select CHANGE REPORT CH.

Press DISP/ENTER.
The displayed report channels are switched.

R b=

¢ Relay Status Display
Lists the statuses of the alarm output relays and internal switches. You cannot change
the settings on this display.

! 18 @[:-IEF- @] u))

EETET Red: ON
SEz S17
= igg 0 sez O sis Green: OFF
W o E a4 E =19

E ses E sze
O 185 O ses O s21
@ I O sev M szz

E se= H =2z

E =sas E =24

E =18 E =25

E 51t E sze

E =1z M sz7

E =1z E sz=

E =14 E =29

E sis E s3e

¢ Modbus Status Display
Lists the statuses of the Modbus client or Modbus master commands.

For the operating procedure, see the Communication Interface User's Manual
(IM04L41B01-17E).

T )
f:10: 10 Ae@ I @ )

Read cucle : s . - cgr
Conect.ratry : mmn} Communication conditions
Comm. Data
Mo. Status First Last  Server name Registers
= 1R ®Good CB1 - CAS modbus. dasstat i Jae1

W € Hone 1 192.168.1.88 4EBE1
< Hone 181 - 185 192.168.1.88 4881a

W

I S St ee—
| | — Communication destination

DX channels

‘ Status

Command

ST NN RN V.Y BT N TN
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4.6 Using the Alarm Summary

Procedure

Explanation

This section explains how to use the alarm summary.
For a description of the function, see section 1.3.

e Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

18:18 @“? —m@ ”))

harine] Tope @ = Sort symbol
j . 2L 2885718718 18:87:51 A Ascending sort
o 1L 2085/18/10 18:07:d4 .
. IH 2095/18/18 18:05:33 ¥ Descending sort
J CHANNEL % 2085/16/18 18:63:45

<UL o
LL

iT
o

LLL

Display name:

1t

g
T
-

firton > 7_| display
TO OVERVIEW: i

4. Press DISP/ENTER to change the displayed contents.

To close the menu without changing the displayed contents, press the ESC key.

* Moving the Cursor (=) and Scrolling the Alarms

Scrolls the alarm information up by half a page
l— Moves the cursor up

Scrolls the alarm information down by half a page

Moves the cursor down

* Recalling the Historical Trend Display at the Point When the Alarm

Occurred

1. Select an alarm with the cursor.

Switches to the specified display

IEZ] —— TO HISTORY (DISP):  Switches to the historical trend

Switches to the overview display

—l— CHANGE SORT KEY: Sort the alarm information by
channel or alarm time

ASCENDING ORDER: Sort in ascending order
DESCENDING ORDER: Sort in descending order

2. Display the historical trend according to the procedure described in “Changing the

Displayed Contents.”

e CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER
The alarms are sorted in ascending or descending order by the following keys. The

sort symbol is displayed next the sort item (see the figure above).
* Channel number: Sorts the alarms by channel number even if tags are being

used. Alarms in a channel are sorted by the alarm number.
» Time of alarm occurrence/release

IM 04L41B01-01E

4-13

su@a1og uonesadQ Buiyoymg =



4.7 Using the Message Summary

Procedure

Explanation

This section explains how to use the message summary.
For a description of the function, see section 1.3.

e Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

Sort symbol

H 2085/16/18 18:87:51 A Ascending sort
2L 2985/16/19 18:87:dd .
H 2005/18/18 19:05:38 ¥ Descending sort

1H 2@A5/18/18 18:83:45

Display name: Switches to the specified display

sgdl —— TO HISTORY (DISP):  Switches to the historical trend
display

—|— CHANGE SORT KEY: Sort the messages by channel,
time, group, or user name

=y IMFOR-
R hation

ASCENDING ORDER: Sort in ascending orde
DESCENDING ORDER: Sort in descending order

CHANGE DISP ITEM: Switches between “time and
group” and “user name”

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

* Moving the Cursor (=) and Scrolling the Messages

Scrolls the messages up by half a page
— Moves the cursor up

Y

A
‘@ Scrolls the messages down by half a page
5

Moves the cursor down

* Recalling the Historical Trend Display at the Point When the Message

Was Written
1. Select a message with the cursor.

2. Display the historical trend according to the procedure described in “Changing the
Displayed Contents.”

e CHANGE DISP ITEM

Switches between the following two message display methods.
* Message, time, and group
* Message, user name

* CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER

The messages are sorted in ascending or descending order by the respective key.
The sort symbol is displayed next the sort item (see the figure above).

4-14
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4.8 Using the Memory Summary

This section explains how to use the memory summary.
For a description of the function, see section 1.3.

Procedure

* Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.
DI

EEN Sain |
aLm 1asais The displayed data type is

qE 2
1680 ¢ 1263 17:EE 8 . . .
indicated with a green mark.

v DISFLAY DATA & EVEWT romo

Display name: Switches to the specified display

|— TO HISTORY: Switches to the historical trend display.

i MR, I8 I —— SELECT SAVE:  Saves a selected file.

(To show these items on the menu, see section 5.17.)

L ALL SAVE: Saves all the data.

CHANGE DATA KIND: Switch between display data —
and event data.

FILENAME DISPLAY: Displays the file name.
For a description of file names,
see section 1.4.

TIME DISPLAY: Displays the times of the first
and last data in the file.

su@aluog uonesado Buiyoymg =

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

* Moving the Cursor (=) and Scrolling the Memory Information

Scrolls the memory information up by half a page
|— Moves the cursor up

‘ ) Scrolls the memory information down by half a page

Moves the cursor down
* Displaying the Historical Trend for the Data Specified by Memory
Summary
1. Select the data with the cursor.

2. Display the historical trend according to the procedure described in “Changing the
Displayed Contents.”
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4.8 Using the Memory Summary

¢ Saving the Data
Save the data in the internal memory to the CF card or the USB flash memory (/USB1

option).
For a description of the function, see section 1.4.

1. To save by selecting the file, select the desired data file with the cursor. This
operation is not necessary for other cases.
Start Time End Time Data Factor
18-10 18:67:56  18-18 182630 5 SaFlina
16-10 18:63:84 1818 1 il 327 Stior
w1018 1eE2 2R 1616 18E2: =) Stior
18-16 18:08:24 1018 16:2@1:24 16 Stior
1810 @3:523: 28 1018 G521 32 19 Stior
1099 20: 02182 10-99 262 25052 232 Stior
18499 19062102 10-99 26262164 5] Auto Sae
18493 182622823 18-93 19:4%: s Auto Save
16493 17:E2:E2 1899 ) Auto Save
18493 16216252 1899 17167 15 KTl Stior
18499 1626108 18-93 161650 T Stior
1893 BAERi48 1099 BR143:52 [ Stor
Cursor
(Move using the
arrow keys)

2. Press DISP/ENTER to show the display selection menu.

3. Press the right arrow key to display the sub menu.

4. Select the sub menu item using the up and down arrow keys.
Sub menu items are SELECT SAVE, M.SAMPLE SAVE, REPORT SAVE (/M1 and /PM1
options), and ALL SAVE.

5. Press DISP/ENTER.

* If you are using a CF card and a USB flash memory (/USB1 option), the message “Which
media do you want save to?” appears. Select the destination medium using the arrow keys,
and press DISP/ENTER.

The measured data is saved.

Nofte

To abort the data saving operation in progress, carry out the procedure below.

Press FUNC and press the Save Stop soft key.

Progress Display When Saving All Data of the Internal Memory (Release Number
2 or Later)

If you carry out All Save* on the memory summary screen, a pop-up window appears
showing the progress of the save operation.

*

Function for saving all data in the internal memory to a CF card or USB flash memory.

M.SAMPLE DATA  (@2a-d4ea) @
FEFORT DATA

AR 188D =

SAMPLE DATA @ @ DISPLAY DATAC.DADD
Start Time Erd Time

1@:

Dat.a

12-26 118720 1139 Stoe
12-26 224 14
=1
2
2
=)
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4.8 Using the Memory Summary

Explanation

Note

* The pop-up window appears only when the memory summary display is showing.

* If you press the ESC key, the pop-up window clears temporarily and reappears
approximately 10 seconds later.

* The time estimate for saving all data is indicated in the table below (when the memory is full
of data). It may take longer depending on the operating conditions of the DX.

Save Destination Time to Save All Data (Estimate)
CF Card USB Flash Memory
Standard memory 4 minutes 5 minutes (16 minutes)*
(internal memory size suffix code -1)
Large memory 10 minutes 15 minutes (40 minutes)*

(internal memory size suffix code -2)

*

Values for the DXs with firmware version 2.02 or later. Values inside the parentheses are
for the DXs with firmware version 2.01 or earlier.

» To abort the data saving operation in progress, carry out the procedure below.
Press FUNC and press the Save Stop soft key.

e Save directory

The data is saved by creating a directory each time the save operation is carried
out.

Directory name: Specified string_YYMMDD_HHMMSS (where YY to SS is the date
of operation)

A 10:10:18 File list example
izt/delete

Directory name Date / Time
DATAA #5/18/18 18:18
DATA_AS1A16_16810A48 S HA— A Save directory
DATA_AS1A16_181R85 #5/18/18 18:18
DATA_AS1A18_181A1A #5/18/18 18:18

Display data or event data that is in the process of adding data cannot be saved.
The save operation explained here merely copies the data in the internal memory.
It does not save the unsaved data in the internal memory (see section 1.4).

Data saving is aborted when there is insufficient free space on the storage medium.
Use a storage medium with sufficient free space when saving data.
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4.9 Displaying a List of Operation Logs

Procedure

Explanation

Displays the following operation logs.
Login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP
log, and Modbus status log

* Displaying the Log
1. Press DISP/ENTER to show the display selection menu.

2. Press the up and down arrow keys to select LOG.
* To show LOG on the menu, see section 5.17.

3. Press the right arrow key to display the sub menu.

4. Press the up and down arrow keys to select the sub menu item.

To close the menu without changing the displayed contents, press the ESC key.
Sub menu items are LOGIN, ERROR, COMMUNICATION, FTP, MAIL, WEB, SNTP,
DHCP, and MODBUS.

5. Press DISP/ENTER.
The display appears.

* Login Log

The log number of the last line and the
total number of logs

s =T o
!\50%a te: 1010 ["EF m@] 0}

(ABDYAAS) Time Action

Factor Username

18718 B6:88:88 Login

18718 BE:88:8] Power(n
18/89 11:23:29 Power(ff
18/89 B3:83: B3 MewTime
B1/81 B8:88:81 TimeCha

KEY  Adminl
SY5
SY5
KEY
KEY

[ User name
Operation method (see the table below)

Operation (see the table below)

Date/time
Action Description
Login Login
Logout Logout
NewTime Time change while memory is stopped
TimeChg Time change through key operation
PowerOff Power OFF (power failure occurred)
PowerOn Power ON (recovered from a power failure)
TrevStart Start the operation of gradually adjusting the time
TRevEnd End the operation of gradually adjusting the time
TimeDST Switch the daylight savings time
SNTPtimset Time change by SNTP
Factor Description
KEY Key operation
CcOoM Operations via communication
REM Operation through the remote control function
ACT Operation through event action
SYS Operation by the system
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4.9 Displaying a List of Operation Logs

Error Log

(127813} Time

18 10:18:18 @m'}'

Mo, Hessage

2885/18/83 15:11:87
2@85/18/83 15:18:53
2885/18/83 15:87:15
2885/18/83 15:85:33
2885/18/83 15:0d 03

232 There iz no available da..
128 Measured walue is incorr..
181 This action is not possi..
218 Hedia has not been inzer..
294 Mo time correction becau,

Error age*
Error code*

Date/time

* See section 10.1, “A List of Messages.”

¢ Communication Log

(B11/811) Time

1/0 Hessage

2885/18/18 @5:18:45
2885/18/18 @5:17:45
2885/18/18 @5:17:45
2885/18/18 #5:17:21
2885/18/18 B5:17:21

(Timed outy

EA

SR2,WOLT,BY, -3208, 32
(186 bwter

s

T— Message*

Input/output symbol (>: input, <: output)

@ N

User ID number (0: serial, 1 to 3: Ethernet)
Date/time

* See the Communication Interface User's Manual (IM04L41B01-17E).

(2]
z
-
(2]
=
=3
«Q
(®)
K=}
®
=
Q
=
o
=
[
2]
=
®
o
>
(7}

* FTP Log

[ = .
15 101010 S0 IEETE(S)

(AA3/883) Time Mo, Code

Flag Filename

2085/18/18 18:8d:13 283 PASS P B51818_1@8413
2085/18/18 18:Bd:B8 282 HOSTNAME S FTP_TEST.TAT
2085/18/18 18:62:88 282 HOSTNAME P FTP_TEST.TAT

File Name

FTP connection destination
(P: primary, S: secondary)

Error age (detail code)*
Date/time

* See section 10.1, “A List of Messages.”

ol))

(BB5/BE8) Time Reguest Mo, Parameter

18718 18:18:18 Hessage STOP
18718 18:18:88 Hessage BATTERY
18/1@ 18:88:58 Screen TREWD  GROUP=1

16/18 18:87:48 Screen HISTORY GROUP=1
16/18 18:67:30 Hessage HIGH WOLTAGE

16/18 B8:37:58 Hessage 155 HIGH WOLTAGE

Operation (see the table on the next page)
Error code*

Requested operation (see the table below)
Date/time

* See section 10.1, “A List of Messages.”

Request Description

Screen Screen switch

Key Key operation

Message Message assignment/write
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4.9 Displaying a List of Operation Logs

Parameter Description

TREND Trend display

DIGIT Digital display

BAR Bar graph display
HIST Historical trend display
oV Overview display
DISP DISP/ENTER key

UP Up arrow key

DOWN Down arrow key

LEFT Left arrow key

RIGHT Right arrow key
FAVOR Favorite Key
Messages Character strings that are written.

* E-mail Log
f ==
2 1011010 00 IEETE(S) =

(AB5/H85) Tine Tvpe Mo, Recipient / Error

18/89 16:48:88 Time 2 user?
1889 16:38:53 Alarm 1 userl
18/89 16:36:28 Test 2 user?
18/83 15:31:48 Test 1 userl

10/09 15:30:40 Test 281 ] Sr][Pﬂ—H'?h"E‘D?U‘..
Recipient (mail address, message)

Recipient (1: recipient 1, 2: recipient 2)
Error code*
Event (see the table below)

Date/time
* See section 10.1, “A List of Messages.”
Type Description
Alarm Alarm mail
Time Scheduled mail
Report Report timeout mail
Fail Power failure recovery mail
Full Memory full mail
Test Test mail
Error Error message mail
e SNTP Log
s 10,10 19:16:10 @m'}' m@
(@84/084) Tine No. Code
2985/16/19 18:19:1@ SUCCESS
2985/16/19 B9:19:1@ SUCCESS

2865718718 @9:18:18 294 OVER
2085/18/18 @7:18:28 291 TIMEOUT

Error message (detail code)*
Error code*

Date/time

*

See section 10.1, “A List of Messages.”
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4.9 Displaying a List of Operation Logs

e DHCP Log

D

[ = .
5. 10:10_ o= MY (O

Mo, Code

2865/168/18 88:15:24 297 NOMAME

2085/18/18 B3:15:24 BES IPCONFIG
2085/18/18 B88:883:24 564 RENEWED
2085/18/18 B3:@3:18 565 IPCONFIG

Error message (detail code)*
Error code*
Date/time

*

See section 10.1, “A List of Messages.”

¢ Modbus Status Log

[
o0 o6 10,1010 e MEETEI(S) i +9)
(B12/288) Time Kind Factor Command
2085/18/18 BE:36:36 M @ HONE B3 Y

2865716718 B6:36:36 H g Dropout
20865/16/68 19:568:86 © @ Goob B2 R
20865/16/68 19:568:86 © @ Goob BLR
20865/16/68 19:58:85 © O B2 R

| Command number, command type
(R: read, W: write)

Communication status*
Communication type (C: client, M: master)
Date/time

* See the Communication Interface User's Manual (IM04L41B01-17E).

(2]
z
-
(2]
=
=3
«Q
(®)
K=}
®
=
Q
=
o
=
[
2]
=
®
o
>
(7}
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Chapter 5 Operations for Changing the Displayed Contents

5.1 Setting Display Groups

Assign channels and set the group name for each display group. Set lines at specified
positions in the waveform display range on the Trend display.

Setup Screen

Press MENU (switch to the setting mode) and select Group set, Trip line

U . -] TP
110 10:10:10_ 00 V(D) 0}
Group number

Group set

On/fOff (n

Group name GROUP 1

CH set BE1.8A2. 883, 864
Trip line

Position Color Width

[on EL N | Red [1 dat

1
2 Jon A | Elue [T dat
3 [off
4 [off

1 1 2 [ 3 | 4 |

e Group number
Select the target group number (1 to 10).

¢ Group

¢ On/Off
Turn On the groups you want to use.

¢ Group name
Set the group name. (up to 16 characters, [Ala[#1])

¢ CH set
Set up to six channels from measurement channels and computation channels
(/M1 and /PM1 options).
» Enter the channel number using two or three digits.
» Separate each channel with a period.
» To specify a range of consecutive channels numbers, use a hyphen.

Example: To assign channels 1 and 5 to 8, enter “001.005-008.”

Note

» The trend, digital, and bar graph displays are shown in the specified order.
* Achannel can be assigned to multiple groups.
* The same channel cannot be assigned multiple times in a group.

IM 04L41B01-01E
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5.1 Setting Display Groups

Note

The channel settings of a display group can be copied to another group on a DX with release

number 2 or later.

4,17
Group number 1

Group set
On/fOff (n
Group name GROUP 1
CH set BA1.BA2. B3, AR
Trip line
1 |off
2 |off
3 |off
4 |off

Procedure

1. Select the copy source channel settings.

2. Press the Copy soft key.

3. Select the copy destination channel settings.

4. Press the Paste soft key. The channel settings are copied.

e Trip line
Set lines at specified positions in the waveform display range on the Trend display.
* On/Off
Turn On the trip lines you want to display.
¢ Position
Set the position in the range of 0 to 100% of the display width.
e Color
The default colors are red, green, blue, and yellow. If you want to change the color,
select from the 24 available colors.
* Width
Set the line width of the trip line in dots (1 to 3).
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5.2 Displaying Tags or Channel Numbers

Display the channels using tags or channel numbers.

Setup Screen

¢ Tag/Channel
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > Operating Environment

Basic Setting Hode

Operating environment

Taa/Channel
Lanauage Enalish
Remote Controller ID 0ff
Temperature G

* Tag

Tag

Characters IH-Y@1

Hemory sample

On/fOff On

Alarm delay

Time 18 =
[ Tnput ||

¢ Operating environment > Tag/Channel

Settings Description

Tag Displays tags. Channel numbers are displayed for channels that do not have
tags assigned.

Channel Displays channel numbers.

¢ First-CH, Last-CH
Set the target channels. The target channels are common with the other items that are
displayed on the screen.

¢ Tag > Characters
Set the tag. (up to 16 characters, [Ala[#[1])

IM 04L41B01-01E 5-3
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5.3 Setting the Trend Interval and Switching to the
Secondary Trend Interval

Setup Screen

Set the trend interval. Switch the trend interval to the secondary trend interval while the
memory sampling is in progress. Automatically write messages when the trend interval is
switched.

For a description of the function, see section 1.3.

¢ Switching the Trend Interval and Writing Messages (When Using the

Secondary Trend Interval)
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > View, Message

View
Trend tupe T-%
Partial 0ff

Trend rate switchina “

Hesszage

Write aroup Common

Power-fail message 0ff

Change message Ooff
T

Trend interval [/div] and Secondary interval [/div]
Press MENU (switch to the setting mode) and select Display > Trend/Save interval

|1|1n 16:10: 1A @m'}' @

Trend / Save interval

Trend interval [/div]

Save interval 1h

Second interval [Adiv] Imin

[ _18s | 30s [ lnin_| Znin_|

View > Trend rate switching

On: Enables the function that switches the trend interval while the memory sampling

is in progress. The “Second interval [/div]” item is displayed in the setting mode.

* When the trend rate switching function is On, the DX cannot be configured to record both the
display and event data (see section 6.1).

Message > Change message
On: Writes the time the interval is switched and the new trend interval as a message
when the trend interval is switched.
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5.3 Setting the Trend Interval and Switching to the Secondary Trend Interval

¢ Trend interval [/div] and Second interval [/div]
Select the time corresponding to 1 division of the time axis on the trend display from
below: You cannot specify a trend interval that is faster than the scan interval.
15s*, 30s, 1min, 2min, 5min, 10min, 15min, 20min, 30min, 1h, 2h, 4h, and 10h
* Can be set on the DX1002, DX1004, DX1002N, and DX1004N.

Nofte

If the trend interval is set greater than or equal to 1h/div on a DX with release number 2 or later,

the month, day, and hour at the grid position are displayed on the screen. The display format

can be changed by setting the date format.
GROUP 1

Thidiv

Month, day, and hour at the grid position.

H 6.6412  B.6414 B.641 B.64a
u v i v

Procedure

¢ Switching the Trend Interval

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Normal speed soft key or Second speed soft key.
The trend interval is switched. A message is written on the trend display (when the change
message is turned ON).
Display example: 10:53 1min/div

IM 04L41B01-01E 5-5
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5.4 Writing Messages

Write messages.

Setup Screen

¢ Message Write Group
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > View, Message

hEt

Basic Setting Hode

View

Trend tupe T-%
Partial 0ff
Trend rate switching Ooff
Hesszage

Write aroup W
Power-fail message 0ff
Change message Ooff

| Common Beparate

* Setting the Messages
Press MENU (switch to the setting mode) and select Message

_— - T
o 15:10: 10 e IEZEEN (O

Hessage Mo,
Characters

ETART

ETOP

FRESS.

DECOHP.

* Message
e Write group
This setting applies only for messages that are written using keys.

Settings Description
Common Write the message to all groups.
Separate Write the message to the displayed group.

¢ Power-fail message
See section 5.16.

¢ Change message
See section 5.3.
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5.4 Writing Messages

Procedure

* Message No.
Select the message number (1 to 100). Messages 1 to 10 are common with free

messages.” If a message is changed as a free message, the old message is
overwritten.

*

Messages that are written by creating the message on the spot.

* Message > Characters
Set the message. (up to 32 characters, [Alaf#]1])

* Writing Messages
Messages cannot be written when the memory sampling is stopped.

1.

Display the group to write the message.

+ If a screen unrelated to a group such as the overview is displayed, messages
are written to all groups even when Write group is set to Separate.

» Messages are written to all groups regardless of the displayed screen when
Write group is set to Common.

Press FUNC.
The FUNC key menu appears.

Press the Message soft key.

Press the soft key corresponding to the desired message number range (example:
[1-10]).
A list of message is displayed.

f |1|1n 16:10: 10 @“@

Press the soft key corresponding to the number of the message you want to write.
A message mark, time, and message are shown on the trend display.

510 10:10: 10 0= IEEEERA (S 0}

Lnindiv

Message

o
—
oy
]
I
A
=

L} Hl
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5-7

sjuayuo9 palkeidsiq ayj buibueys 10 suonesado n



5.4 Writing Messages

* Writing Free Messages
Create a message on the spot and write it.

1.
2.

Display the group to write the message.

Press FUNC.
The FUNC key menu appears.

Press the Free message soft key.

Press a message number soft key.
The message entry window appears.

Enter the message. (up to 32 characters, [Ala#]1])

Select ENT and press DISP/ENTER.
A message mark, time, and message are shown on the trend display.

* Writing Add Messages
Add messages to the past data positions. This operation can be carried out on the
past section of the data that is currently being memory sampled.

1.

3.

Explanation

Carry out the procedure below to show the historical trend of the data that is
currently being memory sampled.
Press DISP/ENTER and select TREND HISTORY > (group name) > DISP/ENTER

Press the arrow keys to move the cursor to the position you want to write the
message.

Write the message according to the procedure given in “Writing Messages” or
“Writing Free Messages.” Use the Add Message or Add Free Message soft key.

Cursor
(yellow line)

Add message

B

1.kEs

* Display Color of Messages
The message colors on the trend display are shown below. You cannot change them.

No. 1 2

3 4 5 6 7 8 9 10

Color Red Green

Blue Blue violet  Brown Orange Yellow-green  Light blue Violet Gray

The colors for messages 11 to 100 are repetitions of the colors above.

* Add Message

The message timestamp is the time that the message is written. It is not the time
stamp of the data at the position where the message is written.

S e ==nin |t ;] Display example on the message

(AE2/882)  Messase *Time Grp | SUMMary
= START 85/18/10 18:04 A . .
HOLD 85/10/10 18:43 Add message (displayed in blue)

Up to 50 messages can be written.
Messages cannot be added to data in the internal memory that has already been
saved to a file or data that has been loaded from the external storage medium.

5-8
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5.5 Changing the Channel Display Colors

Setup Screen

Change the channel display colors. The settings are applied to the trend and bar graph
displays.

Press MENU (switch to the setting mode) and select Meas channel > Color

210 10:10:10 e IECTE(O)ES )

Group of channel [LEbEEIEEE

Calor

Bal
ae2
a5k}
aad

Red
Green
Blue
B.wviolet

AA1-AAd

e Group of channel
Select the target channels.

e Color
To change the color, select from the following 24 colors.
Red, green, blue, blue violet, brown, orange, yellow-green, light blue, violet, gray, lime,
cyan, dark blue, yellow, light gray, purple, black, pink, light brown, light green, dark
gray, olive, dark cyan, and spring green

IM 04L41B01-01E
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5.6 Displaying Channels in Display Zones

Specify a waveform display zone for each channel so that waveforms do not overlap.
For a description of the function, see section 1.3.

Setup Screen

Press MENU (switch to the setting mode) and select Meas channel > Zone, Scale

TP 5 ++
10 10:10:10 e IEZE(S)ER )
First-CH: [T Last-CH: [1

Zone

Lawer m%
Upper 108 %
Scale

Position 1
Divizion 1@

¢ First-CH, Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

e Zone > Lower, Zone > Upper
Sets the zone in which the waveform is displayed. You can set Lower and Upper as

a position (%) when taking the maximum display width to be 100%. Set Upper greater
than Lower, and the zone width (Upper — Lower) greater than or equal to 5%.

Lower: 0to 95%

Upper: 5to 100%
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5.7 Displaying a Scale on the Trend Display

Setup Screen

Display a scale on the trend display.
For a description of the function, see section 1.3.

Scale Position and Number of Scale Divisions

Press MENU (switch to the setting mode) and select Meas channel > Zone, Scale
o810 10: 10,10 > IETEI(C)EE )

First-CH: [T Last-CH: [1

Zone
Lawer A%
Upper 108 %
Scale
Position
Divizion 1@

L off [ 4 [ 2o | 3 |

Number of Displayed Scale Digits and Current Value Indicator
Press MENU (switch to the setting mode) and select Display > Trend

b1 101010 o IEE(S)ER )

Trend
Direction Vertical
Trend clear 0ff
Hessage direction Horizontal
Scale
Digit | Hormal |
Value indicator Hark
Trend line 2 dot
Grid Auto div
 Normal | Fire |

Showing the Scales

To show scales on the trend display, press DISP/ENTER (show the display selection
menu) > the right arrow key (show the sub menu), and select SCALE ON (see
section 4.2).

First-CH, Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

Scale > Position
Select the scale display position on the trend display from 1 to 6. Select Off if you do
not wish to display the scale.

IM 04L41B01-01E
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5.7 Displaying a Scale on the Trend Display

¢ Scale > Division
Select the number of main scale marks on the trend display from 4 to 12 and C10.
C10: The scale is equally divided into 10 sections by main scale marks, and scale
values are indicated at 0, 30, 50, 70, and 100% positions on the trend display.
The figure below is an example in which each scale is displayed with the position
shifted.

Vertical Trend Display

++
—X

1|'a,,,,|,,,,|:’-,5,,,|,,,r’w ||?|5|||I|||1| ~ Number of scale divisions:
24 < 4 3 = < Number of scale divisions:
] I = I : <« Number of scale divisions:
4|El| caa b L <—Number of scale divisions:
5|:| tra g |2|22|5| va ] ,44 | LIty ,1, <—Number of scale divisions:
6|1!5-' IHI Lo e v | ||,||,,ﬁ,,,E|'a|<—Numberofsca|edivisions:
~ ‘ IminAdie

Scale display position |

5] 2 A MH EE =5} 1

E:HIlIHIllBI“IlH|3|E~|HHP1!'1-IIIEI-4I|I |%2||||||||||f|'a|*Numberofscaledmsmns:

||||||||||||||||||||||||||||_||||||| |||,,,|”,Eﬁ,“Eﬂ«Numberofscaledivisions:

5} 1& 3 MH S =23 168 .

Do b o b e bbb b 5 L) = Number of scale divisions:
A M-H, =38

5} 183 < Number of scale divisions:
||||||||||||||||||||||||||||||||..||||||||||||||E:a| umber ot scale divisions

Horizontal Trend Display

GROUP 1
PRAS/11/29 13117 (iR

Imingdiw

1
B

|$II

“ITTT
—

5

=]
=

|ﬁ|||||illl|5§lll|$l§llﬂl
|ﬂllllalllllﬂlll§gllll

|¢1III|IIII|EﬂIIIIIII

||:EIII|IIII|EIII|IIIII$III u
|¢|III|IIII|EﬂIII|III

Number of scale divisions: 10 Number of scale divisions:
Number of scale divisions: 11 Number of scale divisions:
Number of scale divisions: 12 Number of scale divisions:
Number of scale divisions: C10 Number of scale divisions:
Number of scale divisions:

Number of scale divisions:

F .
I

© o N O o b

10
1
12
C10

©O©oo~NO Oh
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5.7 Displaying a Scale on the Trend Display

Note

.

If the scales of multiple channels are set to the same position, the scale of the channel

assigned first to the group is displayed.

Example: If the order of assignment of a group is 003.002.001, and the scale display

position of all channels is set to 1, the scale of channel 3 is displayed at display position 1.

Even if some of the scale display positions are skipped, the scale is packed towards display

position 1.

Example: Suppose the assignment of channels to a group is 001.002.003, and the display

positions of the scales are set to 1, 3, and 6, respectively. The scales are actually displayed

at positions 1, 2, and 3, respectively.

The scale is divided into 4 to 12 sections by the main scale marks. The section between

the main scale marks is divided into 10 subsections by medium and small scale marks.

However, small scale marks are not displayed in the following cases.

*  When the resolution of the input range is smaller than the total number of small scale marks.

* When zone display is used.

*  When partial expanded display is used.

The scale values are displayed according to the following rules.

+ If the number of scale divisions is 4 to 7 for the vertical trend display7, values are
displayed at all main scale marks. If the number of scale divisions is greater, the values
are displayed at every other main scale marks.

» Scale upper and lower limits are displayed at the ends of the scale.

» Scale values are displayed up to 3 digits excluding the minus sign. However, if the
integer part of values at the ends of the scale is both 1 digit or the integer part is zero, 2
digits are displayed.

Example: If the scale is —0.05 to 0.50, the lower limit is “~0.0” and the upper limit is “0.5.”

» If the integer part of either end of the scale is 2 or 3 digits, the fractional part is truncated.
Example: If the scale is 0.1 to 100.0, the lower limit is “0” and the upper limit is “100.”

+ If the integer part of either end of the scale is 4 or more digits, the value is displayed
using a 3-digit mantissa and exponent like “x10” or “x10%",

Example: If the scale is 10 to 2000, the lower limit is “1” and the upper limit is “200 x 10”.

The unit is displayed near the center of the scale. If partial expanded display is used,

the display position is offset from the center. For the vertical trend display, the number of

characters that can be displayed is up to six. For the horizontal trend display, the number of

characters that can be displayed is up to three. However, if the scale digit display is set to

Fine, up to four characters are displayed.

¢ Trend > Scale > Digit
Fine: If the scale value is two-digit display, it can be changed to three digits. For

example, if the scale range is “49.0 to 51.0,” the scale values are displayed
using 3 digits as shown below.

|49.2 N/H|49.5 v |49.? 5.4
I I I I

Iminddiv

¢ Trend > Scale > Value indicator
The current value is displayed as a mark or a bar graph.

Bar graph

IM 04L41B01-01E
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5.8 Displaying Alarm Point Marks and Color Scale
Band on the Scale

Display alarm point marks on the scale. Display the specified range with a color band.
For a description of the function, see section 1.3.

Setup Screen

Press MENU (switch to the setting mode) and select Meas channel > Alarm mark or
Color scale band

* Alarm mark * Color scale band
Snom 10716 10:10: 10 o> BESEMI(OIER )T G 16010 (0 IEEE(OIER )
First-CH: Last-CH: [1 First-CH: Last-CH: [1
Alarm mark Color scale band
Hark kind Fixed Band area In
Indicate on Scale 0n Calor Lime
flarm mark color Dizsplay position
Alarm 1 Red Lawer A, 8868
Alarm 2 Orange Upper B.8188
Alarm 3 Orange
Alarm 4 Red

2 [ 3 | 4 ]

o0}

Alarm point mark

II.B 2.BI
Color band

Fitrdi

¢ First-CH, Last-CH
Select the target channels. The target channels are common with the other items that
are displayed on the screen.

e Alarm mark
Displays marks indicating the values of the high and low limit alarms, delay high and
low limit alarms, and difference high and low limit alarms. This setting is common with
the bar graph display.
e Alarm mark > Mark kind

Settings Description Mark

Alarm Indicates green under normal conditions and red Qor P
when an alarm is activated.

Fixed Displays a fixed color. v

¢ Alarm mark > Indicate on Scale
To display alarm point marks, select On.

¢ Alarm mark color > Alarm 1, Alarm 2, Alarm 3, and Alarm 4
If the Mark kind is set to Fixed, specify the color of the alarm point marks.

5-14 IM 04L41B01-01E



5.8 Displaying Alarm Point Marks and Color Scale Band on the Scale

Color scale band
Displays a specified section of the measurement range using a color band on the
scale. This setting is common with the bar graph display.

¢ Color scale band > Band area

Settings Description

In Displays the area inside using the color band.
Out Displays the area outside using the color band.
Off Disables the function.

e Color scale band > Color
Set the display color.

e Color scale band > Display position > Lower, Upper
Specify the display position. Set a value within the span or scale range.
Lower:  Lower limit of the area.
Upper:  Upper limit of the area.
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5.9 Partially Expanding the Waveform

Partially expand a waveform (reduce the other sections) on the display.
For a description of the function, see section 1.3.

Setup Screen

* Turning ON/OFF the Partial Expanded Display Function
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > View, Message

Basic Setting Hode Cink

View

Trend tupe T-%

Partial | on |

Trend rate switching Ooff

Hesszage

Write aroup Common

Power-fail message 0ff

Change message Ooff
T

¢ Partially Expanded Display Method
Press MENU (switch to the setting mode) and select Meas channel > Partial

[ =
10 10:10:10 00" Y () +13}
Firzt-CH: 1 Last-CH: 1

Partial
On/Off | on |
Expand 58 %
Boundary A, 8868
L 00 | off |

e View > Partial
If you select On, the Partial setup item appears in the setting mode.

e First-CH, Last-CH
Select the target channels.

e Partial > On/Off
To enable partial expanded display, select On.

* Partial > Expand
Set the position where the value specified by Boundary is to be displayed within the
display span in the range of 1 to 99.
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5.9 Partially Expanding the Waveform

¢ Partial > Boundary
Set the value that is to be the boundary between the reduced section and the

expanded section in the range of “minimum span value + 1 digit to maximum span
value — 1 digit.” For channels that are set to scaling, the selectable range is “minimum
scale value + 1 digit to maximum scale value — 1 digit.”
Example: Inputrange: -6 V to 6V. Expand: 30. Boundary: 0
The -6 V to 0 V range is displayed in the 0% to 30% range, and the 0 V
to 6 V range is displayed in the 30% to 100% range.
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5.10 Changing the Display Layout, Clearing of the
Waveform at Start, Message Display Direction,
Waveform Line Width, and Grid

Change the display layout, clearing of the waveform at start, waveform line width, and
grid.
For a description of the function, see section 1.3.

Setup Screen

Press MENU (switch to the setting mode) and select Display > Trend
/10 10:10:10 00 IEETN(O) 0}

Trend

Direction Vertical
Trend clear 0ff
Hessage direction Horizontal
Scale

Digit Hormal

Value indicator Hark

Trend line 2 dot
Grid Auto div

Horizon liertical

¢ Trend > Direction
Set the display direction of the trends to Horizontal, Vertical, Wide, or Split.

e Trend > Trend clear
Settings Description

On Clears the displayed waveform when the memory sampling is started.

Off Does not clear the waveform when the memory sampling is started.

* Trend > Message direction
Set the display direction of messages to Horizontal or Vertical. When the trend is set
to Vertical, the message direction is fixed to Horizontal.

e Trend > Trend line
Set the line width of the trend in dots (1 to 3).

e Trend > Grid
Select the number of grids to be displayed in the waveform display area of the trend

display.

Settings Description

41012 Displays a grid that divides the display width into 4 to 12 sections.

Auto Displays the same number of grids as the number of scale divisions of the first

assigned channel of the group.
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5.11 Changing the Bar Graph Display Method

Setup Screen

Change the bar graph display method.
For a description of the function, see section 1.3.

* Display Direction
Press MENU (switch to the setting mode) and select Display > Bar graph
onr 1810 10:19:1p W= IEZT(O) 0}

Bar araph

Direction Vertical

(Horizon Mertical

* Base Position and the Number of Scale Divisions
Press MENU (switch to the setting mode) and select Meas channel > Bar graph

P 1 =
/10 10:10:10 00 IEETN(O) 0}
First-CcH: 1 Last-CH: 1
Bar araph
Baze position m
Divizion 1@

Center

¢ Bar graph > Direction
Set the display direction of bar graphs to Horizontal or Vertical.

¢ First-CH, Last-CH

Set the target channels. The target channels are common with the other items that are

displayed on the screen.

e Bar graph > Base position
Set the base position of bar graphs to Normal, Center, Lower,* or Upper.*

The setting is applied when displaying the bar graph and when displaying the current

value on the scale using the bar graph.
* You can select Lower and Upper on DXs with release number 2.
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5.11 Changing the Bar Graph Display Method

When the Display Direction of the Bar Graph Is Vertical
* Normal
Value at the bottom of the bar graph: Span lower limit or span upper limit (or scale
lower limit or scale upper limit), whichever is less
Value at the top of the bar graph: Span lower limit or span upper limit (or scale lower
limit or scale upper limit), whichever is greater
Starting point of the bar: Bottom edge
+ Center
Value at the bottom of the bar graph: Same as with Normal.
Value at the top of the bar graph: Same as with Normal.
Starting point of the bar: Center
* Lower
Value at the bottom of the bar graph: Span lower limit (or scale lower limit)
Value at the top of the bar graph: Span upper limit (or scale upper limit)
Starting point of the bar: Bottom edge
» Upper
Value at the bottom of the bar graph: Same as with Lower.
Value at the top of the bar graph: Same as with Lower.
Starting point of the bar: Top edge
Normal Center Lower Upper

\Nn \(Nn Vupper_ Vupper <

I(-

VS ‘ VS - VIower " VIower

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)

VL: Vlower or Vupper, whichever is greater
VS: Vlower or Vupper, whichever is less
< Starting point of the bar

Example: When the span lower and upper limits of the input
range are 0.0 and —100.0, respectively

Normal Center Lower Upper
0.0 0.017 1000u 1OOOH
-100.0 -100.0U 0.0 0.0
o /
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5.11 Changing the Bar Graph Display Method

When the Display Direction of the Bar Graph Is Horizontal
The span lower limit (or scale lower limit) becomes the left edge of the bar graph, and the

span upper limit (or scale upper limit) becomes the right edge of the bar graph.
» Starting point of the bar

Normal: Left edge or right edge, whichever is less

Center: Center

Lower: Left edge

Upper: Right edge

Normal Lower
Viower (Viower < Vupper) VUPPef Viower Vupper
[ F ]
A
(Vlower > Vupper) i
A
Center Upper
Viower Vupper Viower Vupper
[ I ] (——
A A

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)
Starting point of the bar

/Example: When the span lower and upper limits of the input\
range are 0.0 and —100.0, respectively

0.0 —-100.0
Normal C———

0.0 -100.0
Center [ N 1

0.0 -100.0
Lower HEEEN ]

0.0 —100.0
| — ]
\_ Upper Y,

When Displaying the Current Value on the Scale Using the Bar Graph

Normal Center Lower Upper Viower v, <V ) Vupper

! lower upper !

Vupper' """" 1 """ 1" """~ < ]

Normal : (Vlower>Vupper) E

s b

I‘l Center | _‘ ]

Lower —I |:

L@ :

V. B . A S :
lower" < < Upper I:_‘

e Bar graph > Division
Select the number of main scale marks from 4 to 12.
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5.12 Changing the Background Color of the Display

Change the background color of the display. This setting is applied to the operation
screens.

Setup Screen

Press MENU (switch to the setting mode) and select Display > Monitor

[ = .
10 10:10:10 00" Y () +13}

Honi tor
Backaround
Display IIHHIEHII
Historical trend Black
Scroll time 18z
Jump default displav Ooff
[ ithite | Black |

* Monitor > Background > Display
Set the background color of the operation screen to White (default setting) or Black.

* Monitor > Background > Historical trend
Select the background color of the historical trend display from the following:
Settings: White, Black (default setting), Cream, and Lightgray
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5.13 Automatically Switching Display Groups

Automatically switch the displayed group at a specified interval.

Setup Screen

Press MENU (switch to the setting mode) and select Display > Monitor

P 1 r="—
b0 1.10:10 0= IEEEYE (O] 0}

Honi tor
Backaround
Dizsplay White
Historical trend Black
Scroll time 18=

Jump default displav Ooff

L5 | ios | 20s | 30= [ lnin_|

¢ Monitor > Scroll time
Set the switching interval from the available settings between 5 s and 1 min. The
groups switch in ascending order.
Select whether to automatically switch on the operation display.
See section 4.2
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5.14 Automatically Reverting to the Specified
Display

Show a preset display when there is no operation for a specific time.
Setup Screen

Press MENU (switch to the setting mode) and select Display > Monitor

0P 1 r="—
b0 1.10:10 0= IEEEYE (O] 0}

Honi tor
Backaround
Dizsplay White
Historical trend Black
Scroll time 18z

Jump default display

[ off | lnin | Znin_| Snin_|

* Monitor > Jump default display
Returns to a preset display if there is no key operation for a specific time.

Settings Description

1minto 1h  Time until switching the display.
Off Disables the function.

Procedure

» Specifying the Display to be Shown
1. Show the operation display you want to designate.

2. In the operation mode, press FUNC.
The FUNC key menu appears.

3. Press the Standard display soft key.
The display is registered.
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5.15 Registering the Favorite Display

Register a frequently used display to the Favorite key and enable the display to be
shown through simple operation.

oo

\
Favorite key

Procedure

* Registering the Display
Up to 8 displays can be registered.
1. In the operation mode, show the display you want to register.

2. Press FUNC.
The FUNC key menu appears.

3. Press the Favorite regist soft key. Then, press a registration number soft key.

4. Press the Regist soft key.
A window appears for you to enter the display name.
* To delete a registration, press the Delete soft key.

5. Enter the display name (using up to 16 characters, [Ala#[1]).

6. Select ENT and press DISP/ENTER.
The display is registered.

» Switching the Display
The display switches in the registration order each time you press the Favorite key.
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5.16 Writing a Message When the DX Recovers
from a Power Failure

A message is written to the trend display when the DX recovers from a power failure
while memory sampling is in progress.

Setup Screen

* Power-fail message
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > View, Message

hEt

View
Trend tupe T-%
Partial 0ff
Trend rate switching Ooff
Hesszage
Write aroup Common
Power-fail message “
Change message Ooff
L 00 | off |

¢ Message > Power-fail message
Settings Description

On A message is written when the DX recovers from a power failure while memory
sampling is in progress.
Display example: 15:12 Power Off 2005/10/25 15:12:57

Off Disables the function.
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5.17

Changing the FUNC Key Menu and Display
Selection Menu

Change the FUNC key menu that appears when the FUNC key is pressed and the
display selection menu that appears when the DISP/ENTER key is pressed.

Setup Screen

e FUNC Key Menu
Press MENU (switch to the setting mode) and select Menu customize > Function

menu

Number indicating
the display order

Menu name
White: Used
Gray: Not used

* Display Menu
Press MENU (switch to the setting mode) and select Menu customize > Display
menu

==
/10 101010 0= IEET(S) +13}

Separator

5 A

w2
GO e
UILL

LLL

IR

* Enabling/Disabling the FUNC Key Menu
Items whose menu name is white are shown.

1. Press the arrow keys to select a menu item.

2. Press the View or Hide soft key.
If you press the Hide soft key, the menu name is displayed in gray, and does not appear in
the FUNC key menu.

¢ Changing the Display Order of the FUNC Key Menu
Menu items are displayed in order by number. In addition, menu items appear when
the corresponding function can be used.

1. Press the arrow keys to select a menu item.

2. Press the Select soft key.
The menu item is enclosed in a red frame.

3. Press the arrow keys to select the destination.

4. Press the Transfer soft key.
The menu item moves to the selected number position.
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5.17 Changing the FUNC Key Menu and Display Selection Menu

¢ Description of the FUNC Key Menus
For a description of each item, see the respective section.

Hedia

& eject

Sec. 3.8 Sec. 5.4 Sec. 5.4 Sec. 6.4 Sec. 6.6
Sec. 2.12

an
sanple d i

Sec. 6.5 Sec. 6.4 Sec. 6.4 Sec. 6.4 Sec. 4.8

Timer
reset

Text
field

* Communication Interface

Comm* Comm* Comm* User’s Manual.

¢ Enabling/Disabling the Display Selection Menu and Sub Menu
Iltems whose menu name is white are shown.

1.
2.

Press the arrow keys to select a menu item.

Press the View or Hide soft key.
If you press the Hide soft key, the menu name is displayed in gray, and does not appear in
the display selection menu.

* Changing the Display Selection Menu/Sub Menu Positions

1.
2.

Press the arrow keys to select a menu item.

Press the Select soft key.
The menu item is enclosed in a red frame.

Press the arrow keys to select the destination.

Press the Transfer soft key.
The menu item moves to the selected position.

¢ Showing/Hiding Separators

1.
2.

Press the arrow keys to select a menu item.

Press the Separate soft key.

A separator (line) is displayed between the current item and the lower item.

If you select a menu item whose separator is already shown, this operation hides the
separator.

You can set up to three separators in the display selection menu and each sub menu.
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5.17 Changing the FUNC Key Menu and Display Selection Menu

¢ Description of the Display Selection Menus and Sub Menus
ltems with asterisk (*) are set to Hide by default.

Display Selection Menu  Sub Menu Reference Section
TREND GROUP 1 to GROUP 10 Section 4.2
ALL CHANNEL/GROUP CHANNEL Section 4.2
SCALE ON/OFF Section 4.2
DIGITAL OFF/ON Section 4.2
MESSAGE DISP2/1 Section 4.2
TREND SPACE ON/OFF Section 4.2
AUTO SCROLL ON/OFF Section 4.2
TREND HISTORY GROUP 1 to GROUP 10 Section 4.3
DIGITAL GROUP 1 to GROUP 10 Section 4.2
AUTO SCROLL ON/OFF Section 4.2
BAR GROUP 1 to GROUP 10 Section 4.2
AUTO SCROLL ON/OFF Section 4.2
OVERVIEW CURSOR OFF/ON Section 4.4
JUMP TO ALM SUM Section 4.4
JUMP TO TREND Section 4.4
JUMP TO DIGITAL Section 4.4
JUMP TO BAR Section 4.4
INFORMATION ALARM SUMMARY Section 4.5
MESSAGE SUMMARY Section 4.5
MEMORY SUMMARY Section 4.5
MODBUS CLIENT Section 4.5
MODBUS MASTER Section 4.5
RELAY Section 4.5
REPORT DATA Section 4.5
TO HISTORY Sections 4.6, 4.7, and 4.8
TO HISTORY(DISP) Sections 4.6, 4.7, and 4.8
TO HISTORY(EV) Sections 4.6, 4.7, and 4.8
TO OVERVIEW Section 4.6
CHANGE SORT KEY Sections 4.6 and 4.7
ASCENDING ORDER/ Sections 4.6 and 4.7
DESCENDING ORDER
SELECT SAVE' Section 4.8
M.SAMPLE SAVE Section 4.8
REPORT SAVE Section 4.8
ALL SAVE' Section 4.8
CHANGE DISP ITEM Section 4.7
CHANGE DATA KIND Section 4.8
FILENAME DISPLAY/TIME DISPLAY Section 4.8
CHANGE REPORT CH Section 4.5
* Log LOGIN Section 4.9
ERROR Section 4.9
COMMUNICATION Section 4.9
FTP Section 4.9
MAIL Section 4.9
WEB Section 4.9
SNTP Section 4.9
DHCP Section 4.9
MODBUS Section 4.9

1: The default setting is Hide on DXs before release number 2.
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Chapter 6 Saving and Loading Data

6.1 Setting the Recording Conditions of the
Measured Data

Set the method for recording the measured data.
For a description of the function, see section 1.4.

Setup Screen

e Data Type
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select A/D, Memory

Scan interval

Scan mode Hormal
Scan interval 125ms

A/D intearate Auto

Hemory

Data kind Dizsplay

¢ Measurement Channels
Press MENU (switch to the setting mode) and select Meas channel > Tag, Memory,

Delay

==
210 10:10:10 B0 HEETE(D) +13}
irst-CH: 1 Last-CH: 1

Tag

Characters

Hemory sample

On/Off | on |
Alarm delay

Time 18 =

L 00 | off |

¢ File Save Interval (Display Data)
Press MENU (switch to the setting mode) and select Display > Trend/Save interval

U . -] TP
/10 10:10:10 00 IEETN(O) 0}
Trend / Save interval

Trend interval [Adiv] Imin

Save interval 1h

Second interval [Adiv] Imin

[ 16nin | 28nin | 38nin | _lh__|
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Setting the Recording Conditions of the Measured Data

¢ Recording Conditions of Event Data
Press MENU (switch to the setting mode) and select Data save > Event data

==
/10 101010 E0= =S 0}

Event data

Sample rate
Hode SingleTriager
Data lenath 1h
Pre-trigaer @ ¥
Trigger =ignal

ey 0n

125ms 258ms B@Ams

* Memory > Data kind

Settings Description

Display Records display data.

E+D Records display data and event data.
Event Records event data.

* Memory sample > On/Off
Turn On the target channels.

* Trend/Save interval > Save interval
Select the size of a record data file. The recorded data is divided by the file size
specified here. The available settings vary depending on the Trend interval setting.

Trend interval 15 s* 30s 1 min 2 min 5 min
Selectable range of |10 min to 10 min to 10 min to 10 min to 10 min to
auto save interval 3 days 7 days 14 days 14 days 31 days
Trend interval 10 min 15 min 20 min 30 min 1h
Selectable range of (10 minto {10 min to 1 hour to 1 hour to 1 hour to
auto save interval 31 days 31 days 31 days 31 days 31 days
Trend interval 2h 4 h 10 h

Selectable range of |2 hoursto |4 hoursto |8 hours to

auto save interval 31 days 31 days 31 days

* Selectable on the DX1002, DX1002N, DX1004, and DX1004N.

¢ Trend/Save interval > Second interval [/div]
See section 5.3.

* Event data (when recording event data)

¢ Sample rate
Select the data recording interval.

* Mode

Settings Description

Free Records data continuously.

Single Records data when the trigger condition is met.
Repeat Records data each time the trigger condition is met.
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6.1 Setting the Recording Conditions of the Measured Data

e Data length
Select the size of a record data file. The recorded data is divided by the file size
specified here. The available data lengths vary depending on the Sample rate

setting.
Sample rate 25 ms* 25 ms 250 ms 500 ms 1s
Selectable range (10 min to 10 min to 10 min to 10 min to 10 min to
of data length 4 hours 1 day 2 days 3 days 7 days
Sample rate 2s 5s 10s 30s 1 min
Selectable range (10 min to 10 min to 10 min to 1 hour to 1 hour to
of data length 14 days 31 days 31 days 31 days 31 days
Sample rate 2 min 5 min 10 min
Selectable range (1 hour to 1 hour to 1 hour to
of data length 31 days 31 days 31 days

* Selectable on the DX1002, DX1002N, DX1004, and DX1004N.

* Pre-trigger
Specify the range when recording data before the trigger condition is met. Select
the range as a percentage of the data length from 0, 5, 25, 50, 75, 95, and 100%.
If you do not want to record the data existing before the trigger condition is met,
select 0%.
e Trigger signal > Key
Select On if you want to activate the trigger using key operation.

Nofte
« Triggers can be applied using event action (see section 7.1).
< If the trigger condition is already met when you press START, recording starts.
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6.2 Setting the Method for Saving the Data

Set the method for recording the measured data to the storage medium.
For a description of the function, see section 1.4.

Setup Screen

* Auto save
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > Security, Media save

Basic Setting Hode

Security

ey 0ff

Communication Ooff

Save

Auto save | on |

Hedia FIFO Off
T

¢ File header, Data file name
Press MENU (switch to the setting mode) and select Data save > File header, File
name

1510 10:10:10 A== (O) +13}

File header

Characters

Data file name

Structure Date

Identified strinas

[ Ireut | |

e Save directory
Press MENU (switch to the setting mode) and select Data save > Save directory

1310 10:10: 10 == (O) 0}

Save directory

Directory name

[ Toput || Clear
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6.2 Setting the Method for Saving the Data

Save > Auto save

Settings Description

On Automatically saves the measured data to the CF card. Specify On to
enable the media FIFO function.

Off Does not automatically save the data. Save the measured data manually to

the CF card or USB flash memory (/USB1 option).

Save > Media FIFO (Release Number 2 or Later)
This item appears if Auto save is set to On.

Settings Description

On Enable media FIFO. Constantly retains the most recent data files in the CF
card.

Off Disable media FIFO. Replace the CF card if the free space on the CF card
drops low.

File header > Characters
Set the header comment to be written to the data file. (Up to 50 characters, [Ala]#[1])

Data file name > Structure
Sets the structure of the file name when saving data.

Settings Description

Date Serial number + user-assigned character string + date

Serial Serial number + user-assigned character string

Batch Serial number + batch name (when using the batch function)

Data file name > Identified strings

Set the user-assigned section of the file name. (Up to 16 characters, [Alaj#[1])
Symbols that can be used: #, %, (, ), +, -, ., @, °, and _

For details on the data file name, see section 1.4.

Save directory > Directory name
Set the name of the directory on the storage medium for saving the data on the

external storage medium. (Up to 20 characters, [Alaf#[1])

Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.

Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and
LPT1 to LPTO.

IM 04L41B01-01E
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6.3 Using the Batch Function

Setup Screen

Set the batch function.
For a description of the function, see section 1.5.

* Batch Function
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > Batch

Batch
On/0ff | on |
Lot-No. digit E

Auto increment 0n

[ on | 0ff |

¢ Data file name
Press MENU (switch to the setting mode) and select Data save > File header, File

name

1 [T
ot 0010 0 IEETE(Q)

File header

Characters

Data file name

Structure

Serial

e Text Field
Press MENU (switch to the setting mode) and select Data save > Batch text

11/
Text field number 1

Title of field [
Characters
[ Tnput ||
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6.3 Using the Batch Function

Procedure

Batch > On/Off
Select On to use the batch function.

Batch > Lot-No. digit
Select the number of digits of the lot number from 4, 6, or 8. Select Off to disable the

lot number.

Batch > Auto increment

Settings Description

On Automatically sets the lot number of the next measurement to “the lot number of
the current measurement + 1.”

Off Disables the operation described above.

Data file name > Structure
Batch: Sets the name of the display data files or event data files to “batch name.”
For details on the data file name, see section 1.4.

Text field number
Select a number from 1 to 8.

Text field > Title of field or Characters
Set the string.
Title of field: (Up to 20 characters, [Ala#[1]), Characters: (Up to 30 characters, [Alal#]1])

Setting the Batch name and Comment

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Batch soft key.
A window appears for you to enter the batch name and comment.

3. Set the batch number. (Up to 32 characters, [Alaf#]1])
Symbols that can be used: #, %, (, ), +,-, ., @, °, and _.

If you are using the lot number, set the lot number.
4. Setbatch comments 1, 2, and 3. (Up to 50 characters each, [Ala#]1])
5. Press DISP/ENTER.

Nofte

* Batch numbers and lot numbers cannot be changed after memory start.

* You can change the comment as many times as you wish before executing memory start.
After memory start, only the comments that are not specified can be entered. You can
change the comment as many times as you wish while the window for setting the comment
is displayed. The last specified comment is valid.

* The comment is cleared when memory stop is executed.

* The batch number, lot number, and comments are saved to the display data file or event
data file. They are not saved to the setup file.

¢ Displaying the Text Field Settings

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Text field soft key.
The text field settings are displayed.

IM 04L41B01-01E
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6.4 Starting/Stopping the Recording and Saving
the Measured data

Procedure

Start the recording and save the measured data to the external storage medium.
For a description of the function, see section 1.4.

e Starting the Recording (Memory Start)

Press START. The internal memory icon in the status display section changes from

the stop icon to memory sampling icon.

* When recording display data or event data in free mode, recording starts.

* When recording event data in trigger mode, the DX enters the trigger-wait
condition.

Applying a Trigger to Start the Recording

Carry out the procedure below when the DX is waiting for a trigger.

Trigger through Key Operation

The procedure below can be carried out when recording event data in trigger mode
and the DX is configured so that the start trigger is applied through key operation.

1. Press FUNC.
The FUNC key menu appears.

2. Press the Trigger soft key.
The recording starts.

Trigger by an Event (Event action function must be configured. See

section 7.1.)
Recording starts when an event occurs.

Automatically Saving Measured Data
The save destination is the CF card.

Have the CF card inserted in the slot at all times. While the memory sampling is in
progress, the measured data recorded in the internal memory is automatically saved
to the CF card.

Action when Media FIFO is not enabled: If data storage to the storage medium is not
complete such as due to insufficient free space, the unsaved data is saved the next
time the data is automatically saved.

Saving the Display Data or Event Data during Memory Sampling through

Key Operation

The save destination is the CF card.

This operation can be carried out when recording display data or when recording

event data in Free mode. Unsaved measured data is saved to the CF card.

* If this operation is carried out when auto save is Off, the data in the internal memory is
divided, and a file is created.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Save display or Save event soft key.
The display data or event data is saved to the CF card.
Save operation

/ /\t/\ﬁ Jime

I I I I v

File File File
Saved the previous time [ Saved this time ]
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6.4 Starting the Recording and Saving the Measured data

¢ Saving Measured Data Manually (Collectively Stroring Unsaved Data)

The
For

1.

No

save destination is the CF card or USB flash memory (/USB1 option).
the procedure to save data to the USB flash memory, see section 2.12.
Insert the storage medium.

A confirmation window containing the message “There is data which is not saved to media.
Do you want to store to media?” appears.

Select Yes and press DISP/ENTER.
Unsaved data in the internal memory is saved to the storage medium.

Carry out the procedure below to remove the storage medium.
Press FUNC (display the FUNC key menu) > Media eject soft key > CF soft key
When the message “Media can be removed safely” appears, remove the storage medium.

le

If there is not enough free space on the storage medium, the message “Not enough free
space on media” appears, and the data is not saved. If this message appears, replace the
storage medium. Then, carry out the procedure again.

You cannot abort the data save operation while it is in progress.

¢ Stopping the Recording (Memory Stop)

1.

Press STOP. A confirmation window is displayed.

P 1 [:-IEF' m@ ol))

A/18 16:18: 168

Lnindiv
16: 16 : :
i\
164
. Yes Mo
i
L -B.6411 -3.49751 -3.4135‘ -B. 3063
] v v v
H H

Select Yes using the arrow keys and press DISP/ENTER.

On models with the computation function (/M1 or /PM1 option), select Mem+Math or
Memory, and press DISP/ENTER.

The internal memory icon in the status display section changes to the stop icon.

¢ Saving the Data in the Internal Memory Collectively or Selectively
through Key Operation

See

section 4.8.

IM 04L41B01-01E
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6.4 Starting the Recording and Saving the Measured data

Explanation

e Operations That Start Simultaneously with Memory Start
» Waveform display updating on the trend display.
* Report (/M1 and /PM1 options)
» The computation function (/M1 and /PM1 options) can be configured to start
simultaneously with memory start.
See section 9.4.

¢ Operations That Stop Simultaneously with Memory Stop
» Waveform display updating on the trend display.
* Report (/M1 and /PM1 options)
» Computation function (/M1 and /PM1 options): When selected in the procedure
described above.

* Performance While Data Is Being Saved
If the internal memory or external storage medium is continuously accessed, the

following phenomena may occur. When such phenomena occur, the storage medium

access indicator frequently illuminates.

» Files being saved to the external storage medium drop out.

* Accessing the DX through communications takes a long time

In such case, take the following measures.

+ If you are creating data files at short intervals consecutively using the event action
function, increase the data file save interval.

« If you are creating numerous files in a single directory on the external storage
medium, change the destination directory name at approximately every 1000 files.
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6.5

Manually Saving the Measured Data (Manual
Sample)

Save the instantaneous values of all channels (excluding those set to Skip or Off)

through key operation.
For a description of the function, see section 1.4.

Procedure

1. In the operation mode, press FUNC.
The FUNC key menu appears.

Manual sampling is executed.

2. Press the Manual sample soft key.

Explanation

* Number of Manual Sampled Data Set in the Internal Memory
The number of manual sampled data set in the internal memory is displayed on the
memory summary display (see section 1.9)

¢ Saving Measured Data to the CF Card
» If auto save is On, the manual sampled data is saved to the CF card when you

carry out manual sampling.

» If auto save is Off, save the manual sampled data to the CF card according to the
procedure for manually saving the data (see section 6.4).

» The manual sampled data can be saved manually to a CF card or USB flash
memory (/USB1 option) regardless of whether the auto save function is set to On/
Off. For the manual save operation, see section 4.8.
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6.6 Saving the Screen Image Data (Snapshot)

Save the current screen image data to the CF card. This operation is called snapshot,
and the screen image data file is called snapshot data file.
For a description of the function, see section 1.4.

Procedure

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Snap shot soft key.
The snapshot data file is saved to the CF card.
Image of the soft keys and the message window are not saved.

Nofte

If you assign the snapshot function to the USER key, you can carry out snapshots in all modes
(operation mode, setting mode, and basic setting mode). However, error messages are not

saved.

Explanation

* File Format and Size
The snapshot data file is in PNG format.
The maximum size of a snapshot data file is approximately 15 KB.

¢ File Name
See section 1.4.
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6.7 Managing the Files on the Storage Medium

Procedure

This section explains how to display a list of files on the storage medium, check the free
space, delete files and directories, and format the storage medium.

* Displaying a List of Files on the Storage Medium, Deleting Files, and

Checking the Free Space

Carry out the procedure below to show the display.

Press MENU (switch to the setting mode); select Save/Load > File list, delete; press
the CF or USB soft key*; and press DISP/ENTER.

* When a CF card and a USB flash memory (/USB1 option) are being used.

File list/delete

fF:/

Directory name Date / Time

DATHE 65781412 2@:59

DATAL B7/83/14 16:57
DATAZ B7/83/15 15:88
DATAA_B7AZ222_132823 B7/82/22 13:28
DATHA_BT7A222_182687 B7/82/23 @9:53

Free space 4d4@352 Kbutes
Sart

Displaying a List of Files in a Directory and Checking the Free Space
Press the arrow keys to select a directory, and press DISP/ENTER. The files in the
directory are displayed. The root directory is denoted by [/].

File name

HPLEASAL12 BE/81/12
_SAHPLEASAL12 . . B5/81/12
A 193_SAHPLEASAL 12 21834 . DAD BE/a1A12 21019
Baa193_SAHPLEASAL 12 211944 . DAD BE/E1A12 21:29
paa2aa_SAHPLEASAL 12 21234 . DAD BE/81A12 21:39
paa2a1_SAHPLEASAL 12 213344 . DAD BE/81/12 21:49
Baa2A2_SAHPLEASAL 12 214344 . DAD BE/81/12 21:69

paaE36_SAHPLEASA] 12_228R88H_ . DAR 65781713 @3:12

Free space dd@328 Kbutes
|« [ | Gort

Sorting Files and Directories (Release Number 2 or Later)

The files and directories can be sorted by the update date/time.

Each time you press the Sort soft key, the files and directories are sorted in order from
the oldest or the latest update date/time. A mark indicating the sort order is displayed
by Date/Time.

If the File Name Does Not Fit in the Display Space (Release Number 2 or Later)
Press the [> soft key once to shift the file name to the left by a character.
Press the <] soft key once to shift the file name to the right by a character.

Deleting a File
Press the arrow keys to select the file to be deleted, and press the Delete soft key. A

confirmation window appears. Select Yes, and press DISP/ENTER.
The file is deleted.

Deleting a Directory
First, delete all the files in the directory.

Select the directory you want to delete. The rest of the procedure is the same as
deleting a file.

IM 04L41B01-01E
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6.7 Managing the Files on the Storage Medium

Explanation

Checking the Free Space
The free space on the storage medium is shown at the lower right of the screen.

Formatting the Storage Medium

1. Carry out the procedure below to show the display.
Press MENU (switch to the setting mode); select Save/Load > Format; press the
CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.
oo 16/15 10: 1015 bade-= I (O) 0}
Format
Yolume name _
2. Enter the volume name and press DISP/ENTER. (Up to 11 characters, [A[1])
A confirmation window opens.
3. Select Yes and press DISP/ENTER.
The storage media is formatted.
Format Type
Size Type

Storage medium smaller than or equal to 512 MB ~ FAT16

Storage medium greater than 512 MB FAT32

6-14
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6.8 Loading and Displaying the Measured Data in
the Storage Medium

Load the display or event data file saved on the external storage medium and display the

waveform. The loaded data is shown on the historical trend display.
For the operations on the historical trend display, see section 4.3.

Procedure

* Loading a File

1. Carry out the procedure below to show the display.
Press MENU (switch to the setting mode); select Save/Load > Load display data
or Load event data; press the CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.
Directory name Date / Time
bﬁTﬁB B5/@1/12 2@8:59
DATAL H7/83/1d 16:57
DATAZ H7/83/15 15:88
DATA H7/B3/28 28:89
DATAB_BTA222_132629 W7/B2/22 13:28
DATAB_BTA222_182687 W7/B2/23 B8:53
Free zpace dd@3dd Kbutes
Sort
2. Press the arrow keys to select a directory, and press DISP/ENTER. The files in
the directory are displayed. The root directory is denoted by [/].
3. Press the arrow keys to select a file, and press DISP/ENTER.
The file is loaded, and the waveform is displayed in the historical trend.
.Load dizsplay Aata
kF:/patals
AA19 5 5
pEE198_SAHPLEASE112_ 21344 . DAD B5/B1/12 21:18
pEE199_SAHPLEASE112_ 211944 . DAD B5/B1/12 21:29
peB2aE_SAHPLEASE112_ 212344 . DAD B5/B1/12 21:39
peB2a1_SAHPLEASE112_ 213344 . DAD B5/B1/12 21:49
peB262_SAHPLEASE112_ 214944 . DAD B5/@1/12 21:59
peB2E3_SAHPLEASE112_ 215344 . DAD B5/B1/12 22:89
peB26d_SAHPLEASE112_ 226344 . DAD B5/B1/12 22:18
Free zpace ddA288 Kbutes
Sort
Nofte

The display data extension is .dad; the event data extension is .dae.UM-6-15-1

+  For details on how to use the Sort, >, and <] keys, see section 6.7.
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6.9 Saving/Loading the Setup Data

Save the setup data to the external storage medium or load the setup data from the
external storage medium.

Procedure

* Saving the Setup Data
1. Carry out the procedure below to show the display.

Press MENU (switch to the setting mode); select Save/Load > Save settings;
press the CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

1
18710 10:10:10 eI (S 0}

Save settings

File name

cF:/ [—

2. Set the file name. (Up to 32 characters, [Ala]#[1])
Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to
LPTO9.
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is saved.

¢ Loading the Setup Data for the Setting Mode

1. Carry out the procedure below to show the display.

Press MENU (switch to the setting mode); select Save/Load > Load settings;
press the CF or USB soft key; and press DISP/ENTER.

1111.POL A7/83/13 83:87

PaAAaea . POL A7/83/23 B3:53
Free space dd4@256 Kbutes

L [ | Sort |

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is loaded.

Note

For details on how to use the Sort, D and 4 keys, see section 6.7.
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6.9 Saving/Loading the Setup Data

¢ Loading the Setup Data for the Setting Mode and Basic Setting Mode
1. Carry out the procedure below to show the display.
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode); select Load settings, Initialize > Load settings; press the

CF or USB soft key*; and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

Load settings

fF:/

File name

@RaE. PDL

1111.POL
BAARAEE, POL B7/83/23 89:53

Free space 448192 Kbutes

L] Sort |

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is loaded.

Nofte

For details on how to use the Sort, D and <] keys, see section 6.7.

Explanation

¢ Setup Data File
* The extension is .PDL.

+ The maximum size of a single setup data file is approximately 150 KB.
» The following settings are also saved.

» Current monitor display conditions

» Monitor auto recovery registration data

» Favorite key registration data

* Loading Setup Data

* Only the setup data of the setting mode is loaded in the setting mode. However,
settings that contradict the setup data of the basic setting mode are not loaded.

» The monitor display conditions, monitor auto recovery registration, and favorite key
registration are also loaded.

+ If the contents of the loaded setup data is invalid, check the error log (see section
4.9).

» Operations through keys, communications, and remote control input are not
executed while the setup data is being loaded.

IM 04L41B01-01E 6-17

ejeq Buipeo pue Buireg =



Chapter 7  Customizing the Action (Event Action)

7.1 Setting the Event Action Function (Including
Remote Control (/R1 Option) and USER Key)

A specified action is carried out when an event occurs. This function is called event
action. The remote control function (/R1 option) and the USER key are set by the event
action.

For a description of the function, see section 1.6.

Setup Screen

* Event and Action
Press MENU (switch to the setting mode) and select Timer, Event action > Event

action

P 1
3/16 10:10: 18

Ece I (S) )

Logic box number “
Event Remote
Remote number 1
Action DizplaviroupChanae
Group number 1
2 [ 3 | 4 ]
e Timer
Press MENU (switch to the setting mode) and select Timer, Event action > Timer

* When set to relaive time * When set to absolute time
Tk §or T (O) 2]

[ =
b0 1.10:10 0= IEEEYE (O] 0}

3/18 14@:1@:1A
Timer Mo. Timer Mo.
Hode Relative Hode Absolute
Interval B1:88 Interval 1h
Reset at Hath Start 0n Ref.time A 84
1 20 | 1 20 |

e Match Time
Press MENU (switch to the setting mode) and select Timer, Event action > Match

time timer
P 1 [T
110 10:10:10_ 00 V(D) 0}
Timer number
Kind Hanth
Daw 1
Hour:iHinute e aa
Timer action Repeat
1 20 |

(uonoy jusang) uondy ayj buiziwolysny H
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7.1 Setting the Event Action Function (Including Remote Control (/R1 Option) and USER Key)

* Logic box number
You can set up to 40.

¢ Event action > Event
The condition to execute the action.

Settings Description

None Not use.

Remote Select the remote control input terminal number.
Relay Select the alarm output relay number.

Switch Select the internal switch number.

Timer Select the timer number.

Match T Select the match timer number.

Alarm -

UserKey -

¢ Event action > Action
The action to be executed when an event occurs.

Settings Description

Memory -

Start -

Stop -

Trigger Can be specified when the DX is configured to record event data.

AlarmACK Cannot be specified when the event is set to Relay, Switch, or Alarm.

Math Can be specified on /M1 and /PM1 options.

MathStrt Can be specified on /M1 and /PM1 options.

MathStop Can be specified on /M1 and /PM1 options.

Math rst Can be specified on /M1 and /PM1 options.

SaveDisp Can be specified when the DX is configured to record display data.

SaveEvt Can be specified when the DX is configured to record event data.

Message Set the message number to write the message and the destination. Set the
message destination to all groups (All) or a group number.

Snap -

Rate1/2 Can be specified when the function for switching between the trend interval
and the secondary trend interval is enabled.

M.sample -

TimerRst Cannot be specified when the event is set to Timer.

Group Specify the number of the group to be displayed.

Flag Can be specified on /M1 and /PM1 options.

Time adj Can be specified only when the event is set to Remote.

PnlLoad Can be specified only when the event is set to Remote.
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7.1 Setting the Event Action Function (Including Remote Control (/R1 Option) and USER Key)

Timer
Timer used by event action. Used also in the TLOG computation of the computation
function.
* The timer cannot be changed while memory sampling or computation is in progress.
¢ Timer No.
Up to four timers (1 to 4) can be set.
When Using an Absolute Timer
* Mode
Select Absolute.

* Interval
Select the interval from the available settings between 1min to 24h.

¢ Ref.time
Set the time in the range of hour 0 to hour 23.

When Using a Relative Timer
* Mode
Select Relative.

¢ Interval
Set the interval in the range of 00:01 (1 min) to 24:00 (24 hours).

* Reset at Math Start
On: Resets the timer when computation is started. The resetting of the timer is not
considered to be a timeout. Even if the timer is used as an event, the action is not
executed.

Match Time Timer
Set the time match condition used in event action.
* The condition cannot be changed while memory sampling or computation is in progress.
¢ Timer number
You can set up to four match time conditions (1 to 4).

¢ Kind

Settings Description

Day Set the time match condition of a day.
Week Set the time match condition of a week.
Month Set the time match condition of a month.

Set the items with check marks in the following table depending on the Kind setting.

Setup It Kind
etup ftem Day Week Month
Day v
Day of week v
Hour:Minute v v v
e Day
Set the day.
* Day of the week
Set the day of the week.
* Hour:Minute
Set the time in the range of 00:00 to 23:59.
e Timer action
Settings Description
Single Executes the action once when the condition is met.
Repeat Executes the action at every specified time.

IM 04L41B01-01E
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7.1 Setting the Event Action Function (Including Remote Control (/R1 Option) and USER Key)

Procedure

* Resetting the Relative Timer
1. In the operation mode, press FUNC.
The FUNC key menu appears.
2. Press the Timer reset soft key.

3. Press the soft key corresponding to timer you want to reset. Select All to reset all
timers.
The relative timer is reset.

Explanation

* Resetting the Relative Timer
Restarts the timer.
* The resetting of the timer is considered to be a timeout. (If the timer is used as an
event, the action is executed.)
 |If the timer is used in TLOG computation on the /M1 or /PM1 math option and
mathreset is specified, the computed result is reset.
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7.2 Setup Examples of Event Action

Example 1: Starting/Stopping the Memory Sampling through Remote Control
(/R1 Option)

Starts/Stops the memory sampling when a signal is applied to remote control input
terminal 2. Use logic box number 1.

e Setup Screen and Setup ltems
Press MENU (switch to the setting mode) and select Timer, Event action > Event

action

WP 1 =

/10 10:10:10 00 IEETN(O) 0}
Logic box number
Event Remote
Remote number 2

Action HemorwStarts/Stop

4l 2 [ 3 | 4 |

<Operation>

If the input to the remote control input terminal 2 is turned ON when memory sampling
is stopped, memory sampling starts. If the remote control input is turned OFF when
memory sampling is in progress, memory sampling stops.

Example 2: Writing a Message When an Alarm Occurs
Write the message “Channel 1 Alarm” to group 1 when an alarm occurs on channel 1.

Use logic box number 2.

e Setup Screen and Setup Items
Press MENU (switch to the setting mode) and select Timer, Event action > Event
action

1 == T
G 1010 16:10:10 0 IEZET(S) 0}
Logic box number “

Event Switch
Switch MNo. SA3
Action Heszage
Heszage MNo. q
Write to Select
Group number 1

1 2 e |

<Other Settings>

» Set an alarm to channel 1 and output to internal switch 3.
» Register “Channel 1 alarm” in message number 4.

For the procedure to set the alarm, see section 3.7.

For the procedure to set the message, see section 5.4.
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7.2 Setup Examples of Event Action

Example 3: Releasing the Alarm Output Using the USER Key (Alarm

Acknowledge Operation)
Release the activated alarm output by pressing the USER key. Use logic box number 4.

e Setup Screen and Setup Items
Press MENU (switch to the setting mode) and select Timer, Event action > Event

action

10 16:10:10 e IEET(S) 0}
Logic box number

Event Userkey
Action AlarmAcK
1 20 |

<Operation>
Press the USER key to release the activated alarm indication and relay output.

<Related Settings>
Set the alarm indication and alarm output relay operation to Hold.
For the procedure to set the alarm indication operation and alarm output relay operation,

see section 3.5.
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Chapter 8

Using the Security Function

8.1 Disabling the Key Operation (Key Lock
Function)

Disable the key operation.
For a description of the function, see section 1.7.

Setup Screen

* Selecting the Key Lock Function

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > Security, Media save

Basic Setting Hode

Security

ey Kewlock

Communication Ooff

Save

Auto save 0n
fiewlock

Key Operation to Be Disabled

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Keylock > Password, Key action, Media, or Action
of Function

» Key action, Media « Action of Function

Basic Setting Hode Basic Setting Hode

Password _ Action of Function

Kew action AlarmACK
START Free Hessage / Batch Free
STOP Free itz Free
HEMU Free Data save Free
LSER Free E-mail / FTP Free
DISP/ENTER Free Time set Free
FAWORITE Free Dizplay Function Free
External media r__??gg___

[ Toput || Clear

Security > Key

Select Keylock.

Settings Description

Keylock Enables the key lock function. The Keylock item is displayed in the basic setting
mode menu.

Login Enables the login function. See section 8.2.

Password
The password used to release the key lock. (Up to 8 characters, [Ala#[1])

Key action, External media or Action of Function
Select whether to lock each item.

Settings Description
Free Key lock not applied.
Lock Disables the operation.

IM 04L41B01-01E
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8.1 Disabling the Key Operation (Key Lock Function)

Procedure

* Locking the Keys

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Keylock soft key.
The key lock is activated. The key lock icon appears in the status display section.

* Releasing the Key Lock

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Keylock soft key.
A window appears for you to enter the password.

19 10:10: 1o [elor=> TN (O) w0 49}

3. Enter the password and press DISP/ENTER.
The key lock is released. The key lock icon in the status display section disappears.
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8.2 Enabling Only Registered Users to Operate the

DX (Login Function)

Only registered users can operate the DX.
For a description of the function, see section 1.7.

Setup Screen

* Login Function
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > Security, Media save

3

Basic Setting Hode

Security

few

Communication Loain

Save

Auto save 0n
fewlock

* Logout Method
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Login > Basic settings

Basic Setting Hode

User basic settinas

Auto Togout
Operation without Login Off

L0 | dnin | 2nin | Suin | 1fnin |

* Registering Administrators
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Login > Admin settings

Basic Setting Hode

Admin number

Hode ey

User name Adminl
Pazzword P S22

T O N -
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8.2 Enabling Only Registered Users to Operate the DX (Login Function)

* Registering Users

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Login > User settings

hEt

Basic Setting Hode

User number

Hode ey

User name Userl

Pazzword PR s s

Authority of user Off
1 20 |

* User Privileges

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Login > Authority of user > Key action, Media or
Action of Function

Basic Setting Hode Basic Setting Hode

Authority of user Authority of user
kew action Action of Function

START Free AlarmACK Free
SToOP Free Hessage / Batch Free
HEMU Free Hath Free
USER Free Data zave Free
DISP/ENTER Free E-mail # FTP Free
FAWORITE Free Time set Free
External media W Display Function Free

I T T N

The login function can be set separately for login through keys and login through
communications.

e Security > Key

Select Login.

Settings Description

Login Enables only registered users to operate the DX using keys. The Login item is
displayed in the basic setting mode menu.

Keylock Enables the key lock function. See section 8.1.

Off Disables the security functions.

Security > Communication

Settings Description

Login Enables only registered users to operate the DX via communications. The
Login item is displayed in the basic setting mode menu.

Off Disables the security functions.

User basic settings > Auto logout

Settings Description

Off Does not log out until the logout operation is executed.

1min to 10min Automatically logs out when there is no key operation for a specified time.
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8.2 Enabling Only Registered Users to Operate the DX (Login Function)

User basic settings > Operation without login
Sets the operation that the user can carry out when logged out.

Settings Description
Off Only login operation is available.
Display Allows the user to switch the operation screen in addition to the login operation.

Admin number
Up to five administrators can be registered. Be sure to register at least one
administrator. At least one administrator must be registered to use the login function.

Admin > Mode
The available settings vary depending on the Security setting.

Settings Description

Off Not register.

Key Log into the DX using keys.

Comm Log into the DX via communications.

Web Log into the operator page and monitor page of the DX using a Web browser.

Key+Comm  Log into the DX using keys and via communications.

Admin > User name
Set the user name. (Up to 20 characters, [Ala#]1])

* You cannot register user names that are already registered.
* You cannot register “quit” or a user name containing all spaces.

Admin > Password
Set the password. (Up to 8 characters, [Ala[#[1])

as Bkkkkkkkk
* You cannot register “quit” or a password containing all spaces.

User number
Up to 30 users can be registered.

User > Mode
The available settings vary depending on the Security setting.

Settings Description

Off Not register.

Key Log into the DX using keys.

Comm Log into the DX via communications.

Web Log into the monitor page of the DX using a Web browser.

Key+Comm  Log into the DX using keys and via communications.

User > User name or Password
Same as the administrator settings.

¢ Authority of user

Settings Description
Off No limitations on the operation.
1t0 10 Registration number of the operation limitation.

Key action, External media, or Action of Function
See section 8.1.
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8.3 Logging in and Logging Out

This section explains the procedure to log into the DX using keys. For the procedure
to log into the DX via communications, see the Communication Interface User’s
Manual (IM04L41B01-17E).

Procedure

* Logging In

1. In the operation mode, press FUNC.
A list of registered user names appears.

[ = .
15 101010 B0 IEETE(S) 0}
ot

Userl

2. Press the arrow keys to select a user name, and press DISP/ENTER.
A window appears for you to enter the password.

GROUP 1 e
b0 1.10:10 0= IEEEYE (O] 0}

3. Enter the password* and press DISP/ENTER.
The DX is ready to be operated using keys. The name of the user that is logged in is
displayed in the status display section.
* The password that you enter is displayed as “*******”

* Logging Out
Using Keys
1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Logout soft key.
You are logged out from the DX. The user name in the status indication section disappears.

Auto Logout
If auto logout is enabled, you are automatically logged out if there is no key operation
for a specified time.
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8.3 Logging in and Logging Out

¢ Changing the Password
Using Keys

1.

In the operation mode, press FUNC.
The FUNC key menu appears.

Press the Password change soft key.
A window appears for you to enter the current password.

Enter the current password, select ENT, and press DISP/ENTER.
A window appears for you to enter the new password.

Enter the new password, select ENT, and press DISP/ENTER.
A window appears for you to enter the new password again.

Enter the new password, select ENT, and press DISP/ENTER.
The window closes, and the new password is activated.

IM 04L41B01-01E
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Chapter 9 Computation and Report Functions (/M1 and /PM1 Options)

9.1 Setting the Expression, Measurement Range,
Alarm, Tag, and Data Storage on Computation
Channels

Set the computation details, measurement range, tag, and alarm. You cannot set
expressions or constants while memory sampling or computation is in progress.
For a description of the function, see section 1.8.

Setup Screen

e Expression and Alarm
Press MENU (switch to the setting mode) and select Math Channel > Expression,

Alarm
5/10/18 18:18: 1@ E@?[I? ll!ﬂiﬂl[:j 0}
First-CH: IS Last-CH: 181
Hath |0n
Galculation expression
p1
Span Lower Span Upper Unit
[ -zeo.e0 [ zoo.pe |
Alarm
1 [off_
2 [off
3 [off
4 [off

* Constants Used in Expressions
Press MENU (switch to the setting mode) and select Math Channel > Constant

nfn|1n 10: 10 E@?[I? ll!ﬂiﬂl[:j 0}

Humber of constant
Yalue i

¢ Tag and Alarm Delay Time of Computation Channels
Press MENU (switch to the setting mode) and select Math Channel > Tag, Memory,

ol))

First-cH: J:b)  Last-CH: 181

Tag

Characters

Hemory sample

On/fOff On

Alarm delay

Time 18 =
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9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Measurement Channels

¢ Conditions of TLOG Computation and Rolling Average
Press MENU (switch to the setting mode) and select Math Channel > TLOG, Rolling

average
=T
/15 10:10:10 o= IEZE (O 0}

First-cH: J:b)  Last-CH: 181
TLOG

Timer Mo. 1

Sum scale 0ff

Reset Ooff

Rolling average

On/fOff (n

Interval 18z

Humber of samples 1

* Display for Computation Errors and Handling of Overflow Data in
Statistical Computation

Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Environment > Math

Basic Setting Hode

Hath
VYalue on Error

VYalue on Owverflow

SUM, AVE Skip
HAX, MIN, P-P Over

e First-CH/Last-CH
Set the target channels.

* Expression/Span
¢ Math On/Off
Select On for channels to be used.
¢ Calculation expression
Enter the expression using up to 120 characters.
Pressing the Input soft key displays a window used to enter the expression.

[ = .
1 101010 0= IEET(S] +0)

For details on how to write expressions, see section 9.2.

Nofte
You cannot use both the USB keyboard (/USB1 option) and the DX keys to enter the equation.

If you press a DX soft key, for example, while you are entering an equation from the USB
keyboard, the entered equation is cleared.
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9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Measurement Channels

e Span_L, Span_U
Set the measurement range.
Selectable range of values: —9999999 to 99999999
Selectable decimal places: X.XXXX, XX. XXX, XXX. XX, XXXX.X

¢ Unit
Set the unit of the computed value. (Up to 6 characters, [Ala[#]1])

e Alarm
The available alarm types are high limit alarm, low limit alarm, delay high limit alarm,
and delay low limit alarm.
The range of alarm values is as follows:

Type Value
H LTt Within —9999999 to 99999999 excluding the decimal point

For details on setting alarms, see section 3.7.

*

If the Math On/Off or calculation expression is changed, the alarms for that channel are turned
Off.

e Alarm delay > Time
Set the alarm delay time using an integer in the range of 1 to 3600 s.

e Tag > Characters
Set the tag. (Up to 16 characters, [ala[#[1])

e Constant

* Number of constant
Select the constant (K01 to K60) to set.

e Value
The selectable range is as follows:
—9.9999E+29 to —1.0000E-30, 0, 1.0000E-30 to 9.9999E+29
The number of significant digits of a constant is five. When specifying the constant
using exponential notation, set the mantissa less than or equal to 5 digits and the
exponent less than or equal to 2 digits.

e TLOG

¢ Timer No.
Select the timer number to use.
For details on setting the timer, see section 7.1.

* Sum scale
Set the sum scale to /s to /h to match the unit of the measured value.
Example: If the unit of the measured value is “m3/min,” select /min.
Off: Sums as-is the measured data per scan interval.

* Reset
To reset the TLOG computed value at each interval, select On.
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9.1 Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Measurement Channels

* Rolling average

e On/Off
To take the rolling average of the measured results, select On.

e Interval
Select the sampling interval when taking the rolling average from the following: The
sampling interval takes on a value that is an integer multiple of the scan interval.
For example, if the sampling interval is set to 5 s when the scan interval is 2 s, the
actual sampling interval is 6 s.

¢ Number of samples
Set the number of samples for the rolling average using an integer between 1 and
1500.
The rolling average time is equal to the sampling interval x the number of samples.

Note

» If the number of data points to be averaged has not reached the specified number of
samples immediately after computation is started, the average of the available data is
calculated.

» Computation error data is excluded from the rolling average computation.

» If the computed data exceeds the upper or lower limit, the data is clipped at the upper or
lower limit, and the rolling average is computed. The upper and lower limit is “+100000000”
excluding the decimal point. The decimal place is the same as that of the span lower limit.

* Memory sample > On/Off
Turn On the target channels.

¢ Math
e Value on Error
Specify whether to set the display for a computation error to +Over or —Over.
¢ Value on Overflow > SUM, AVE
Specify how to handle overflow data when it is detected in the SUM or AVE
computation of TLOG or CLOG. This setting is also applied to report generation.

Settings Description

Error Sets the computed result to computation error.

Skip Discards the overflow data and continues the computation.

Limit Uses a limit value in place of the overflow data and continues the computation.

¢ Value on Overflow > MAX, MIN, P-P
Specify how to handle overflow data when it is detected in the MAX, MIN, or P-P
computation of TLOG or CLOG. This setting is also applied to report generation.

Settings Description
Over Uses the overflow data as-is.
Skip Discards the overflow data and continues the computation.
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9.2 Writing Expressions

Common ltems

This section explains the meaning and how to write expressions.

Follow the rules below when writing expressions.
» Use up to 120 characters to write expressions.

» The precedence of computing terms can be specified using parentheses.

» Specify the channels in the expression using channel numbers.
Example: 1, 12, and 101

» The one-digit number of constants (K), communication input data (C), remote input

terminal status (D), pulse input (P, Q), internal switch (S), alarm output relay status (1),

and flag (F) in the expression can be denoted as in “01” and “1.”

Example: KO1, K1, C01, C1, D01, D1, P01, P1, Q01, Q1, S01, S1, 101, 11, FO1, and F1.
» The data of the previous scan is used in the computation for its own channel number

and channel numbers greater than its own channel number in the expression.

» Special computation (HOLD, RESET, and CARRY) and conditional expressions are

written at the beginning of the expression.

Order of Precedence in Computations

The order of precedence of computation in expressions is as follows:

Type Computing Element

(high order of precedence)
Function ABS(), SQR(), LOG(), LN(), EXP(),

TLOG.MAX(), TLOG.MIN(), TLOG.AVE(),
TLOG.SUM(), TLOG.P-P(), CLOG.MAX(),
CLOG.MIN(), CLOG.AVE(), CLOG.SUM(),

CLOG.P-P()

Special computation and conditional expression PRE, HOLD, RESET, CARRY, [a?b:c]

Power *

Logical negation NOT

Multiplication and division *

Addition and subtraction +, -

Greater than and less than .GT,, .LT., GE,, LE.

Equal and not equal .EQ.,, .NE.

Logical product AND

Logical sum and exclusive logical sum OR, XOR

(low order of precedence)

Limitations
The following limitations exists in writing expressions.

Type Limitations

TLOG computation A computing element cannot be written inside the parentheses.
Only one TLOG computation can be specified in a single expression.

CLOG computation Number of channels that can be written in the parentheses is 30 channels or less.

A computing element cannot be written inside the parentheses.
Only one CLOG computation can be specified in a single expression.

PRE A computing element cannot be written inside the parentheses.
HOLD(a):b Can only be written at the beginning of an expression.

Only one HOLD computation can be specified in a single expression.
RESET(a):b Can only be written at the beginning of an expression.

Only one RESET computation can be specified in a single expression.
CARRY(a):b Can only be written at the beginning of an expression.

Only one CARRY computation can be specified in a single expression.

Only TLOG.SUM can be written in “b.”

Conditional equation RESET, CARRY, or HOLD cannot be written to “a,” “b,” or “c.” Other computing
[a?b:c] elements cannot be combined (example: [a?b:c]+001). However, coditional

equations can be specified for a, b, and c.

IM 04L41B01-01E
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9.2 Writing Expressions

Four Arithmetic Operation

Expression Example
+ Addition 001+002
(Determines the sum of the measured values of channel 1 and channel 2.)
* Subtraction 001-002
(Determines the difference of the measured values of channel 1 and
channel 2.)
* Multiplication 001*K03
(Multiplies constant KO3 to the measured value of channel 1.)
+ Division 001/K02
(Divides the measured value of channel 1 by constant K02.)

Power and Other Computations

Expression Example
* Power 001**002

(Determines the measured value of channel 1 to the power of
the measured value of channel 2.)

» Square root SQR(002)
(Determines the square root of the measured value of channel 2.)
» Absolute value ABS(002)
(Determines the absolute value of the measured value of
channel 2.)

» Common logarithm LOG(001)
(Determines the common logarithm (log1o) of the measured
value of channel 1.)

* Natural logarithm LN(001)
(Determines the natural logarithm of the measured value of
channel 1.)

» Exponent EXP(001)
(Determines e to the power of the measured value of channel 1.)

Relational Computation

Expression Example

002.LT.003

If the measured value of channel 2 is less than the measured value of channel 3, the
computed result is “1.” Otherwise, the result is “0.”

002.GT.003
If the measured value of channel 2 is greater than the measured value of channel 3, the
computed result is “1.” Otherwise, the result is “0.”

002.EQ.003
If the measured value of channel 2 is equal to the measured value of channel 3, the
computed result is “1.” Otherwise, the result is “0.”

002.NE.003
If the measured value of channel 2 is not equal to the measured value of channel 3, the
computed result is “1.” Otherwise, the result is “0.”

002.GE.003
If the measured value of channel 2 is greater than or equal to the measured value of
channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.LE.003
If the measured value of channel 2 is less than or equal to the measured value of channel 3,
the computed result is “1.” Otherwise, the result is “0.”
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9.2 Writing Expressions

Logical Computation
Checks whether the two data values, e1 and e2 (e1 only for NOT), are zeroes or non-

zeroes, and computes according to the conditions.

AND

Logical product
(Syntax)
(Condition)

(Explanation)

OR

Logical sum
(Syntax)
(Condition)

(Explanation)

XOR
Exclusive OR

(Syntax)
(Condition)

(Explanation)

NOT

Logical negation

(Syntax)
(Condition)
(Explanation)

e1ANDe2

If the two data values e1 and e2 are both non-zeroes, the computed
result is “1.” Otherwise, it is “0.”

e1=0,e2=0
e1#0,e2=0
e1=0,e2#0
el1#0,e2#0

e10Re2

—

—
—
—

e1ANDe2 =0
e1ANDe2 =0
e1ANDe2 =0
e1ANDe2 = 1

If the two data values e1 and e2 are both zeroes, the computed result is

“0.” Otherwise, it is “1.”

e1=0,e2=0
e1#0,e2=0
e1=0,e2#0
e1#0,e2#0

e1XORe2

—

—
—
—

e10Re2=0
e10Re2 =1
e10Re2 =1
e10Re2 =1

If the two data values e1 and e2 are zero and non-zero or non-zero and
zero, the computed result is “1.” Otherwise, it is “0.”

e1=0,e2=0
el1#0,e2=0
e1=0,e2#0
el1#0,e2#0

NOTe1

—

—
—
—

e1XORe2 =0
e1XORe2 =1
e1XORe2 =1
e1XORe2 =0

The result is the inverse of the status of data e1 (zero or non-zero).

el=0
e1#0

Expression Example
01-020R03.GT.04
Determines the OR of the computed results of “01-02” and “03.GT.04”.

—

—

NOTe1 =1
NOTe1 =0

IM 04L41B01-01E
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9.2 Writing Expressions

TLOG Computation

In the explanation below, an expression containing a computing element in e1, an
internal switch (S), a relay (1), or flag (F) cannot be written. In addition, only one TLOG
computation can be specified in a single computing equation.

TLOG.MAX()

Maximum value

(Syntax) TLOG.MAX(e1)

(Condition) Determines the maximum value of channel e1.
TLOG.MIN()

Minimum value

(Syntax) TLOG.MIN(e1)

(Condition) Determines the minimum value of channel e1.
TLOG.AVE()

Average value

(Syntax) TLOG.AVE(e1)

(Condition) Determines the average value of channel e1.
TLOG.SUM()

Sum value

(Syntax) TLOG.SUM(e1)

(Condition) Determines the sum of channel e1.
TLOG.P-P()

Maximum - minimum value

(Syntax) TLOG.P-P(e1)

(Condition) Determines the maximum - minimum value of channel e1.

Expression Example
TLOG.MAX(01)+K01*SQR(02)

Examples of Equations That Are Not Allowed
TLOG.AVE(01)+TLOG.AVE(02)

Reason: TLOG appears twice in one equation.

TLOG.AVE(ABS(01))
Reason: A computing element is used inside the parentheses.
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9.2 Writing Expressions

CLOG Computation

Only data of measurement channels and computation channels can be used in the
CLOG computation. Up to 30 channels can be written in the parentheses.

In the explanation below, an expression containing a computing element cannot be
written to e1, etc. In addition, only one CLOG computation can be specified in a single
computing equation.

CLOG.SUM()

Sum value

(Syntax) CLOG.SUM(e1.e2.e4-e6)

(Condition) Determines the sum of the data of channels e1, e2, e4, €5, and e6 that

are measured at the same time.

CLOG.MAX()
Maximum value

(Syntax) CLOG.MAX(e1.e2.e4-e6)
(Condition) Determines the maximum value among the data of channels e1, €2, e4,
e5, and e6 that are measured at the same time.

CLOG.MIN()

Minimum value

(Syntax) CLOG.MIN(e1.e2.e5.e7)

(Condition) Determines the minimum value among the data of channels e1, e2, e5,
and e7 that are measured at the same time.

CLOG.AVE()

Average value

(Syntax) CLOG.AVE(e1-e6)

(Condition) Determines the average value among the data of channels e1 to e6 that

are measured at the same time.

CLOG.P-P()

Maximum - minimum value

(Syntax) CLOG.P-P(e1.e2.e5.e7)

(Condition) Determines the difference between the maximum and minimum values
among the data of channels e1, e2, €5, and e7 that are measured at the
same time.

Expression Example
CLOG.MAX(001.002.104-106)+K01*SQR(002)

Examples of Equations That Are Not Allowed
CLOG.AVE(001.003.005)+CLOG.AVE(002.004.006)

Reason: CLOG appears twice in one equation.

CLOG.AVE(001.ABS(001))
Reason: A computing element is used inside the parentheses.
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9.2 Writing Expressions

Special Computation

PRE()

(Syntax) PRE(e1)

(Condition) Determines the previous value of e1.

HOLD(a):b

(Syntax) HOLD(a):b

(Condition) When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value is held.

RESET(a):b

(Syntax) RESET(a):b

(Condition) When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value of b is reset, and b is carried
out to derive the computed value.

CARRY(a):b

(Syntax) CARRY(a):b

(Condition) Only TLOG.SUM can be specified for b. If the computed value X of b is
less than a, the computed result is X. If X is greater than or equal to a,
the computed result is the excess (X — a).

(Description) When a value such as the flow rate is summed and the threshold value
is reached or exceeded, the sum value is reset while carrying over the
amount that exceeded the threshold value.

Expression Example
Expression that sums the values of channel 1 and resets the value when it reaches or

exceeds 10000
K01 = 10000
CARRY(K01):TLOG.SUM(001)

Examples of Equations That Are Not Allowed
002+HOLD(K01): TLOS.SUM(001)

Reason: HOLD is not at the beginning of the expression.

RESET(101.GT.K01):TLOG.SUM(001)+RESET(101.GT.K01):002
Reason: RESET appears twice in one equation.

Conditional Expression

[a?b:c]
(Syntax) [001.GT.K01?002:003]
(Condition) If the measured value of channel 1 is greater than constant KO1, the

computed result is the measured value of channel 2. Otherwise, the
computed result is the measured value of channel 3.

Examples of Equations That Are Not Allowed
[001.GT.K01?002:003]*K02

Reason: Used in combination with another computing element.

Nested Conditional Expressions
A conditional expression can be written to Expression1, Expression2, and Expressions

in the equation [Expression1?Expression2:Expressions]. For example, the following
expression is allowed: [Equation1?[Equation2-1?Equation2-2:Equation2-3]:[Equations-
1?Equations-2:Equations-3]]

Expressions can be nested as long as the number of characters of the expression does
not exceed 120 characters.
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9.3 Displaying the Computation Channels

Computation channels can be assigned to groups and displayed in a similar manner to
measurement channels.
For a description of the function, see section 1.8.

Setup Screen

e Color
Press MENU (switch to the setting mode) and select Math channel > Color

> =T
16 16:10:10 e IEEET(S) 0}
Group of channel

Calor
1a1 . Red
182 . Green
1483 . Blue
ICEIE | B.violet
185 . Brown
186 Orange
[101-166 [167-112

e Zone Display and Scale Display
Press MENU (switch to the setting mode) and select Math channel > Zone, Scale

§or T (O) )

First-cH: 0N Last-CH: 181
Zone

Lawer A%

Upper 108 %

Scale

Position 1

Divizion 1@

* Bar Graph Display
Press MENU (switch to the setting mode) and select Math channel > Bar

@0 T (S) )

First-cH: 0N Last-CH: 181
Bar araph
Base position Hormal
Divizion 1@

e Partial Expanded Display
Press MENU (switch to the setting mode) and select Math channel > Partial

, o= T () )

First-cH: 0N Last-CH: 181
Partial
On/fOff (n
Expand 58 %
Boundary A, aa

(suondo LN/ pue LIN/) suondoun4 Joday pue uoneindwos
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9.3 Displaying the Computation Channels

e Alarm Marks
Press MENU (switch to the setting mode) and select Math channel > Alarm mark

[ = .
/10 101010 00 IEET(S) +13}

First-cH: 0N Last-CH: 181
Alarm mark
Hark kind Fixed
Indicate on Scale Ooff
Alarm mark color
Alarm 1 Red
Alarm 2 Orange
Alarm 3 Orange
Alarm 4 Red

* Color Scale Band
Press MENU (switch to the setting mode) and select Math channel > Color scale

First-CcH: 0N Last-CH: 181

Color scale band
Band area In
Calor Lime
Dizsplay position
Lawer A, aa
Upper 1.88

¢ Channel Numbers, First-CH, and Last-CH
Select the target channel range.

¢ Channel Display Color
See section 5.5.

e Zone Display
See section 5.6.

e Partial Expanded Display
See section 5.9.

* Bar Graph Display Method
See section 5.11.

e Scale
See section 5.7.

¢ Alarm Marks and Color Scale Band
See section 5.8.
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9.4 Starting/Stopping Computation, Resetting
Computation, and Releasing Computation Data
Dropout Display

Setup Screen

* Action Taken When the START Key Is Pressed
Press MENU (switch to the setting mode) and select Math channel > Math start

action

P 1
A/18 16:18:168

§or T (O) )

Hath start action

Hath start

Start

¢ Math start action > Math start

Settings Description

Off Does not start the computation even when the START key is pressed.

Start Starts the computation when the START key is pressed.

Rst+St Resets the computed result up to then and starts the computation when the

START key is pressed.

Procedure

¢ Starting the Computation
» Starting the Computation Simultaneously with the Memory Sampling
Press START. Computation starts simultaneously with the start of the memory
sampling. The computation icon appears in the status display section.
* Math start must be set to Start or Rst+St.

¢ Starting Only the Computation

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Math start soft key.
Computation starts, and the computation icon is displayed in the status display section.
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9.4 Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data Dropout Display

e Stopping the Computation
¢ Stopping the Computation Simultaneously with the Memory Sampling

1. Press STOP.
A confirmation dialog box appears.

510 10:10:10 e IEEEERA (S )

Lnindiv

- [ Hemory [ cancel
1

L -A.6d11 —3.49751 —E.dliﬂ -B. 3063
i v u u
Hl Hl

2. Select Mem+Math and press DISP/ENTER.
The memory sampling and computation stop, and the computation icon in the status display
section disappears.

e Stopping Only the Computation

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Math stop soft key.
The computation stops, and the computation icon in the status display section disappears.

Nofte

When the computation is stopped, the computed data of the computation channel is held at the
value that existed immediately before the computation is stopped. When memory sampling is in
progress, the held value is recorded.

Resetting the Computed Results on All Computation Channels
This operation can be carried out when the computation is stopped. You can carry out this

operation even while the computation is in progress on DXs with release number 2 or later.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Math reset soft key.
The computed results of all computation channels are reset.

Releasing the Computation Data Dropout Display
This operation can be carried out when a computation data dropout occurs. When a
computation data dropout occurs, the computation icon turns yellow.

1. In the operation mode, press FUNC.
The FUNC key menu appears.

2. Press the Math ACK soft key.
The computation icon returns to white.
* Math ACK is displayed in the FUNC key menu only when a computation data dropout
occurs.

Nofte

A computation data dropout occurs when the computation process cannot be completed within
the scan interval. If computation data dropout occurs frequently, lessen the load on the CPU by
reducing the number of computation channels or setting a longer scan interval. If a computation
data dropout occurs during memory sampling, the data immediately before the dropout is
recorded as the computed data of the scan interval in which the dropout occurred.

9-14
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9.5 Creating Reports

Set how the reports are created.
For a description of the function, see section 1.8.

Setup Screen

* Report Computation Type
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Environment > Report

Basic Setting Hode

Report
Report select
1
2 Hax
3 Hin
4 Sum
File twpe Separate

| Hax | Hin | fve | Sun | Inst |

¢ Report Type and Time of Creation
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the
basic setting mode), and select Report > Basic settings

thetrnet

Report set

Report kind
Date
Time thour:

* Source Channels
Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the

basic setting mode), and select Report > Report settings

Basic Setting Hode
Report channel number

On/fOff (n
Channel Ba1
Sum scale I
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9.5 Creating Reports

Report > Report select > 1, 2, 3, and 4
Select the type of data to output as reports.

Settings Description

Off Does not output reports.

Ave Outputs the average value.

Max Outputs the maximum value.

Min Outputs the minimum value.
Sum Outputs the sum value.

Inst Outputs the instantaneous value.

Report > File type
Set this item when creating two types of reports such as daily report and monthly
report.

Settings Description
Separate Saves each type of report to a separate file.
Combine Saves the report data of two types in a single file.

Report set > Report kind
Select the type of report to be created.

Settings Description

Hour Creates hourly reports.

Day Creates daily reports.

H+D Creates hourly and daily reports.

Day+Week Creates daily and weekly reports.

D+M Creates daily and monthly reports.

Report set > Date/Day of the week, Time (hour)

Set the date or day of the week and the time when the report is to be created. The
specified date/time is when the report file is divided. Set the values in the range
indicated below. Items with a dash are invalid.

Report Type Date Day of Week Time

Hour - - 0to 23
Day 1 to 28* - 0to 23
H+D - - 0to 23
Day+Week - SUN to SAT 0to 23
D+M 1to 28* - 0to 23

* You cannot specify 29, 30, or 31.

Report Time and Date/Time When the Report File Is Divided

Example: When the Date of a daily report is set to 1 and the Time (hour) is set to
18:00

A daily report is created every day at hour 18.

The file storing the report is divided at 18:00 on day 1 of each month.

9-16
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9.5 Creating Reports

Procedure

Report Channel number
The report is output in order by this number.

Report CH > On/Off
Select On for the report channels to be used.

Report CH > Channel
Set the channel to assign to the report channel. All channels can be assigned, but

reports are not created for channels set to Skip or Off even if they are assigned.

Report CH > Sum scale

Set the sum scale to /s to /day to match the unit of the measured value.
Example: If the unit of the measured value is “m3/min,” select /min.

Off: Sums as-is the measured data per scan interval.

Handling of Overflow Data
See section 9.1.

Starting/Stopping the Report Function
Starting the memory sampling starts the report function. Likewise, stopping the
memory sampling stops the report function.

Displaying the Reports
See section 4.5.

Saving the Reports
See section 1.4.
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Chapter 10 Troubleshooting

10.1 A List of Messages

There are cases in which error codes and messages are displayed on the screen during
operation. A list of the possible error codes and messages are given in the table below.
Communication error codes and messages are also listed.

Error responses to communication commands are output in English.

Errors Related to Parameter Settings
. Setting Errors

Code Message

Explanation/Countermeasures/Ref. section

1 System error. Contact your nearest YOKOGAWA dealer.
2 Incorrect date or time setting. Enter a correct value.
3 A disabled channel is selected. Specify a channel that is not set to Skip or Off.

Specify a channel that is installed.

Incorrect function parameter.

See Communication Interface User’s Manual.

The input numerical value exceeds the set range.

Enter a proper value.

Enter a proper character string.

Too many characters.

Enter the correct number of characters.

4
5
6 Incorrect input character string.
7
8

Incorrect input mode.

Specify a correct mode.
See section 3.3.

9 Incorrect input range code. Specify a correct range code.
See section 3.3.

11 Range settings are not same within the selected channels. Specify channels with the same range setting.
See section 3.9.

21 Cannot set an alarm for a skipped channel. Cannot be specified on channels set to Skip.
See section 3.7.

22 The upper and lower span limits are equal. Cannot be set to the same value.
See section 3.3.

23 The upper and lower scale limits are equal. Cannot be set to the same value.
See section 3.3.

24 The lower limit of the span band is greater than the upper limit. Set the lower limit less than the upper limit.
See section 3.3.

25 The lower limit of the scale band is greater than the upper limit. Set the lower limit less than the upper limit.
See section 3.3.

30 The partial boundary value exceeds the range of the span. See section 5.9.

31 Partial-expansion display is set ON for a SKIPPED channel. Cannot be specified on channels set to Skip.

35 The upper and lower limits of the display band are equal. Set the upper limit greater than the lower limit + 5.
See section 5.6.

36 The lower limit of the display band is greater than the upper Set the upper limit greater than the lower limit + 5.

limit. See section 5.6.

37 The display band is narrower than 4% of the entire display. Set the upper limit greater than the lower limit + 5.
See section 5.6.

40 Incorrect group set character string. See section 5.1.

41 There is no specified input channel. Specify a channel that is installed.

42 Exceeded the number of channels which can be set. Up to 10 channels per group.

43 A channel number cannot repeat in a group. See section 5.1.

45 There is no character string saved in the clipboard. Copy a character string to the clipboard.

46 The character string saved in the clipboard is too long. Paste a character string with the specified number of
characters.

47 Start and end time cannot match. See section 2.1.

48 Invalid or missing DST time settings. See section 2.1.

61 There is no channel specified by the MATH expression. See section 9.1.
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10.1 A List of Messages

Code Message Explanation/Countermeasures/Ref. section
62 MATH expression grammar is incorrect. See section 9.2.
63 MATH expression sequence is incorrect. See section 9.2.
64 MATH upper and lower span values are equal. Set the upper limit not equal to the lower limit.
65 Too many operators for MATH expression. See section 9.2.
70 Nonexistent constant specified in MATH expression. See section 9.2.
71 Set range of the MATH constant is exceeded. See section 9.1.
80 This username is already registered. See section 8.2.
81 All space or ‘quit’ string cannot be specified. See section 8.2.
84 The login password has not been set up. See section 8.2.
85 The login password is incorrect. See section 8.3.
86 The key-lock release password is incorrect. See section 8.1.
87 This key is locked. See section 8.1.
88 This function is locked. See section 8.1.
89 Press [FUNC] key to login. See section 8.3.
90 No permission to enter to the SETUP mode. See sections 8.2 and 8.3.
91 Password is incorrect. See sections 8.2 and 8.3.
92 Press [ESC] key to change to the operation mode. Press the ESC key.
93 String including space or all space cannot be specified. Spaces are not allowed in the Web browser user
name and password.
94 More than one address cannot be specified. Only a single sender is allowed.
95 Number entered exceeds channel number range. Check the syntax of the Modbus command.
Use another command. See Communication Interface User’s Manual.
100 IP address doesn’t belong to class A, B, or C. See Communication Interface User’s Manual.
101 The result of the masked IP address is all Os or 1s. See Communication Interface User’s Manual.
102 SUBNET mask is incorrect. See Communication Interface User’s Manual.
103 The net part of default gateway is not equal to that of IP See Communication Interface User’s Manual.
address.
105 This port number is already in use. Please enter a different Enter a different port number for each function.
number.
113 Password entered is incorrect. Enter the correct password.
119 This user name is unable to use this mode. Check the user privileges on the operation.
See section 8.2.
120 Measured value is incorrect. (in ascending order) See section 3.9.
122 Measured value exceeds the range setting. See section 3.9.
125 Character entry cannot be performed. The DX is not showing a display used to enter
character strings.
126 You cannot use the same password. Specify a different password.
127 Report kind overlaps and cannot be set up. See section 9.5.
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10.1 A List of Messages

Execution Errors

Code Message Explanation/Countermeasures/Ref. section
150 This action is not possible because sampling is in progress. Stop the memory sampling and then execute.
151 This action is not possible during sampling or calculating. Stop the memory sampling and then execute.
152 This action is not possible because saving is in progress. Wait until the saving is complete.

153 This action is not possible because formatting is in progress.  Wait until the formatting is complete.

154 Message not accepte because message limit was reached. The limit is 50 messages.

155 The message is not written while sampling is stopped. Start the memory sampling and then execute.
156 There are no channels to be saved to the memory. Set the channels to be saved.

157 This function is not possible at this time. Check the DX status.

158 Exceeds time deviation setting. See section 2.3.

159 It is outside the postscript message write-in range. See section 5.4.

Operation Errors

Errors Related to the External Storage Medium

Code Message Explanation/Countermeasures/Ref. section

200 Operation aborted because an error was found in media. Use another storage medium or format it.

201 Not enough free space on media. There is not enough free space on media or the
number of directories exceeded the limit. Use another
storage medium.See section 1.4.

202 Media is read-only. Make it writable.

210 Media has not been inserted. Insert a storage medium into the drive.

21 Media is damaged or not formatted. Use another storage medium or format it.

212 Format error. Try formatting again.

213 The file is read-only. Access another file or make the file writable.

214 There is no file or directory. Specified a file in which data is being added. Tried
to save a file which does not exists in the internal
memory.

215 Exceeded the allowable number of directories or files. Replace a storage medium. Delete unneeded files and
directories.

216 The file or directory name is incorrect. Use alphanumeric characters and symbols.

217 Unknown file type. Specify another file.

218 This directory or file now exists. Delete it or change the name. See section 6.2.

219 Invalid file or directory operation. Tried to delete multiple directory levels. Or, tried to
delete a directory containing files.

Delete the files and directories in the directory first
before executing the operation.

220 The file is already in use. Try again later. Wait until the file is accessible.

221 This action is not possible because FTP transmission is in Execute after FTP data transfer is complete.

progress.

222 Media is not recognized. Remove and reset the storage medium.

230 There is no setting file. Specify another file.

231 Abnormal setting exists in file. Specify another file.
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10.1 A List of Messages

Errors Related to the Historical Trend

232 There is no available data. Appears when displaying historical trends. Specify another

file.

233 The specified historical data do not exist. Appears when switching to historical trend from information

display. See section 4.5.
234 The specified channel is not assigned to the display group.  Appears when switching to trend, digital, or bar graph from
overview. See sections 4.4 and 7.6.
. Errors Related to E-mail and Web Server
260 IP address is not set or ethernet function is not available. The IP address is not specified.
Check the IP address.

261 SMTP server is not found. Occurs when the SMTP server is specified by

name.
» Check the DNS setting.
» Check the SMTP server name.

262 Cannot initiate E-mail transmission. * The host name of the DX is not correct. Check

the host name.
» The port number of the SMTP server is not
correct. Check the port number.

263 Sender’s address rejected by the server. Check the sender’s address.

264 Some recipients’ addresses are invalid. Check the recipients’ addresses.

265 SMTP protocol error. May occur if a network failure (cable problems,
duplicate addresses, network device failure, and so
on) occurs in the middle of the e-mail transmission.

266 Ethernet cable is not connected. Check the cable connection.

267 Could not connect to SMTP server. * Check to see that the SMTP server is connected

to the network.

* If the SMTP server name is specified using an
IP address, check to see that the IP address is
correct.

268 E-mail transmission request failed. Contact your nearest YOKOGAWA dealer.

269 E-mail transfer error. May occur if a network failure (cable problems,
duplicate addresses, network device failure, and so
on) occurs in the middle of the e-mail transmission.

275 The current image cannot be output to the Web. The setup display cannot be output to the Web
browser. This message is displayed on the Web
browser.

276 Image data currently being created. Unable to perform key Try again a little later.This message is displayed on

operation. the Web browser.

277 Could not output screen to Web. Failed to create the image.This message is

displayed on the Web browser.

10-4

IM 04L41B01-01E



10.1 A List of Messages

o Errors Related to FTP Client

For a description of the FTP client function of the DX, see the Communication Interface
User’s Manual (IM 04L41B01-17E). The detail code does not appear in the error message
on the screen. You can view the code on the FTP log display of the DX or using the FTP
log output via communications.

Code Message

280 IP address is not set or FTP function is not available.

Further details are provided by the character string that appears after error code 280.

Character String and Details

HOSTADDR
An IP address has not been assigned to the DX.
Check the IP address.
DORMANT
Internal processing error.”
LINK
Data link is disconnected.
Check the cable connection.

281 FTP mail box operation error.

Further details are provided by the character string that appears after error code 281.

Character String and Details

MAIL

Internal processing error.”
STATUS

Internal processing error.”
TIMEOUT

Internal processing error.™
PRIORITY

Internal processing error.”
NVRAM

Internal processing error.”

282 FTP control connection error.

Further details are provided by the character string that appears after error code 282.

Character String and Details

HOSTNAME
Failed the DNS lookup (search the IP address corresponding to the host name).
Check the DNS setting and the destination host name.
TCPIP
Internal processing error.”
UNREACH
Failed to connect to a control connection server.
Check the address setting and that the server is running.
OOBINLINE
Internal processing error.”
NAME
Internal processing error.”
CTRL
The control connection does not exist.
Check that the server does not drop the connection and that it responds within the proper
time period.
IAC
Failed to respond in the TELNET sequence.
Check that the server does not drop the connection and that it responds within the proper
time period.
ECHO
Failed to transmit data on the control connection.
Check that the server does not drop the connection and that it responds within the proper
time period.
REPLY
Failed to receive data on the control connection.
Check that the server does not drop the connection and that it responds within the proper
time period.

IM 04L41B01-01E
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10.1 A List of Messages

Character String and Details

SERVER

The server is not in a condition to provide the service.

Check that the server is in a condition in which service can be provided.

Code Message
283 FTP command was not accepted.
Further details are provided by the character string that appears after error code 283.
Character String and Details
USER
Failed to verify the user name.
Check the user name setting.
PASS
Failed to verify the password.
Check the password setting.
ACCT
Failed to verify the account.
Check the account setting.
TYPE
Failed to change the transfer type.
Check that the server supports the binary transfer mode.
CWD
Failed to change the directory.
Check the initial path setting.
PORT
Failed to set the transfer connection.
Check that the security function is disabled.
PASV
Failed to set the transfer connection.
Check that the server supports PASV commands.
SCAN
Failed to read the transfer connection settings.
Check that proper response to the PASV command is received from the server.
284 FTP transfer setting error.
Further details are provided by the character string that appears after error code 284.
Character String and Details
MODE
Internal processing error.”
LOCAL
Internal processing error.”
REMOTE
The destination file name is not correct.
Check that you have the authority to create or overwrite files.
ABORT
File transfer abort was requested by the server.
Check the server for the reason for the abort request.
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10.1 A List of Messages

Code

Message

285

FTP data connection error.

Further details are provided by the character string that appears after error code 285.

Character String and Details

SOCKET

Failed to create a socket for the transfer connection.?
BIND

Failed the transfer connection command.”
CONNECT

Failed the transfer connection.”
LISTEN

Failed the transfer connection reception.™
ACCEPT

Failed to accept the transfer connection.”
SOCKNAME

Internal processing error.”
RECV

Failed to receive data over the transfer connection.”
SEND

Failed to send data over the transfer connection.”

286

FTP file transfer error.

290

SNTP access failure.

Further details are provided by the character string that appears after error code 290.

Character String and Details

DORMANT
Internal processing error.”
LINK
Data link is disconnected.
Check the cable connection.

291

SNTP server does not respond.

Further details are provided by the character string that appears after error code 291.

Character String and Details

TIMEOUT
Check that the server is running.”

292

Incorrect SNTP server setting.

Further details are provided by the character string that appears after error code 292.

Character String and Details

HOSTNAME
Failed the DNS lookup (search the IP address corresponding to the host name).
Check the DNS setting and the SNTP server name.

TCPIP
Internal processing error.”

293

Invalid SNTP server reply.

Further details are provided by the character string that appears after error code 293.

Character String and Details

SEND
A correct IP address has not been assigned to the DX.
Check the IP address.
BROKEN
There is a problem with the SNTP server.
If this error occurs even after executing SNTP manually several times, check the SNTP
server.
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10.1 A List of Messages

Code Message
294 No time correction because excess time deviation with SNTP server.
Further details are provided by the character string that appears after error code 294.
Character String and Details
OVER
This error occurs when periodic SNTP is executed by the auto setting of the clock and
the clock is not adjusted because the time difference between the DX and the SNTP
server is greater than or equal to 10 minutes.
Check the time on the DX and the SNTP server.
295 IP address was released because DHCP setting is invalid.
Further details are provided by the character string that appears after error code 295.
Character String and Details
REJECT
Address obtained by DHCP is inappropriate.

296 DHCP access failure.
Further details are provided by the character string that appears after error code 296.
Character String and Details
ESEND
Failed to transmit to the DHCP.
ESERVER
DHCP server not found.
ESERVFAIL
No response from the DHCP server.
ERENEWED
Address renewal rejected.
EEXTENDED
Address lease extension rejected.
EEXPIRED
Address lease period expired.
297 Registration of the hostname to the DNS server failed.
Further details are provided by the character string that appears after error code 297.
Character String and Details

INTERNAL
Failed to register the host name (transmission error, reception timeout, etc.).
FORMERR
Failed to register the host name (format error: DNS message syntax error).
SERVFAIL
Failed to register the host name (server failure: DNS server processing error).
NXDOMAIN
Failed to register the host name (non existent domain).
NOTIMP
Failed to register the host name (not implemented).
REFUSED
Failed to register the host name (operation refused).
YXDOMAIN
Failed to register the host name (name exists).
YXRRSET
Failed to register the host name (RR set exists).
NXRRSET
Failed to register the host name (RR set does not exist).
NOTAUTH
Failed to register the host name (not authoritative for zone).
NOTZONE
Failed to register the host name (different from zone section).
NONAME

Host name not entered on the DX.
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Code

298

Deletion of the hostname to the DNS server failed.

Further details are provided by the character string that appears after error code 298.

Character String and Details

INTERNAL

Failed to delete the host name (transmission error, reception timeout, etc.).
FORMERR

Failed to delete the host name (format error: DNS message syntax error).
SERVFAIL

Failed to delete the host name (server failure: DNS server processing error).
NXDOMAIN

Failed to delete the host name (non existent domain).

NOTIMP

Failed to delete the host name (not implemented).
REFUSED

Failed to delete the host name (operation refused).
YXDOMAIN

Failed to delete the host name (name exists).
YXRRSET

Failed to delete the host name (RR set exists).
NXRRSET

Failed to delete the host name (RR set does not exist).
NOTAUTH

Failed to delete the host name (not authoritative for zone).
NOTZONE

Failed to delete the host name (different from zone section).
NOTLINKED

4Physical layer was disconnected when removing the host name.

Nofte

*1 Contact your nearest YOKOGAWA dealer.
*2 These errors may occur if the network experiences trouble during the data transmission
(bad cable connection, duplicate addresses, network equipment failure).

The FTP client function on the DX has a timer function that drops the connection if there is
no data transfer for two minutes. If the server does not respond within this time period, the
transfer fails.

The FTP client function on the DX overwrites files without a warning if files with the same
name exist at the transfer destination unless the server returns a negative response.
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10.1 A List of Messages

Communication Errors

For information regarding the communication function of the DX, see the Communication
Interface User’s Manual (IM 04L41B01-17E).

. Errors during Setting and Basic Setting Modes, Output Communication
Command Execution, and Setup Data Loading

Code Message

300 Command is too long.

301 Too many number of commands delimited with ;.

302 This command has not been defined.

303 Data request command can not be enumerated with sub-delimiter.
350 Command is not permitted to the current user level.

351 This command cannot be specified in the current mode.

352 The option is not installed.

353 This command cannot be specified in the current setting.

354 This command is not available during sampling or calculating.

. Memory Access Errors during Setting and Basic Setting Modes and Output

Communication Command Execution
An English error message is returned via the communication interface. It is not displayed
on the screen.

Code Message
362 There are no data to send ‘NEXT’ or ‘RESEND’.
363 All data have already been transferred.
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10.1 A List of Messages

. Maintenance and Test Communication Command Errors
An English error message is returned via the communication interface. It is not displayed
on the screen.

Code Message

390 Command error.

391 Delimiter error.

392 Parameter error.

393 No permission.

394 No such connection.

395 Use ‘quit’ to close this connection.
396 Failed to disconnect.

397 No TCP control block.

398 Format error.

. Other Communication Errors
An English error message is returned via the communication interface. It is not displayed
on the screen.

Code Message

400 Input username.

401 Input password.

402 Select username from ‘admin’ or ‘user’.

403 Login incorrect, try again!

404 No more login at the specified level is acceptable.
410 Login successful. (The special user level)

411 Login successful. (The general user level)

420 Connection has been lost.

421 The number of simultaneous connection has been exceeded.
422 Communication has timed-out.
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10.1 A List of Messages

Status Messages

Code Message

500 Execution is complete.

501 Please wait a moment...

503 Data are being saved to media...

504 File is being loaded from media...

505 Formatting...

506 Memory save to media was interrupted.

508 There is no file or directory.

509 Press [DISP/ENTER] key to display file name.
510 Range cannot be changed during sampling or calculating.
511 MATH expression cannot be changed during sampling or calculating.
513 Post process in progress.

514 Now loading historical data.

515 Data save is completed.

516 Files are now being sorted.

520 Connecting to the line...

521 The data file is being transferred.

530 Media can be removed safely.

531 Media was removed compulsorily.

532 USB device has been connected.

533 USB device cannot be recognized.

534 There was no data which is not saved to media.
535 Media was recognized.

536 Media is not recognized.

542 Media read error.

543 Flash write error.

550 The A/D calibration is being executed...

551 FTP test is being executed...

552 E-mail test is being executed...

560 Now connecting to SNTP server...

561 Now adjusting the time.
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Code Message
562 Ethernet cable is disconnected.
Further details are provided by the character string that appears after error code 562.
Character String and Details
ON
Detected that an Ethernet cable was connected.
OFF
Detected that an Ethernet cable was disconnected.
563 The command is sent to DHCP.
Further details are provided by the character string that appears after error code 563.
Character String and Details
RENEW
Requesting address renewal to the DHCP server.
564 The response was received from DHCP.
Further details are provided by the character string that appears after error code 564.
Character String and Details
RENEWED
Address renewal complete.
EXTENDED
Address release extension request complete.
RELEASED
Address release complete.

565 IP address was set.
Further details are provided by the character string that appears after error code 565.
Character String and Details
IPCONFIG
Assigned the IP address.
566 It is a setting that doesn’t register hostname to the DNS server.
Further details are provided by the character string that appears after error code 566.
Character String and Details
NOREQUEST
Configured not to register the host name.
567 The hostname was registered to DNS server.
Further details are provided by the character string that appears after error code 567.
Character String and Details
UPDATE
Registered the host name to the DNS server.
568 The hostname was deleted from DNS server.
Further details are provided by the character string that appears after error code 568.
Character String and Details
REMOVE
Assigned the IP address.
OFF
Removed the host name from the DNS server.
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10.1 A List of Messages

Warning Messages

Code Message Ref. Section
600 Measured data and Settings have been initialized. -

601 Measured data have been initialized. -

610 This usernema is already registered. See section 8.2.
614 Calibration settings are reset because of range setting change. See section 3.9
615 Noise may influence measurement in test mode. See section 3.1

System Errors

Servicing is required when a system error occurs. If this happens, contact your nearest
YOKOGAWA dealer for repairs.

Code Message

901 ROM failure.

902 RAM failure.

910 A/D memory failure for all input channels.
911 Channel 1 A/D memory failure.

912 Channel 2 A/D memory failure.

913 Channel 3 A/D memory failure.

914 Channel 4 A/D memory failure.

921 Channel 1 A/D calibration value error.
922 Channel 2 A/D calibration value error.
923 Channel 3 A/D calibration value error.
924 Channel 4 A/D calibration value error.
930 Memory acquisition failure.

940 The Ethernet module is down.
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10.2 Troubleshooting

Does not function (nothing is displayed).

Is the power switch
turned ON? Does the
switch work properly?

Is the power supply
connected properly?

Is the power

supplied properly? voltage and frequency.

Contact your nearest YOKOGAWA
dealer.

0.G.: Operation Guide

IM 04L41B01-01E
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10.2 Troubleshooting

¢ The error is large.
* The trend or digital values fluctuate.

¢ The trend is off the scale on either the 0% or 100% side.

Does the input meet
the specifications?

NO

YES

Is the range/span
setting appropriate?

NO

YES

Taking measures NO

against noise?

YES

Is the environmental
temperature kept constant?

NO

YES

NO

Is the input wiring correct?

YES

Is the input wiring parallel
with other equipment?

NO

Is the RJC setting correct NO

(TC input)?

YES

Contact your nearest YOKOGAWA
dealer.

Change the input to meet the
specifications.

) Section 12.1

« Adjust the span and range (section 3.3).

« If you use Calibration Correction (/CC1
option), check the set values for
correction points (section 3.9).

KSeparate the input wiring from the \
noise source.

» Ground the recorder.

» Ground the measured object properly.

* Insulate the TC from the measured object.
» Use shielded cables for input.

» Change the integral time of the input
A/D converter (section 3.1).

YES

» Use moving average on the input

k(section 3.4). j

« Attach the input terminal cover properlﬁ

« Protect the input terminal from wind or
fans.

» Keep the temperature fluctuation near
the input terminal to a minimum.

» Wire correctly (O.G.).

« Install the terminal block correctly.

« Fasten the terminal screws correctly.
« Insulate the RTD from the ground.

« If burnt, replace the TC.

» Stop the TC burnout upscale/downscale
function of other equipment.

* Ground the DX and other equipment
at one point.

« Disconnect parallel wiring
(use a double-element TC, for instance

).

Set it correctly. Section 3.2

N S N/

0.G.: Operation Guide
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10.2 Troubleshooting

Display and other functions do not work properly.

(Move the input and communication wires\
away from the noise source.

Taking measures

against noise?
» Ground the recorder.

+ Use shielded cables for input and

YES

communication wires.

* Insert an isolation transformer into the
power line.

* Insert a power line filter into the power line.

« If an inductive load is used in the alarm
output line, insert a serge suppressor in
the line.

- /

Contact your nearest YOKOGAWA
dealer.

Some items on the display selection menu
or FUNC key menu are not displayed.

» Use the customize-menu function to show | Section 5.17
the item on the menu.

» Confirm that the DX is equipped with the

necessary options.

Is the function of the DX
configured properly?

Contact your nearest YOKOGAWA
dealer.

IM 04L41B01-01E 10-17

Bunjooyssjqno.y E



Chapter 11 Maintenance

11.1 Periodic Inspection

Check the operation periodically to keep the DX in good working order.
Perform the following checks and replace worn parts as needed.
 Is the display and storage functioning properly?
If not, see chapter 11, “Troubleshooting” in the DX1000/DX1000N User’s Manual.
» Has the brightness of the LCD backlight deteriorated?
If replacement is necessary, see “Recommended Replacement Periods for Worn

Parts.”
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11.2 Calibrating the DX

It is recommended that the DX be calibrated once a year to assure its measurement

accuracy.

Calibration service is also provided by YOKOGAWA dealers.
For details, contact your nearest YOKOGAWA dealer.

Required Instruments

Calibration instruments with the following resolution are required for calibrating the DX.

Recommended Instruments
+ DC voltage standard:

» Decade resistance box:

» 0°C standard temperature device:

5520A by FLUKE or equivalent

Main specifications

Output accuracy: £(0.005% + 1 pV)

Yokogawa Meters & Instruments Model 2793-01
or equivalent

Main specifications

Accuracy of output range 0.1 to 500 Q: £(0.01%
+2 mQ)

Resolution: 0.001 Q

ZC-114/ZA-10 by Coper Electronics or equivalent
Main specifications

Standard temperature stability accuracy: +0.05°C

For information on purchasing the calibration instruments, contact your nearest

YOKOGAWA dealer.

Calibration Procedure

1. Wire the DX and the calibration instrument as shown in the following figure, and
adequately warm up the instruments (the warm-up time of the DX is at least 30

minutes).

2. Check that the operating environment such as ambient temperature and humidity
is within the standard operating conditions (see section 13.6).

3. Apply appropriate input signals corresponding to 0, 50, and 100% of the input
range and calculate the errors from the readings.
If the error does not fall within the accuracy range of the specifications, contact your nearest

YOKOGAWA dealer.

Note

For thermocouple inputs, you must measure the temperature of the input terminal and apply a
voltage taking into account the reference junction temperature.

DC Voltage Measurement (Example for the DX1012)

0000
o 0 O

(o]

o
DC voltage standard
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11.2 Calibrating the DX

Temperature Measurement When Using an RTD (Example for the DX1012)

The resistance of three lead
i wires must be equal.
Input terminal =

=1

o ¥ L
o)
ou
o))
oo
o)
o)

) Decade resistance box
(Model 2793-01 from Yokogawa
Meters & Instruments Corporation)

Temperature Measurement When Using a Thermocouple (Example for the
DX1012)

Thermocouple wires or TC
Copper wires extension wires

[m} ] a [m} [m} ]
OEONOXONOXO)
cQ O O 0 0O
- Thermocouple
DC voltage standard wires wires

(0 °C standard temperature device ZC-114/ZA-10 by Coper Electronics)

RJC of TC Input
As the measurement terminal of the DX is generally at room temperature, the actual

output of the thermocouple is different from the values given on the thermoelectromotive
force table based on 0°C. The DX performs compensation by measuring the temperature
at the input terminal and adding the corresponding thermoelectromotive force to the
actual output of the thermocouple. Therefore, when the measurement terminal is shorted
(equivalent to the case when the detector tip is 0°C), the measured value indicates the
temperature of the input terminal.

When calibrating the DX, this compensation voltage (thermoelectromotive force of 0°C
reference corresponding to the input terminal temperature) must be subtracted from the
output of the standard generator before application. As shown in the figure, by using the
0°C standard temperature device to compensate the reference junction at 0°C, you can
input the thermoelectromotive force of 0°C reference from the DC voltage standard and
perform the calibration.
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11.3 Pulling Out the Inner Instrument (DX1000N)

The inner instrument of the DX1000N can be pulled out.
Because some areas inside the DX have high voltages, be sure to pull out the inner

instrument correctly. For the procedure, see the Dagstation DX1000/DX1000N/DX2000
Service Manual (SM 04L41B01-01E).

11-4
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Chapter 12 Specifications

12.1 Signal Input and Alarm

Measurement Input

Item

Specifications

Number of inputs, scan interval, and A/D integration time

Model Number of Scan interval
ode inputs Normal mode Fast sampling mode
DX1002, DX1002N 2 125 ms, 250 ms 25ms
DX1004, DX1004N 4
DX1006, DX1006N 6 1s 25,55 125 ms
DX1012, DX1012N 12
Integration time of the A/D converter 60 Hz/50 Hz 60 Hz/50 Hz/100 ms 600 Hz (fixed)

Input Type

DC voltage, 1-5V, thermocouple (TC), resistance temperature detector (RTD), ON/OFF input (DI),
and DC current (by adding an external shut resistor)

Measurement range and measurable range

Input Type Range Measurable Range

DC voltage 20 mV —20.000 to 20.000 mV
60 mV —60.00 to 60.00 mV
200 mV —200.00 to 200.00 mV
2V —2.0000 to 2.0000 V
6V —6.000 to 6.000 V
20V —20.000 to 20.000 V
50V —50.00 to 50.00 V

1-5V 1-5V 0.800 to 5.200 V

Thermocouple| R™ 0.0 to 1760.0°C 32 to 3200°F
s 0.0 to 1760.0°C 32 to 3200°F
B 0.0 to 1820.0°C 32 to 3308°F
K" —200.0 to 1370.0°C —328 to 2498°F
E"1 —200.0 to 800.0°C —328.0 to 1472.0°F
J1 —200.0 to 1100.0°C —328.0 to 2012.0°F
T —200.0 to 400.0°C —328.0 to 752.0°F
N1 0.0 to 1300.0°C 32 to 2372°F
W2 0.0 to 2315.0°C 32 to 4199°F
L3 —200.0 to 900.0°C —328.0 to 1652.0°F
us —200.0 to 400.0°C —328.0 to 752.0°F
WRe™ 0.0 to 2400.0°C 32 to 4352°F

RTD Pt (Pt100)" —200.0 to 600.0°C —328.0 to 1112.0°F
JPt (JPt100)"S | —200.0 to 550.0°C —328.0 to 1022.0°F

DI Level 0: Less than 2.4 V. 1: 2.4V or higher (judged at the 6 V range

Contact

0: Open. 1: Closed (parallel capacitance of 0.01 yF or less)

*1: R, S,B,K,E, J, T, N: IEC584-1 (1995), DIN IEC584, JIS C1602-1995

*2: W: W-5%Re/W-26%Re (Hoskins Mfg. Co.), ASTM E988

*3:  L: Fe-CuNi, DIN43710, U: Cu-CuNi, DIN43710
*4: WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)

*5: Pt100: JIS C1604-1997, IEC751-1995, DIN IEC751-1996

JPt100: JIS C1604-1989, JIS C1606-1989
Measuring current: i = 1mA (Pt100, JPt100)

Thermocouple burnout

Burnout upscale/downscale selectable (for each channel).

Normal: 2 kQ or less., Burnout: 100 kQ or more (parallel capacitance of 0.01 pF or less)
Detection current: Approx. 10 pA

1-5 range burnout

Burnout upscale/downscale selectable (for each channel).

Burnout detection: Greater than “scale upper limit + 10% of scale width* or “scale lower limit — less
than 5% of scale width*

0: Open (100 kQ or greater). 1: Close (1 kQ or less)

TC reference junction compensation
Internal reference junction compensation or external reference junction compensation

Moving average function

Takes the moving average of the input values (for each channel). Moving average data points: 2 to 400

* In fast sampling mode, burnouts on all measurement channels cannot be detected within a scan interval. Burnout may not be
detected until the number of measurements indicated below is carried out if measurement is started in a burnout condition or

after a burnout occurs.

DX1002, DX1004, DX1002N and DX1004N: Up to 4 measurements. DX1006, DX1012, DX1006N and DX1012N: Up to 2

measurements
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12.1 Signal Input and Alarm

Item Specifications
Computation
Difference computation =~ Computable range:  DC voltage, TC, RTD, and DI
Linear scaling Computable range:  DC voltage, TC, RTD, and DI
Scalable range: —30000 to 30000. The decimal place is within 4 digits to the right of the
decimal point.
Unit: 6 digits or less
Over value detection: The value can be set to over value when +5% of the scale range is
exceeded.
Square root computation Computable type: DC voltage
Scalable range and unit: Same as linear scaling
Low-cut: Set the low-cut value in the range of 0.0% to 5.0% of the span.
Over value detection: Same as linear scaling
1-5V Computable range: 1-5
Scalable range and unit: Same as linear scaling
Low-cut: The low-cut point is fixed to the span lower limit.

Over value detection: Same as linear scaling

Alarms

Item Specifications

Number of alarms Up to four alarms (level) for each measurement channels

Alarm type High limit, low limit, difference high limit, difference low limit, high limit on rate-of-change alarm, low
limit on rate-of-change alarm, delay high limit, and delay low limit

Alarm delay time 1 to 3600 s (for each channel)

Rate-of-change calculation interval of rate-of-change alarms
1 to 32 times the scan interval (common to all channels)

Alarm output Output to the internal switch
Number of internal switches: 30
Internal switch operation: AND/OR operation selectable

Hysteresis High and low limit alarm: 0.0 to 5.0% of the span (common to all channels)
Difference high and low limit alarms: 0.0 to 5.0% of the span (common to all channels)

Display Displays the status on the respective operation screen and an alarm icon on the status display
section when an alarm occurs.
Display operation: Hold or not hold the display until the alarm acknowledge operation.

Alarm hide function (alarm no logging function)
Not display alarms nor record to the alarm summary (for each channel)

Alarm information Displays a log of alarm occurrences on the alarm summary.
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12.2 Display Function

Display

Item Specifications

Display* 5.5-inch TFT color LCD (240 x 320 dots)

Brightness 8 levels

Backlight saver function Dim or turn off the LCD backlight if there is no key operation for a specified time.

* A section of the LCD monitor may contain pixels that are always on or off. The brightness of the LCD may also not be uniform
due to the characteristics of the LCD. This is not a malfunction.

Displayed Information

Item Specifications
Display groups Assign channels to groups on the trend display, digital display, and bar graph display and display.
Number of groups 10
Number of channels that can be assigned to each group
Up to six
Display color Channel: Select from 24 colors

Background: Select white or black
Trend display (T-Y display)

Waveform line width Select from 1, 2, and 3 dots
Display method Orthogonal axis display with time axis (T) and measured value axis (Y)
Layout: Vertical, horizontal, wide, or split

Trend interval: Select from 15 s/div (DX1002, DX1004, DX1002N, and DX1004N only) and
available settings between 30 s/div and 10 h/div.
Switchable to the secondary trend interval.

Scale Display a scale for each channel.
Current value bar graph, color scale band, and alarm point marks can be displayed on the scale.
Others Grid (divisions: 4 to 12), trip line (line width: 1, 2, or 3 dots), message, zone display, and partial
expanded display
Digital Display Displays measured values numerically
Update rate 1 s (scan interval if the scan interval is greater than 1 s)
Bar graph display Displays the measured value on a bar graph
Direction Vertical or horizontal
Base position End or center
Update rate 1 s (scan interval if the scan interval is greater than 1 s)
Scale Display a scale for each channel

Color scale band, and alarm point marks can be displayed on the scale.

Historical trend display (T-Y display)
Redisplays the display data or event data in the internal memory or external storage medium.

Display format All screen or half screen (only when the display data is being redisplayed)
Time axis operation Reduce/expand and continuous data display possible.
Add message Messages can be added.
Background color Select from white, cream, black, or light gray.
Overview Display Displays the measured values of all channels and the alarm statuses.

Information display

Alarm summary display  Displays a log of up to 1000 alarms.

Specify an alarm with the cursor and jump to the corresponding section on the trend display.
Message summary display

Time and content of up to 450 messages (including 50 add messages)

Specify a message with the cursor and jump to the corresponding section on the trend display.
Memory summary display Displays the information of the data in the memory.

Specify a file with the cursor and jump to the corresponding section on the trend display.

Save the data in the internal memory to the external storage medium using keys.

Report Displays the report data residing in the internal memory.
Status Display Relay status display: Displays the ON/OFF status of the alarm output relay and internal switch.
Modbus client status: Displays the communication status on the Modbus client

Modbus master condition: Displays the communication status on the Modbus master

Log display Displays the login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP
log, and Modbus log.
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12.2 Display Function

Other Displayed Information

Item Specifications
Tag display Up to 16 alphanumeric characters
Message Write messages to the trend display.
Number of messages 100
Character Up to 32 alphanumeric characters
Write method Write a preset message or write an arbitrary message on the spot.
Write destination Select only the displayed group or all groups.
Auto message Write a message when the DX recovers from a power failure while memory sampling is in progress.
Write a message when the trend interval is switched during memory sampling.
Add message Write messages to the past data positions.
Number of messages 50
Status display section Displays the DX status at the upper section of the display.
Displayed contents Year, month, day, time, displayed group name/display name, user name (when using the login

function), batch name (when using the batch function), internal memory status, external storage
medium status, alarm status, and function usage status (key lock , computation function, and e-mail)

Auto switching of displayed groups
Switches the display group at a given interval.
Interval: Select from the available settings between 5's and 1 min.

Auto recovery display Specify the display to be shown automatically when keys are not operated.
Time until the display switches: Select from the available settings between 1 min and 1 h.

Favorite display Register frequently used displays to the Favorite key and show them through simple operation.
Up 8 displays can be registered.

Language Select English, Japanese, German, French, or, Chinese.

System information display Displays the number of measurement and computation channels, options, remote controller ID,
MAC address, firmware version, and internal memory capacity.

Network information display Displays the DX network setup information.

Display selection menu customization
Show/hide and change the positions of each item in the display menus and sub menus
Insert/delete separators.

FUNC key menu customization
Show/hide and change the display positions of each item.

12-4 IM 04L41B01-01E



12.3 Data Saving Function

Configuration

Item Specifications

Internal memory Temporarily saves various types of data.
Medium Flash memory

External storage medium
Medium CF card (up to 2 GB)
Format FAT32 or FAT16

Data Type

Name Description

Data type (file name extension)
Display data (.DAD), event data (.DAE), and manual sampled data (.DAM)
Screen image data (.PNG), setup data (.PDL), report data (.DAR) (/M1)

Display Data and Event Data

Item Specifications
Internal memory
File storage capacity 80 MB (standard memory) or 200 MB (large memory)

Number of files Up to 400
Operation FIFO (First In First Out)
Display data

Target Measurement/computation input channel

Sampling interval Synchronized to the trend interval.

Description Maximum or minimum value per sampling interval

Data size Measurement input channel data: 4 bytes/data value. Computation channel data: 8 bytes/
data value.

File size Up to 8 MB

Data format Binary

Recording Records data at all times.

Event data

Target Measurement/computation input channel.

Sampling interval Select from the available settings between 25 ms to 600 s.

Description Data per sampling interval

Data size Measurement input channel data: 2 bytes/data value. Computation channel data: 4 bytes/
data value.

File size Up to 8 MB

Data format Binary

Mode Free: Records data at all times.

Trigger: Starts recording data when a certain event occurs and records for the specified interval.

Combinations of saved data Display data only, event data only, or display data and event data.
File size See appendix 1.
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12.3 Data Saving Function

Manual Sampled Data

Item

Specifications

Item
Data format

Measured value at an arbitrary time
ASCII

Maximum number of data values that the internal memory can store

400

Report Data (/M1)

Item

Specifications

Item
Data format

Report at each scheduled time of report
ASCII

Maximum number of reports that the internal memory can store

100

Saving Data to the External Storage Medium

Item Specifications
Data Saving Saves the data in the internal memory to the external storage medium.
Manual save Saves when the external storage medium is inserted with a key operation.
Auto save Display data: Every file save interval
Event data: Every data length

Auto save operation

Manual sampled data: When manual sampling is executed.
Report data: When report is created.

Select “save data only if there is sufficient free space on the CF card” or “constantly retain the most
recent data files in the CF card (media FIFO)” (release number 2 or later).

File name

Select from “sequence number+user-assigned string+date,” “sequence number+user-assigned
string,” or “sequence number+batch name.”

Save destination

Auto save: CF card. Manual save: CF card or USB flash memory (/USB1)
Directory name: Specify using up to 20 characters.

Snapshot Data

Item

Specifications

Item
Data format
Output destination

Displayed screen image data
PNG
CF card or communication output

Setup Data

Item Specifications

Item DX setup data

Data format Binary

File name Specify using up to 32 characters.

Output destination
Load

CF card or USB flash memory (/USB1)
Loadable from a CF card or USB flash memory (/USB1)

Data File Loading

Item Specifications

Function Load and show the display data or event data in a CF card or USB flash memory (/USB1).
Miscellaneous

Item Specifications

Header comment

Add up to 50 characters of comment to display data, event data, manual sampled data, or report
data file.
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12.4 Other Standard Functions

Event Action Function

Item Specifications
Event action Execute a specified operation when a given event occurs.
Number of settings 40
Events Remote control input, etc.
Timer Number of timers: 4
Match time timer Number of timers: 4
Action Specify memory start/stop, alarm ACK, etc.

There are limitations on the combinations of events and actions.

Security Function

Item Specifications
Key lock function Limitations to key operation, access to the external storage medium, and various operations
Login function Allow DX operation to registered users.

System administrators 5 administrators

Users 30 users

Time Related Functions

Item Specifications
Clock With a calendar function
Accuracy +10 ppm (0 to 50°C), excluding a delay (of 1 second, maximum) caused each time the power is
turned on.
Time setting Using key operation, communication command, event action function, or SNTP client function

Time adjustment method
While memory sampling Corrects the time by 40 ms for each second.
Limit in which the time is gradually adjusted: Select from the available settings between 10 s and 5
min.
If the time is outside the limit, the time is immediately corrected.
Cannot be used after hour 0 on January 1st, 2038.
While memory is stopped Immediately change the time.

DST The date/time for switching between standard time and DST can be specified.
Time zone Sets the time difference from GMT.
Date format Select YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY, or DD.MM.YYYY.

Types of Characters That Can Be Handled

Item Specifications

Characters Alphabet characters, numbers, and symbols (limitation exists)
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12.4 Other Standard Functions

Communication Functions

Item Specifications

Electrical and mechanical specifications
Conforms to IEEE 802.3 (Ethernet frames conform to the DIX specification).

Medium Ethernet (10BASE-T)
Implemented protocols TCP, IP, UDP, ICMP, ARP, DHCP, HTTP, FTP, SMTP, SNTP, Modbus, and DX-dedicated protocols
E-mail client Automatically send e-mail at specified times.
FTP client Automatically transfer data files to the FTP server.
Applicable files: Display data, event data, screen image data, and report data
FTP Server Transfer files, delete files, manipulate directories, and output file lists of the DX.
Web server Shows the DX display on a Web browser.
SNTP client Inquires the time to the SNTP server and sets the DX.
Cannot be used after hour 0 on January 1st, 2036.
SNTP server Outputs the DX time.

Time resolution: 5 ms
Cannot be used after hour 0 on January 1st, 2036.

DHCP client Automatically obtain the network address settings from the DHCP server.
Modbus client Reads data from another device and writes to the registers.
Modbus server Outputs the DX data.

Setting/Measurement server Operate, set, and output data of the DX using a dedicated protocol.

Maintenance/test server Outputs connection information and network information.

Instrument information server
Outputs information (serial number, model name, etc.) of the connected DX.

Batch Function

Item Specifications
Function Data management using batch names. Enter text fields and batch comments in the data file.
Batch name Added to the file name of the display data and event data.
Structure Batch number (up to 32 characters) + lot number (up to 8 digits)
Text field Adds text to the display data and event data.
Batch comment Adds text to the display data and event data.
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12.5 Options

Alarm Output Relay (/A1, /A2, and /A3)

Item Specifications

Action Outputs relay contact signals from the terminals on the rear panel when alarms occur.
Number of outputs 2 outputs (/A1), 4 outputs (/A2), and 6 outputs (/A3)

Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)

Output format NO-C-NC

Relay operation Energized/deenergized, AND/OR, hold/non-hold, and reflash settings are selectable.

RS-232 Interface (/C2) and RS-422A/485 Interface (/C3)

Item Specifications

Connection EIA RS-232(/C2) or EIA RS-422A/485(/C3)
Protocol Dedicated protocol or Modbus protocol
Synchronization Start-stop synchronization

Transmission mode (RS-422A/485)
Four-wire half-duplex multi-drop connection (1:N (N = 1 to 32))

Data rate 1200, 2400, 4800, 9600, 19200, or 38400 bps
Data length 7 or 8 bits
Stop bit 1 bit
Parity QOdd, even, or none
Handshaking Off:Off, XON:XON, XON:RS, and CS:RS
Communication distance (RS-422A/485)
1200 m
Modbus communication Operation modes: Master or slave

FAIL/Status Output Relay (/F1)

Item Specifications
FAIL output Relay contact output on CPU error
Relay operation Energized during normal operation and de-energized on system error.
Status output Output a relay contact signal when a selected condition occurs.
Relay operation Relay is energized when a condition occurs.
Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)

Clamped Input Terminal (Detachable) (/H2)

Item Specifications

Input terminal Make the input section clamp input terminals (detachable).
Recommended wire size: 0.08 to 1.5 mm? (AWG 28 to 16)
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12.5 Options

Desktop Type (/H5[ ])

Item

Specifications

Construction

With carrying handle.
/H5D, /H5F, /H5R, /H5J, /H5H: Power Inlet connector. With a power cord.
/H5: Can only be specified when /P1 is simultaneously specified. Screw type power terminal.
Without power cord.

Computation Function (including the report function) (/M1)

Item

Specifications

Number of computation channels
DX1002, DX1004, DX1002N, and DX1004N: 12 channels (101 to 112)
DX1006, DX1012, DX1006N, and DX1012N: 24 channels (101 to 124)

Operation

General arithmetic operations: Four arithmetic operations, square root, absolute, common logarithm,

Relational operations:

Logic operations:

Statistical operations:
Special operations:
Conditional operation:

natural logarithm, exponential, and power
<,%,> 2, = and #

AND, OR, NOT, and XOR

TLOG or CLOG

PRE, HOLD, RESET, and CARRY
[a?b:c]

Computation accuracy

Double-precision floating point for TLOG.SUM and single-precision floating point for all other

computations

Data that can be used
Channel data
Constants

Measurement and computation channels

60 constants

Communication input data24
Remote control input status  0/1 (/R1)
Counts the number of pulses (/PM1)

Internal switch, alarm output relay (/A[ ]), and flags

Pulse input
Status input

Rolling average

Performs moving average on the computed results.

Measurement range

—9999999 to 99999999
Decimal place: 0 to 4 digits to the right of the decimal point

Alarms High limit, low limit, delay high limit, and delay low limit
Hysteresis: High and low limit alarm: 0.0% to 5.0% of the span.

Display Same as the measurement channels

Data saving Same as the measurement channels

Report function

Number of report channels: 12 or 24 (same as the number of computation channels)

Computation types: Average, maximum, minimum, sum, or instantaneous value
Report types: Hourly, daily, hourly + daily, daily + weekly, daily + monthly

Cu10, Cu25 RTD Input/3 Leg Isolated RTD Input (/N1)

Item

Specifications

Measurement/display accuracy
Under standard operating conditions

Input Type Measurement | Accuracy Measurement Accuracy Max.
Range Guaranteed A/D integration time: A/D integration time: | Resolution
Range 16.7 ms or more 1.67 ms
Cu10 (GE) —70 to 170°C
Cu10 (L&N) —75 to 150°C
Cu10 (WEED) —200 to 300°C |—200 to 260°C +(0.4% of rdg + 1.0°C) £(0.8% of rdg + 5.0°C)
Cu10 (BAILEY) -328 to 572°F 0.1°C
Cu10: a = 0.00392 at 20°C _200 to 300°C
Cu10: a =0.00393 at 20°C
Cu25: a = 0.00425 at 0°C +(0.3% of rdg + 0.8°C) +(0.5% of rdg + 2.0°C)

* Measuring currenti =1 mA

Input source resistance

Input source resistance

1 Q or less per wire (The resistance of all three wires must be equal).
Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater)
+(0.2% of range + 2 digits) or less

With variation of 1 Q per wire (resistance of all three wires must be equal): £(0.1% of rdg + 1 digit)

orless

With maximum difference of 40 mQ between wires: Approx. 1 °C
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12.5 Options

3 Leg Isolated RTD Input (/N2)

Specifications

Item

Isolated on each channel.
Applies to DX1006, DX1012, DX1006N, and DX1012N

Input terminal

Extended Input Type (/N3)

Specifications

Item

Measurement/display accuracy
Under standard operating conditions

Pt50

—200.0 to 550.0°C

—328.0 to 1112.0°F

0.3% of rdg + 0.6°C)

+(0.6% of rdg + 3.0°C)

Ni100 (SAMA)

—200.0 to 250.0°C

—328.0 to 482.0°F

+(0.3% of rdg + 2.0°C)

Input Type Measurement Range Measurement Accuracy Max.
AID integration time: AID integration time: | Reso-
16.7 ms or more 1.67 ms lution
Kp vs Au7Fe 0.0to 300.0 K 0to 20K Within £4.5 K Within £13.5 K
20 to 300 K Within 2.5 K Within £7.5 K 01K
PLATINEL 0.0 to 1400.0°C |32 to 2552°F +(0.25% of rdg + 2.3°C) +(0.25% of rdg + 8.0°C)
PR40-20 0.0 to 1900.0°C |32 to 3452°F 0 to 450°C Accuracy not guaranteed | Accuracy not guaranteed
450 to 750°C  |+(0.9% of rdg + 3.2°C) | £(0.9% of rdg + 15.0°C)
TC 750 t0 1100°C _ |+(0.9% of rdg + 1.3°C) | (0.9% of rdg + 6.0°C)
1100 to 1900°C  |(0.9% of rdg + 0.4°C) | £(0.9% of rdg + 3.0°C)
NiNiMo 0.0 to 1310.0°C |32 to 2390°F %(0.25% of rdg + 0.7°C) +(0.5% of rdg + 3.5°C) 0.1°C
W/WRe26 0.0 to 2400.0°C |32 to 4352°F 0 to 400°C +15.0°C +30.0°C ’
400 to 2400°C _ |+(0.2% of rdg + 2.0°C) | (0.4% of rdg + 4.0°C)
Type N (AWG14)|0.0 to 1300.0°C |32 to 2372°F (0.2% of rdg + 1.3°C) +(0.5% of rdg + 7.0°C)

+i
(
+(0.15% of rdg + 0.4°C)
(
(

Ni100 (DIN) —60.0 to 180.0°C |-76.0 to 356.0°F 0.15% of rdg + 0.4°C) +(0.3% of rdg + 2.0°C)
Ni120 —70.0 to 200.0°C |-94.0 to 392.0°F 0.15% of rdg + 0.4°C) +(0.3% of rdg + 2.0°C)
RTD* [J263*B 0.0 t0 300.0 K 0t0 40 K Within £3.0 K Within £9.0 K
40 to 300 K Within 1.0 K Within £3.0 K 01K
Cu53 —50.0 to 150.0°C |-58.0 to 302.0°F | #(0.15% of rdg + 0.8°C) +(0.3% of rdg + 4.0°C)
Cu100 —50.0 to 150.0°C |-58.0 to 302.0°F | #(0.2% of rdg + 1.0°C) +(0.4% of rdg + 5.0°C) | 0.1°C
Pi25 —200.0 to 550.0C |-328.0 to 1022.0°F | +(0.15% of rdg + 0.6°C) +(0.3% of rdg + 3.0°C)

* Measuring currenti =1 mA

Input source resistance Thermocouple input: 2 kQ or less
RTD input: 1 Q or less per wire (The resistance of all three wires must be equal).

Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater)

TC input +(0.1% of rdg + 0.05% of range) or less, excluding the error of reference junction compensation
RTD input +(0.2% of range + 2 digits) or less
Input source resistance
TC input With variation of +1 kQ: £10 pV or less
RTD input With variation of 1 Q per wire (resistance of all three wires must be equal): £(0.1% of rdg + 1 digit)

or less
With maximum difference of 100 mQ between wires: Approx. 1 °C

Remote Control (/R1)

Specifications

Item

Number of input terminals 8

Input type Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input

terminals, and shared common.

Input type and signal level
Voltage-free contact
Open collector

Allowable input voltage

Signal type

Action

Contact closed at 200 Q or less and contact open at 100 kQ or greater.

ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or less
5VDC

Level or edge (250 ms or more)

Executes a specified action by applying a given signal to the remote signal input terminal.

Action type: Action of the event action function

suoneoydadg
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12.5 Options

24 VDC Transmitter Power Supply (/TPS2 and /TPS4)

Item Specifications
Number of loops 2 (/TPS2) or 4 (/TPS4)
Output voltage 22.8 to 25.2 VDC (under rated load current)

Rated output current
Max. output current

4 to 20 mADC
25 mADC (overcurrent protection operation current: approx. 68 mADC)

Allowable conductor resistance

Max. length of wiring
Insulation resistance
Dielectric strength

RL < (17.8 — minimum transmitter operation voltage)/0.02 A

where 17.8 V is the result obtained by subtracting the maximum drop voltage of 5 V when the load
shunt resistance is 250 Q from the minimum output voltage of 22.8 V

2 km (when using the CEV cable)

20 MQ or more at 500 VDC between output terminal and ground

500 VAC (50/60 Hz, | = 10mA) for one minute between output terminal and ground
500 VAC (50/60 Hz, | = 10mA) for one minute between output terminals

Easy Text Entry (/KB1 and /KB2)

Item

Specifications

Remote control terminal (438227)
Operating temperature range

0to 40°C

Operation humidity range 20% to 80% RH (at 5 to 40°C no condensation)

Power supply
Weight
External dimensions
Signal
Combination with the DX

3 VDC AA dry batteries x 2

Approx. 60 g (excluding the batteries)
170 (H) x 50 (W) x 23.7 (D) mm
Infrared

Number of units that can be controlled individually

Up to 32 units by setting the ID number

Communication distance Up to 8 m from the front of the light receiving section of the DX (reference value)*

Directional characteristics

See the figure below (reference characteristics)*

* Varies depending on the operating environment such as the battery voltage and the presence or
absence of external light.

Standard accessories (/KB1)

Horizontal
00

Remote control unit, two alkaline dry batteries, and ID number label

15 10 5 11 5 10
Distance (m)

Vertical
00
-30° 30°
602, 0 ©
-90% 90°
15 15 10 5 11 5 10 15

Distance (m)

USB Interface (/USB1)

Item

Specifications

USB port

Complies with Rev. 1.1 and host function

Number of ports

2 (one each on the front panel and rear panel)

Power supply

5V, 500 mA (per port)
Devices which need more than 500 mA total bus power for 2 ports can not be connected at the
same time.

Connectable devices
Keyboard

External medium

Only connect the devices listed below to prevent damage to the devices.

Complies with HID Class Ver. 1.1

104 keyboard (US) and 109 keyboard (Japanese)

Number connectable units: 1

USB flash memory (up to 2 GB)

Does not guarantee the operation of all USB flash memories.

External medium such as a hard disk, ZIP, MO, and optical discs are not supported.
Number connectable units: 1

12-12
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12.5 Options

Pulse Input (/PM1)

Item Specifications
Pulse input
Number of inputs 3 (8 when using the remote control input terminals)
Input type Isolated from the main circuitry through a photocoupler and built-in isolated power supply for the

input terminals.
Shared common for pulse inputs.
Input type and signal level Voltage-free contact Contact closed at 200 Q or less and contact open at 100 kQ or greater
Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when
OFF: 0.25 mA or less
Counting Counts the rising edges of pulses.
For voltage-free contact input: Contact open to contact close
For open collector: Voltage level of the terminal H from high to low
Allowable input voltage 30 VDC
Max. sampling pulse period 100 Hz

Minimum detected pulse width
5 ms or more for both low (closed) and high (open)

Pulse detection period Approx. 3.9 ms (256 Hz)

Pulse measuring accuracy +1 pulse
Remote control Number of inputs: 5. Same as remote control (/R1) for the other specifications
Computation function Same as the computation function (/M1)

Calibration Correction (/CC1)

Item Specifications

Calibration correction method
Corrects the measured value of each channel using segment linearizer approximation.

Number of segment points: 2 to 16 (including the start and end points)

DC/AC 24 V power supply (/P1)

Item Specifications

Rated supply voltage 24 VVDC and 24 VAC (50/60Hz)
Allowable power supply voltage range
21.6V to 26.4 VDC/AC

Insulation resistance Between power terminal and earth: 20 MQor greater at 500 VDC.
Withstand voltage Between power terminal and earth: 500 VAC at 50/60 Hz for one minute
Rated power supply frequency (for AC)

50/60 Hz

Allowable power supply frequency range (for AC)
50 Hz 2%, 60 Hz +2%
Power supply fluctuation (for AC)
With variation within 21.6 to 26.4 VDC/AC: +1digit or less
With variation of +2 Hz from rated power supply frequency (at 24 VAC): +(0.1% of rdg+1digit) or less
Rated power consumption 28 VA (for DC), 45 VA (for AC)
Power consumption

Supply voltage LCD backlight off Normal Maximum
24 VDC 8 VA 15 VA 28 VA
24 VAC (50/60Hz) 15 VA 24 VA 45 VA
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12.6 General Specifications

Construction

Item Specifications

Mounting Flush panel mounting (on a vertical plane) (excluding the desktop type)

Mounting angle Inclined backward up to 30 degrees from a horizontal plane.

Allowable panel thickness 2 to 26 mm

Material Case: Metal plate
Bezel and display cover: Polycarbonate

Color Case: Grayish blue green (Munsell 2.0B5.0/1.7 or equivalent)
Bezel: Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)

Front panel Water and dust proof: Complies with IEC529-1P65 and NEMA No.250 TYPE 4 (except External Icing
Test) (Style number 2 or later), except side-by-side mounting

External dimensions 144 (W) x 144 (H) x 229 (D) mm (D: depth from the panel mounting plane)

Weight DX1000: Approx. 2.9 kg excluding options, DX1000N: Approx. 3.7 kg excluding options

Normal Operating Conditions

Item Specifications

Supply voltage 90 to 132, 180 to 250 VAC

Power supply frequency 50 Hz £ 2%, 60 Hz + 2%

Ambient temperature 0to 50°C

Ambient humidity 20 to 80%RH (at 5 to 40°C), 10 to 50% (at 40 to 50°C)
Vibration 10 to 60 Hz, 0.2 m/s?

Shock Not allowed

Magnetic field 400 A/m or less (DC and 50/60 Hz)

Noise Normal mode (50/60 Hz)

DC voltage The peak value including the signal must be less than 1.2 times the measuring range.

Thermocouple The peak value including the signal must be less than 1.2 times the measuring thermal
electromotive force.

RTD 50 mV or less
Common mode noise 250 VACrms or less for all ranges (50/60 Hz)
Maximum noise voltage between channels
250 VACrms (50/60 Hz) or less

Mounting position Can be inclined up to 30 degrees backward. Left and right horizontal.
Warm-up time At least 30 minutes after power on

Installation location Indoors

Operating altitude 2000 m or less

Power Supply

Item Specifications

Rated supply voltage 100 to 240 VAC

Allowable power supply voltage range
90 to 132, 180 to 264 VAC
Rated power supply frequency 50 Hz, 60 Hz

Power consumption Supply voltage LCD backlight off Normal Maximum
100 VAC 15 VA 24 VA 45 VA
240 VAC 25 VA 32 VA 60 VA

Allowable interruption time  Less than 1 cycle of the power supply frequency

Isolation
Item Specifications
Insulation resistance Between the Ethernet, RS-422A/485, and insulation terminals and earth: 20 MQ or greater at 500 VDC
Withstand voltage Between the power terminal and earth: 2300 VAC at 50/60 Hz for one minute
Between the contact output terminal and earth: 1600 VAC at 50/60 Hz for one minute
Between the measurement input terminal and earth: 1500 VAC at 50/60 Hz for one minute
Mutually between measurement input terminals: 1000 VAC (50/60 Hz) for one minute (excluding
the RTD input terminal of DX1006, DX1012,
DX1006N and DX1012N)
Between the remote input terminal and earth: 1000 VDC for one minute
Between the pulse input terminal and earth: 1000 VDC for one minute
Ground Grounding resistance: 100 Q or less
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12.6 General Specifications

Transport and Storage Conditions

Item

Specifications

Ambient temperature

Ambient humidity
Vibration
Shock

—251t0 60°C
5 to 95%RH (no condensation)
10 to 60 Hz, 4.9 m/s*> maximum

392 m/s? maximum (in packaged condition)

Supported Standards

Item Specifications
CSA CSA22.2 No.61010.1, installation category 11", and pollution degree 22
UL UL61010B-1 (CSA NRTL/C)
CE
EMC directive EN61326 compliance (Emission: Class A, Immunity: Annex A)

Low voltage directive

C-Tick

EN61000-3-2 compliance
EN61000-3-3 compliance
EN55011 Class A Group 1

EN61010-1, measurement category II*3, pollution degree 2
AS/NZS CISPR11 compliance, Class A Group 1

*1 Installation category (overvoltage category) II: Describes a number which defines a transient overvoltage condition. limplies
the regulation for impulse withstand voltage. “II” applies to electrical equipment which is supplied from the fixed installation like
a distribution board.

*2 Pollution degree 2: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface
resistivity is adhering. “2” applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.

*3 Measurement category II: Applies to measuring circuits connected to low voltage installation, and electrical instruments
supplied with power from fixed equipment such as electric switchboards.

Standard Performance

Item

Specifications

Measurement/display accuracy

Standard operating conditions:
Temperature:
Humidity:

Power supply voltage:

23+2°C
55% + 10%RH
90 to 132 or 180 to 250 VAC

Power supply frequency: 50/60 Hz + 1%

Warm-up time:

At least 30 minutes.

Other ambient conditions such as vibration should not adversely affect the operation.

Input Type Range Measurement Accuracy (Digital Display) Max. Resolution of
A/D integration time: 16.7 ms or more A/D integration time: 1.67 ms Digital Display
20 mV +(0.05% of rdg + 12 digits) +(0.1% of rdg + 40 digits) 1V
ggomn\]/v +(0.05% of rdg + 3 digits) +(0.1% of rdg + 15 digits) 18 ﬁx
2V +(0.05% of rdg + 12 digits) +(0.1% of rdg + 40 digits) 100 pVv
DC voltage 15V 1Tmv
g(;/v +(0.05% of rdg + 3 digits) +(0.1% of rdg + 15 digits) 1 xx
50 V 10 mV
R +(0.15% of rdg + 1°C) +(0.2% of rdg + 4°C)
R,S 0to 100°C: £3.7°C, R,S 0to 100°C: +10°C,
S 100 to 300°C: £1.5°C 100 to 300°C: #5°C
B 400 to 600°C: +2°C, B 400 to 600°C: +7°C,
B Accuracy not guaranteed for Accuracy not guaranteed for
values less than 400°C values less than 400°C
K +(0.15% of rdg + 0.7°C) +(0.2% of rdg + 3.5°C)
Thermocouple —200 to —100°C: +(0.15% of rdg + 1°C) —200 to —100°C: +(0.15% of rdg + 6°C)
(excluding E +(0.15% of rdg + 0.5°C) +(0.2% of rdg + 2.5°C)
RJC J —200 to —100°C: +(0.15% of rdg + 0.7°C) —200 to —100°C: #(0.2% of rdg + 5°C) 0.1°C
accuracy) T
N +(0.15% of rdg + 0.7°C) +(0.3% of rdg + 3.5°C)
W +(0.15% of rdg + 1°C) +(0.3% of rdg + 7°C)
L +(0.15% of rdg + 0.5°C) +(0.2% of rdg + 2.5°C)
U —200 to —100°C: +(0.15% of rdg + 0.7°C) —200 to —100°C: #(0.2% of rdg + 5°C)
WRe +(0.2% of rdg + 2.5°C) +(0.3% of rdg + 10°C)
0 to 200°C: +4.0°C 0 to 200°C: +18.0°C
RTD 5’;2’80 +(0.15% of rdg + 0.3°C) +(0.3% of rdg + 1.5°C)

IM 04L41B01-01E
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12.6 General Specifications

Item Specifications
Measuring accuracy in case of scaling
Accuracy during scaling (digits) = measurement accuracy (digits) x multiplier + 2 digits (rounded up)
*  Fractions rounded up
where the multiplier = scaling span (digits)/measuring span (digits).
Example For 1-5V range (A/D integration time is 16.7 ms or more), measurement span of 1.000 to
5.000 V, and scaling span of 0.000 to 2.000
The measuring accuracy for 5 V input is as follows.
Measuring accuracy (1-5 Vrange) = £(0.05% x 5 V + 3 digits) = +(0.0025 V [3 digits] + 3
digits) = 6 digits
Multiplier = {2000 digits (0.000 to 2.000)}/4000 digits (1.000 to 5.000) = 0.5
Thus, accuracy during scaling = (6 x 0.5 + 2) digits = 5 digits (rounded up)
Reference junction compensation accuracy
When measuring temperature greater than or equal to 0 °C and when input terminal temperature is balanced

Type R, S, B, W, WRe: +1.0°C
Type K, J, E, T, N, L, and U: £0.5°C. Type B: Internal reference compensation is fixed to 0°C
Maximum input voltage 160 VDC (continuous)
Input resistance 200 mV range or less and TC: 10 MQ or more
2V range or higher: Approx. 1 MQ
Input source resistance
Volt, TC 2KkQ orless
RTD input 10 Q or less per wire (The resistance of all three wires must be equal).
Bias current 10 nA or less (except when burnout detection function is enabled)

Maximum common mode noise voltage
250 VACrms (50 Hz/60 Hz)
Maximum noise voltage between channels
250 VACrms (50 Hz/60 Hz)
Interference across channels 120 dB (when the input source resistance is 500 Q and the input to other channels is 60 VDC)
Common mode rejection ratio
When the A/D integration time is 20 ms
120 dB (50 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)
When the A/D integration time is 16.7 ms
120 dB (60 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)
When the A/D integration time is 1.67 ms
80 dB or higher (50/60 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)
Normal mode rejection ratio
When the A/D integration time is 20 ms
40 dB or more (50/60 Hz + 0.1%)
When the A/D integration time is 16.7 ms
40 dB or more (60 Hz + 0.1%)
When the A/D integration time is 1.67 ms
Not reject 50/60 Hz

Effects of Operating Conditions

Item Specifications
Ambient temperature (applies when the A/D integration time is 16.7 ms or greater)
DC voltage, TC range With temperature variation of 10°C: +(0.1% of rdg + 0.05% of range) or less
*  Excluding the error of reference junction compensation
RTD range +(0.1% of rdg + 2 digits) or less
Power supply fluctuation With variation within 90 to 132 V and 180 to 250 VAC (50/60 Hz):
Accuracy specifications are satisfied.
With variation of +2 Hz from rated power frequency (power supply voltage 100 VAC):
Accuracy specifications are satisfied.

Magnetic field AC (50/60 Hz) and DC 400 A/m fields: +(0.1% of rdg + 10 digits) or less
Input source resistance
DC voltage range With variation of +1 kQ:

200 mVrange or less:  +10 pV or less
2V range or higher: +0.15% of rdg or less

TC range With variation of +1 kQ: +10 pV or less
RTD range (Pt100) With variation of 10 Q per wire (resistance of all three wires must be equal): £(0.1% of rdg + 1 digits) or less
With maximum difference of 40 mQ between wires: Approx. 0.1 °C
Effects of vibration Effects from a sinusoidal vibration along all three axis at a frequency between 10 to 60 Hz and an

acceleration of 0.2 m/s?: +(0.1% of rdg + 1 digit) or less

Miscellaneous
Item Specifications
Memory backup A built-in lithium battery backs up the settings and runs the clock

Battery life: Approximately 10 years (at room temperature)
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12.7 External Dimensions

See the DX1000/DX1000N Operation Guide (IM04L41B01-02E).
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Appendix

Appendix 1 File Size of Display Data and Event Data

This section explains how to calculate the file size of display data files and event data
files. The calculation examples are given for the display data only and event data only
cases. If you are recording both display and event data, calculate the data size of each
and add them together.

Use the calculated file size as a rough guide.

File Size
A file consists of the following data.

Information other than the sampled data + the sampled data
The maximum size of a single display data file or event data file is 8 MB.

Size of Information Other Than the Sampled Data
Item Size [Bytes]
File header 216
Channel information  [88xN + 28
Group information 96x10 + 28 = 988
Message information |104*50 + 28 (an add message area is reserved by default)
Batch information 832
Sampled data header |80 + 32 + Nx4 + 2 + 18
Message information |Up to 104x1050 (varies depending on the number of messages)
Alarm information Up to 32x5000 (varies depending on the number of alarms)
N is the number of channels (measurement channels + computation channels).

Example 1: If display data of 12 measurement channels and 24 computation
channels is recorded. There are no messages or alarms.

216 + (88x36 + 28) + 988 + (104x50 + 28) + 832 + (80 + 32 + 36%4 + 2 + 18)
= 9,688 bytes

Sampled Data Size
¢ Data Size of Display Data and Event Data

Channel Display Data Event Data
Measurement channel 4 bytes/channel 2 bytes/channel
Computation channel 8 bytes/channel 4 bytes/channel

Time data common to all channels is added for each sample.
|Time data |8 bytes/sample

¢ Data Size per Sample
Display Data
(Number of measurement channelsx4 bytes) + (number of computation channelsx8
bytes) + 8 bytes (time data)

Event Data
(Number of measurement channelsx2 bytes) + (number of computation channelsx4
bytes) + 8 bytes (time data)

IM 04L41B01-01E App-1
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Appendix 1 File Size of Display Data and Event Data

e Sampled Data Size per File
Display Data
Data size per samplexfile save interval/sampling interval
The sampling interval is determined by trend interval (s)/30.

Example 2: If the display data of 12 measurement channels and 24 computation
channels is recorded with a trend interval of 30 min/div (the sampling interval of
display data is 60 s) and a file save interval of 1 day (24 h)

(12x4 bytes + 24x8 bytes + 8 bytes)x24 hx60x60/60 s
= 248 bytesx24 hx60x60/60 s
= 357,120 bytes

Event Data
Data size per samplexdata length/sample rate

Example 3: If the event data of 12 measurement channels and 24 computation
channels is recorded with a sample rate of 1 s and data length of 2 h

(12x2 bytes + 24x4 bytes + 8 bytes)x2 hx60x60/1 s
= 128 bytesx2 hx60x60/1 s
= 921,600 bytes

Size per File
The size per file is the sum of the size of information other than the sampled data and the
size of the sampled data.

Display Data

Example 4: If recording under the conditions of examples 1 and 2

From examples 1 and 2, we obtain 9,688 + 357,120 = 370,352 bytes = 0.350 MB

Event Data
Example 5: If recording under the conditions of examples 1 and 3
From examples 1 and 3, we obtain 9,688 + 921,600 = 934,832 bytes = 0.888 MB
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Appendix 1 File Size of Display Data and Event Data

Save Duration to the CF Card

We will estimate the duration over which measured data can be saved to a CF card when
measured data is being saved automatically.
Display Data
Save duration to the CF card (estimate) = (Size of the CF card/size of a file)x[file save
interval]
Example 6: We will estimate the save duration to the CF card under the conditions
of examples 1 and 2. In this example, the size of the CF card is assumed to be 256
MB.

256 MB/0.350 MBx24 h
=17,554 h
=731 days

Event Data
Save duration to the CF card (estimate) = (Size of the CF card/size of a file)x[data
length]
Example 7: We will estimate the time until the CF card needs to be replaced
under the conditions of examples 1 and 3. In this example, the size of the CF card is
assumed to be 256 MB.

256 MB/0.888 MBx2 h
=576 h
= 24 days

Time until the Internal Memory Becomes Full

If you are manually saving the measured data in the internal memory, old data is
overwritten when the internal memory is full. You must save the measured data to the CF
card before the data is overwritten.
Display Data
Time until the internal memory becomes full (estimate) = (Size of the internal memory/
size of a file)x[file save interval]
Example 8: We will estimate the time until the internal memory becomes full under
the conditions of examples 1 and 2. In this example, the internal memory is assumed
to be of a standard type (80 MB).

80 MB/0.350 MBx24 h
=5,485h
= 228 days

Event Data
Time until the internal memory becomes full (estimate) = (Size of the internal memory/

size of a file)x[data length]

Example 9: We will estimate the time until the internal memory becomes full under
the conditions of examples 1 and 3. In this example, the internal memory is assumed
to be of a standard type (80 MB).

80 MB/0.888 MBx2 h
=180 h
=7.5 days
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Appendix 2 Types of Data That the DX Can Create
and Their Application

This section explains the types of data that the DX can create and their application.

Data Type In the DX Extension Format Display Method"

DX DAQ Application
Display data Yes DAD Binary (undisclosed) Yes Yes Yes*®
Event data Yes DAE Binary (undisclosed) Yes Yes Yes*®
Report data Yes DAR ASCII (see appendix 3) Yes Yes Yes
Manual sampled data Yes DAM ASCII (see appendix 3) - - Yes
Setup data Yes PDL Binary (undisclosed) Yes Yes -
Snapshot data None PNG PNG (general format) - - Yes

1 DX: DX main unit, DAQ: DAQSTANDARD, Application: Software application

2 The data format can be converted on DAQSTANDARD and displayed on a software
application such as Microsoft Excel.

3 The data can be retrieved from the DX using the communication function and displayed on a
software application.
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Appendix 3 Data Format of ASCII Files

This section explains the format of ASCII files. The ASCII files that the DX can create are
manual sampled data files and report files.
In the explanation below, CRLF represents a terminator.

Format of the Manual Sample Data File
» The manual sampled data is output using numerical values and strings in ASCII format

delimited by tabs.

» Values of measurement channels set to Skip and computation channels set to Off are

not output.

» The data is appended to the file each time manual sample operation is performed.

Format
YRECCRLF
Manual Sample Data Version 1.00.00 CRLF
Model DX1000 CRLF
Language Code shift-JIS CRLF
File Status ffffffff CRLF
Serial No. IIT---1I CRLF
File Header HHH- - -H CRLF
Ch cccecece cceccece ccccece CRLF
Tag ttt---t ttt---t ttt---t CRLF
Unit uuuuuu uuuuuu uuuuuu CRLF
yyyy/mo/dd hh:mi:ss nnn---n nnn---n s nnn- - -n CRLF
TEFfEELE File status (8 characters)
Complete Completed
Progress Data being added
Decrease Defective
IT1T---1 Serial number of the DX (16 characters)
HHH: - -H File header (50 characters)
cccce Channel number (5 characters)
ttt---t Tag (16 characters)
uuuuuu Unit (6 characters)

yyyy/mo/dd hh:mi:ss

nnn---n

Sampling year, month, day, and time (19 characters)
Measured value (13 characters)
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Appendix 3 Data Format of ASCII Files

YREC

File Output Example
Below is a manual sample data example of channels 1, 2, 3, and 4.

Manual Sample Data

Model
Language Code
File Status
Serial No.
File Header
Ch

Tag

Unit

2005/10/01 08:57:22
2005/10/01 08:57:28

Version 1.00.00

DX1000

shift-JIS

Progress

S5E701600

CHOO1 CHO002 CHO003 CHO04

TI-101 oUT-102 FI-103 VA-204

~C \Y% m3/h %

213.8 0.517 368.4 68.9

208.6 0.494 363.0 68.1

Nofte
« Output when error data, overrange data, or computation overflow data is detected

Channel Data Output

Measurement channels Error (Space)
+over range (includes burnout detection) 99999
—over range (includes burnout detection)  —99999

Computation channel Error 999999999
Positive computation overflow 999999999
(when the value exceeds 3.4E + 38)
Negative computation overflow —-999999999

(when the value falls below —3.4E + 38)

A new manual sampled data file is created in the following cases.
* A measurement channel is changed to Skip from a range other than Skip.
* A measurement channel is changed from Skip to a range other than Skip.
» A computation channel is changed from On to Off or Off to On.

* The unit is changed.

App-6
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Appendix 3 Data Format of ASCII Files

Report File Format

The hourly, daily, weekly, and monthly reports are output using numeric values and

strings in ASCII format delimited by tabs.

» Values of measurement channels set to Skip and computation channels set to Off are
not output.

» The data is appended to this file every time a report is created.

Format
YRECCRLF
Report Data Version 1.00.00 CRLF
Model DX1000 CRLF
Language Code shift-JIS CRLF
File Status ffffffff CRLF
Serial No. IIT---1 CRLF
File Header HHH---H CRLF
Report Set RRR- - R CRLF
File Data rrr---r CRLF
Math Set MMM MMM MMM MMMM CRLF
Start Time YYYY/MO/DD HH:MI:SS CRLF
Ch ccccce ccccce s ccccece CRLF
Tag ttt-e--t ttt---t ttt---t CRLF
Unit uuuuuu uuuuuu cee uuuuuu CRLF
Data Type Sss***S CRLF
Time yyyy/mo/dd hh:mi:ss CRLF
Status eceeeeeeeee CRLF
Ave nnn---n nnn---n nnn---n CRLF
Max nnn---n nnn---n nnn---n CRLF
Min nnn---n nnn---n nnn---n CRLF
Sum nnn---n nnn---n nnn---n CRLF
fEffffff File status (8 characters)
Complete Completed
Progress Data being added
Decrease Defective
III---1 Serial number of the DX (16 characters)
HHH- - -H File header (50 characters)
RRR- - *R Report setting (setting on the DX) (13 characters)
Hourly
Daily
Hourly+Daily
Daily+Weekly
Daily+Monthly
rrr---r Contents of the report file (13 characters)
Hourly
Daily
Hourly+Daily
Daily+Weekly
Daily+Monthly

Example:  When the DX is set to Hourly+Daily and
Combine, Hourly+Daily is output.
When the DX is set to Hourly+Daily and
Separate, the hourly report is output as Hourly,
and the daily report as Daily.
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Appendix 3 Data Format of ASCII Files

YREC

Report Data
Model
Language Code
File Status
Serial No.
File Header
Report Set
File Data
Math Set
Start Time
Ch

Tag

Unit

Data Type
Time

Status

Ave

Max

Min

Sum

MMMM

YYYY/MO/DD HH:MI:SS
CcCCcccc

ttt-- -t

uuuuuu

ceeeeeeeee

SSS---S

yyyy/mo/dd hh:mi:ss

nnn---n

File Output Example

Report items (16 characters (including tabs that are counted
as one character each), up to four types)

Ave

Max

Min

Sum

Inst Instantaneous value

Report start year, month, day, and time (19 characters)
Channel number (5 characters)

Tag (16 characters)

Unit (6 characters)

Status (output the events that occurred while creating report
data) (10 characters)

Bo Burn out detected

Er Error (error detection)

ov Over (overrange/computation overflow detection)
Pw Power failure (power failure occurrence)

Cg Change (time change present)

Report type (7 characters)

Hourly

Daily

Weekly

Monthly

Report year, month, day, and time (19 characters)
Average, maximum, minimum, sum, or instantaneous value
(13 characters)

Below is an example of an hourly report of 4 channels while creating hourly and daily
reports and saving each type of report to a separate file.

Version 1.00.00

DX1000
shift-JIS
Complete
S5E701600

Hourly+Daily
Hourly
Ave

2005/10/01 08:10:56

CHOO1
TI-101
e
Hourly

2005/10/01 09:00:00

91.5

259.8

-59.9
3.293636E+05

Max Min Sum
CHO02 CHO03 CHOO04
ouUT-102 FI-103 VA-204
v m3/h %
-0.039 241.1 48.6
0.726 416.5 76.6
-0.727 83.4 23.3

-1.392980E+02 8.680871E+05 1.748983E+05

App-8
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Appendix 3 Data Format of ASCII Files

Note

.

When the channel data is in the condition shown in the table below, the Ex, Ov, or Bo status

is output to a report.

Data Condition Status
Error Er
Measurement channels
Positive over range ov
Negative over range ov
Burn out detection Bo
Computation channels
Positive computation overflow (when the value exceeds 3.4E + 38) ov

Negative computation overflow (when the value falls below —3.4E + 38) ov

The report output value of Ave, Max, Min, Sum, and Inst varies depending on the channel

data condition as shown in the table below.

Item Data Condition of Measurement Channels Report
Output Value

Ave When all of the data are errors or over range (Space)
Max, * When all of the data are errors (Space)
Min, » For +over range (includes burnout detection) 99999

Inst » For —over range (includes burnout detection) -99999
Sum * When all of the data are errors or over range (Space)

* When the sum value exceeds approx. 3.4E + 38 9.999999E+99

* When the sum value is below approx. —3.4E + 38

—9.999999E+99

Item Data Condition of Computation Channels Report
Output Value
Ave When all of the data are errors or computation overflow  (Space)
Max, * When all of the data are errors (Space)
Min, * When the maximum value or instantaneous value 999999999
exceeds 99999999
Inst * When the minimum value or instantaneous value is —999999999
less than —9999999
Sum » When all of the data are errors or computation overflow (Space)
* When the sum value exceeds approx. 3.4E + 38 9.999999E+99
* When the sum value is below approx. —3.4E + 38 —9.999999E+99

* The decimal place that was specified when the span for the channel was specified

applies to the maximum and minimum values or the instantaneous values. For example,
if the span setting of the channel is “200.0,” then “999999999"” is output when the value
exceeds “9999999.9” and “—999999999” is output when the value is below “~999999.9.”
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A

A/D integration time ...........oooiiiiiiiii e 3-1
ABS

absolute time Mode ..o 1-32
ACHION L. 1-33
added MESSAGES .....veeviiiiieeciiieeiee e 1-14
administrator.. .1-36, 8-5
alarm.............. .1-4, 12-2
AlarM ACK .. 1-6, 3-14
alarm acknowledge. ...t 1-6
alarm acknowledge operation............ccceevieiiiiiiceiiiic e 3-14
alarm delay time ............cc........ 3-13, 9-3
alarm hide function ... 1-5
alarm indication ... 1-5, 3-7
alarm mark indication ...........ccccoiiiiiiiii e 5-14
alarm output relay

alarm point Mark........coocoueiiiee e
alarm SEttiNgS ......ooviiiieii e
alarm SUMMANY ........oociieiiieie e

AlarmM ValUE ...

all channel display ...

all data display.........coceeiiiiiiiie
AND ..o
AND/OR.........

auto increment..

auto logout........ccceeeueee.

automatic message Writing .........oooveriieieiiiiiiicce e 1-10
AUEO SAVE ...t 1-26, 6-5
B

background COIOr ...........oiiiiiiiiiiie e

background color (historical trend).
backlight Saver............cccciiiiiii
bar graph display ...........cooiiiiiiiie e
base position (bar graphs).
batch comment..
batch function ... .
batch name............cocciii
batch NUMDET ...

brightness......
burnout ....... .
burnout Detection ...........ccoceiiiiiiiiie e

c

calculate the file Size ..........ooooveiiiiiii
calibration...................
calibration correction ..

Change MESSAGE ......eeiiiiiiiiiiie et
channel (computation)
channel display colors ...
Channel NUMDET .........coiiiiiii e
clamped input terminal ..........c.oooiiiiiiiiei e

CLOG comMpUtatioNn.........coiuiiiiiiiieiie e

color scale band .........cocceiiiiiiniii e
communication errors
communication funCtions............cccoevieiiiiiiie 12-8
COMMUNICALION 10G. .. .eiiiiiiiiiiiee e
computation channel
computation data dropout...............ccceeviiiiiiniiiiiienns 1-39, 9-14
COMPULALION EITOT ..o
computation function ..........cccceeeiii i
computation tyPes .......ccoviiiiiiiiiii e
conditional expression .
configuration (StOrage).........ccoecvveriiiiieiiiec e
CONSrUCtion (DX).....cocuiiiieiiiiiei e
continuing data.................
count (moving average)...
Cu10, Cu25 RTD input.... .
current value display.........ccooueeeiieieiiiie e
CUIrent value mark.........cooeoviieiiiiie e
cursor (historical trend)............cccociiinenne.

customizing the display selection menus
customizing the FUNC key menus............
customizing the menus..........c.ccocoiiiiiiiie

D

data display SeCON .........coiiiiiiiiie e 1-7
data kind....
datalength.......ccccooiiiiiiiiiniiie ...6-3
data that can be used in equations...........cccccooiiiiiiiiiine. 1-39
data that the DX can create..........ccccceeeeviiiiiiieec e App-4
data type....ccccoeviiiiiiiien.

data types.
date/time...
date format
daylight savings time ... 2-1
de-energize .
delay high limit alarm..........cccooiiiiiie
delay low limit alarm ...
deleting @ file .......oooiiiiiii
AESKEOP tYPE ..ttt
detect (alarm hide function) .
DHCP 10ttt ettt
difference computation ...........ccceoiiiiiiiiiiic
difference lower limit alarm.....
difference upper limit alarm ....
digit (scale value)................
digital diSplay .........ccoeeiiiiiiiiie e 1-12, 4-3
directory (data Save).........cccceiieiiiiiiei e 1-26
display (LCD).......cocveeneeene
display color (channels)...
display color (messages)....
display data .........cccooeveeiiiiini 1-211-47, 1-23, 12-5
display direction (bar graphs) .........cccccceiiiierinieeiieeceee 5-19
display direction (messages) .
display direction (trend) ........ccoceeriiiiieiiiee e
displayed information............cccceiiiiiiiiiine e
displayed [anguage...........cooouvieiiiiiiiee e
AISPlAY GrOUP ...t
display menu .
display selection menu ...........ccocvieiiiiiiniec e
diSPlay ZONE........ooiiiiiiiiii
divided (report file).
division (scale)....
DNS server-...... .
dOmMaiN NAME ...t
DST (daylight saving time) .........cccoceiiiiiiiiiieiee
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E

€Ml 1OG .. 4-20
easy text entry ... 1-46, 12-12
effects of operating conditions..............cccoveeiiiiiiiiiciens 12-16
ENEITIZE ..ttt 1-6
©ITOF COUBS ..ottt ettt ettt e e 10-1
(T4 (o] o E- | = PR SUSRRRR 1-42
errorlog............ ..4-19
€ITOr MESSAJES...ccvvieeriieeeriireeanes ... 10-1
errors related to parameter settings .. .10-1
(V=10 | S PRI 1-32
event action ... 1-32, 7-1, 12-7
event data...... .. 1-21, 1-23, 12-5

E X e 9-6
expressions (Computation) .........c.cooveeriiiiieiie e 9-5
extended iNPUt tyPe ......oceiiiiiiiiii 12-11
extension (file) .......coeeie i 1-28
external dimeNnSIONS. ........ccoiiiiiiiiicie e 12-17
F

FAIL/status output relay.........ccocveeieiiiiiiiiiiieccc e 12-9
FAIL QUEPUL ... 1-43, 2-9
fast sampling MOde .........ccooiiiiiiiiie e 1-1
favorite key

file NEAET ..o

fille NAME ..o

fil© SIZE..eeiieiiee e
fIrMWare VErsion ..........oociiiiiii e

fixed (alarm mark).

flow of data recording and storage ............ccccooveviiiiiinncnnn. 1-22
format of ASCII files........cccceoeeeeen.

formatting....... 6-14
format type........cccoceene. ...6-14
four arithmetic operation.............ccccooeeiiiie e 9-6
free (event data) ........cccoviiiiiiiii 1-24, 6-2

free messages
free space

[o 10 o1 T T PP PU PP OURPPPPRPON 5-1
GrOUP SEL..eiiiiiiiie e 5-1
L U PRSP RUS PRSP 9-6
H

historical trend display ..........ccocoeiiiiiiiiieee

HOLD ...

hold (alarm indication) ...
hold (alarm output relay)....
Holizontal split display ...

Holizontal wide display ..........ccccceeiiiiiiiiiiiiccc e
oSt NaME ...
NYSEErESIS ..o

|

identified StHNGS........cooiiiii e 6-5
ID NUMDET ... 2-11
INAICALON ... 3-7
information on the displayed measured data..............c.cccceeuee 4-9

INItIAIZE ...
input processing ....

input range.............

INPUEEYPE .o
integration time ...
internal memory..

internal switch..... .

interval (rate-of-change alarm) ..........c.cccocoeiiiiiincn.

INVAIA KEYS ... 2-16
IPaddress ........cccoiiiiiiiiiii 2-5
ISOIALION ... 12-14
J

jump default display..........ccceeiiiiiiii e 5-24
K

KEYDOAId. ... 2-15
KEY TOCK. ...t 1-35, 8-1
L

L E s 9-6
limitations (EXPressions).........ccocciiiiiiiiiiiiiiesec e 9-5
liNEAr SCAIING.....iiiiiiieiiiie e 1-3

line width of the trend ...
list of files..

log....
log display.....
10GGING OUL ... 8-6
logical computation............coeiiiiiiiiii e 9-7
login function .
JOGIN 10G -

10g iNt0 the DX ...cuiiiiiiii e 8-6
10t-NO. digit ..o 6-7
lot nUMDEr......ooi 1-31
low-cut

MAC @dArESS....uiveeiiiiie ettt 2-5
MAINTENANCE .....coiiiiiiiiiii e 11-1
manuals i
manual sampled data ...........ccooceeiiiiiiiiiiiens 1-21, 1-25, 12-6
manual sampled data (format)..........cccccovveiiiiiiiineicen, App-5
manual save ..........ccoceeeeeenen.

match time timer-...
math start action..............

measurement channel...........cccooiiiiiiiii e
measuremMeNnt iNPUL..........oooiiiiiiii e
measure soft key ...
media FIFO.........
memory backup.....
MEMOTY SAMPIE ...t
MEMOTY SEA.......coiiiiiiii e
memory stop..........
memory summary..
message colors ..................

message display methods ..o
IMESSAGES . uveenveeenteeriteateeaiteeabeeaiee e tee bt esbeeabeesaeeaneeees
messages (errors, status, etc)...
MESSAGE SUMMAIY ...eiiiiiiieeiieaieieniee e e eieeeieeseee e
modbus client status display.........cc.ccceeeiiiiiiiiiiiieee
modbus master status display ... .
modbus status diSplay ..........ccoeceeeeiiiieiiiieeee e
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MOAbUS StAtUS 10g ......c.eviiiiiiiiiiice e
mode (input range) ..

MOVING AVETAGE .....eeieiiiieeiiieeeeieeeasiiee e e e abeeesaaeeeenees

N

N e
network information .

next softkey .....cccocoeeeninnne

non-hold (alarm indication)......

non-hold (alarm output relay) ..........ccocveviiiieniiieeee
normal operating conditions ............ccccooiiiiiiii e

NOT .

number of pulses per minute...

numerical display section ........

NUMENIC AISPIAY.....ueiiiiiiiie i

0)

OPEIAtION EITOFS ..eviiieeeiiiiie et a e e e e e 10-3
0PEration 10gS ......c..uorruieriiiiiiiiieee e 4-18
operations that can be carried out when logged out. ... 1-36
OR e 9-7
order of precedence (computation) ..........cccccoevriieriiiniennene 9-5
overflow data ... .1-42, 9-4
overview display ... ..1-15, 4-10
P

partial expanded display..........ccccoeiiiiiiiiiiiieie 1-11, 5-16
parts replacement...........oooiiiiiiie s 11-1
password (10gin fUNCHON)........c.ooouiiiiiiiieiceee e 8-5
PASSWOrd ChaNGE .....ccveeiiiiie e 8-7
power-fail message .... ...5-26
power COMPULALIONS .......cceeiiiiiiiiiee e 9-6
power failure operation ............ccccceeiiiiiiiiiiin 1-42
power supply

power supply for transmitter.............ccoooeiiiiiiiiiiin 1-46
S 9-10
preset display ........cociiiiiiiii 5-24
PrELTIGGET ..t 1-24
processing order of computation .
progress of the save operation ...........ccoccceeiiiieiiiieinieeee
PUISE INPUL ...

PUISE SUM VAIUE......coiiiiiiiiieiic e 3-16
R

range (INPUE FaNGE) .....couiiiiiiiiieiiieee e 3-4
rate-of-change alarm ..o 1-4
recommended replacement periods for worn parts............... 11-1
recording conditions (display data)..........cccccceeviens 1-23

recording conditions (event data)...

reference channel..........ccoociiiiii i
reference junction compensation
reflash.......ccooeiiiiiiii

relational computation ...

relative time mode.......... .

relay action on alarm ACK ..........cooiiiiiieiieiieee e 3-8
relay status display..........cccoeveiiiiiiiiic 1-19, 4-12
releasing the Key 1oCK ...........ooiiiiiiiiii e 8-2
remote control............. 1-32, 12-11
remote control fUNCHON ..o 7-1
remote controller ID..........ccoeiiiiiiiie e 2-5, 2-10

report data......cccceeeeeviiiiiiiee e 1-19, 1-21, 1-25, 12-6
TEPOIt diSPIAY ...t 4-11
report file (format) ..........oooiiiiii e App-7

RESET.............

reset (TLOG) .
resets the computed result (Rst+St)........cccoveiiiniiiiinnne 9-13
resetthe sum value ..., 3-17
resetting the computed results ..... 9-14
resetting the relative timer............ . T7-4
TEVISIONS ...ttt i
rOlliNG @VErage .......eeieiiiieiieie e 1-40, 9-4
RS-232 interface..........ccvevviiiiiiieeceeeeees e 12-9
RS-422A/485 Interface .........coooveeeieieieieeeseee e 12-9
S

SAMPIE FALE ... 6-2
SAVE AIFECIONY ...ttt 6-5
save duration to the CF card ...........cccoooeivieiiiniciccies App-3
save interval

saving data to the external storage medium......................... 1-26
saving measured data (automatically)..........c.cccoeveriviiiiennnne 6-8
saving measured data (manually) .........cccoceiiieeiiiienieees 6-9
saving setup data ........occveviiiiiii 6-16

saving the data ...

SCAIE IOWEN ...
scan interval .......... 1-1, 3-1
screen image data. .1-21, 6-12
SCrOIl HIME ..o 5-23
secondary iNErval ..........coooiiiiiiiiiiee e 5-5
SECUILY ettt ettt ettt ettt e et e e e e e e nneeeeannes 8-4
security function.. .12-7
separators........... ... 5-28
setup data.............. .1-21, 1-30, 12-6
single (event data)..........coooeiiiiiiiie e 1-24
size of the internal memory ............cocoeiiiiiiin 1-23
snhapshot

snapshot data........c.ccoeeiiiiiiiiiiiee e

SINTP OG -ttt

SO IEEIM ...

SPAN TOWET ..ttt e e e e e e e e e
Special computation ..

special data .....c.eeiiiiii e
SQR .
square root computation.....

standard display soft key....

standard performance ........ .
STANAAAS ....eeieieieecee s
standard temperature deviCe...........ocoiiiiiiiiiie e 11-2
starting the computation......... 9-13
start the recording............ ...6-8
status display section ... .. 1-8
Status MESSAGES. ... .uvii i 10-12
status OULPUL ..o 1-44, 2-9
status relay

stopping the recording .........ccooiiiiiiiiiiii e 6-9
structure of the file name............cccooiiiiie 6-5
SUD MENU....oeiiii 4-1, 5-29
SUM SCAIE ... 1-41
symbols that can be entered .. .
SYSTEM EITOIS ...t 10-14
system information ..ot 2-5
T

temperature Unit ...
text field ..o
time at the grid position ...
HIME AXIS ..

IM 04L41B01-01E




Index

timer action
time related functions ............cccoocviiiiiiiiiii
tiMe et
time until the internal memory becomes full ...
time ZoNe .....coooieeee e

TLOG computation ..........ccceeeveeeiieeeeiiieeseieee s
trademarks
transport and storage conditions ............cccceeiiieiiiieeeneen.
trend diSPlay .......oooevieiiee e
trend display (T-Y)...
trend history...
trend interval...............

trend rate SwitChing ..........cccciriiiiiiiii
TN SPACE ...t
trigger ............
trigger signal
trip line..............

troubleshooting .........eooiiiiii

unit in computations....
unsaved data.........ccceeeiieeiiiieenns

update interval (measured values) ........c.cccocveeviieeenieeenneen 1-7
updating of the waveform ..o 1-10
USB interface ..........c......... w1447, 1212
USET . ieeeeeeeeeeeeeeeeeeeeeeeeaseesseessesssnssssssnsssnssansssnssnsssnnnnnnnnnns 1-36, 8-5
USER KEY ...ttt 1-32, 7-1

Vv

value iNdiCator ..........cccoiiiiiiiii 5-13
ValUE ON OVEI-TANGE. ....utiieiiiiieeiiiee ettt 3-19

w

WaINING MESSAGES. ...ccuveeueiiiieriiietieateesiee sttt e esee e 10-14
WED 10Q 1t 4-19
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